SP Perspectives:
A New View of Your SP System

Yoshimichi Kosuge, Janet Ellsworth

International Technical Support Organization

http://www.redbooks.ibm.com

SG24-5180-00
International Technical Support Organization

SP Perspectives:
A New View of Your SP System

December 1998
Take Note!

Before using this information and the product it supports, be sure to read the general information in Appendix C, “Special Notices” on page 333.

First Edition (December 1998)

This edition applies to Version 3 Release 1 of the IBM Parallel Systems Support Programs for AIX (PSSP) Licensed Program (5765-529).

Note

This book is based on a pre-GA version of a product and may not apply when the product becomes generally available. We recommend that you consult the product documentation or follow-on versions of this redbook for more current information.

Comments may be addressed to:
IBM Corporation, International Technical Support Organization
Dept. HYJ Mail Station P099
522 South Road
Poughkeepsie, New York 12601-5400

When you send information to IBM, you grant IBM a non-exclusive right to use or distribute the information in any way it believes appropriate without incurring any obligation to you.

© Copyright International Business Machines Corporation 1998. All rights reserved
Note to U.S Government Users – Documentation related to restricted rights – Use, duplication or disclosure is subject to restrictions set forth in GSA ADP Schedule Contract with IBM Corp.
Contents

Figures ................................................................. ix

Tables ................................................................. xv

Preface ................................................................. xvii
The Team That Wrote This Redbook ................................. xviii
Comments Welcome .................................................. xix

Chapter 1. Introducing SP Perspectives ............................ 1
  1.1 Understanding the SP Perspectives Interface ................ 2
    1.1.1 Launch Pad .............................................. 2
    1.1.2 Windows ............................................... 5
    1.1.3 Dialog Boxes .......................................... 12
    1.1.4 Notebooks ............................................ 16
    1.1.5 Message Boxes ........................................ 18
  1.2 Using Help .................................................. 19

Chapter 2. Starting and Customizing the SP Perspectives ....... 21
  2.1 Starting the SP Perspectives .................................. 21
  2.2 Customizing the SP Perspectives ................................ 24
  2.3 Displaying Applications on the Launch Pad .................. 25
    2.3.1 Modifying the Display of Applications ............... 25
    2.3.2 Deleting the Display of Applications ................. 26
    2.3.3 Adding Applications .................................. 27
  2.4 Setting Colors ............................................. 27
    2.4.1 Set Colors Dialog Box ................................. 28
  2.5 Setting the Font ............................................ 29
    2.5.1 Set Font Dialog Box .................................... 30
  2.6 Arranging Window Layout .................................... 31
    2.6.1 Sizing the Launch Pad or a Window .................... 31
    2.6.2 Positioning the Launch Pad or a Window on the Screen 31
    2.6.3 Displaying Panes in Window ............................ 31
    2.6.4 Setting the Display Characteristics of Panes ....... 32
    2.6.5 Setting the Size of Panes ............................. 32
  2.7 Saving Preferences ......................................... 33
    2.7.1 Save Preferences Dialog Box ........................ 34
  2.8 Loading Preferences ........................................ 35
    2.8.1 Loading Preferences at SP Perspectives Initialization . 35
  2.9 Customization Sample ....................................... 36
    2.9.1 Default Window ....................................... 36
    2.9.2 Single Window with Multiple Panes .................... 37
A.4 Viewing Hardware Attributes ........................................ 206
  A.4.1 The Control Workstation Notebook .......................... 207
  A.4.2 The System Notebook ........................................ 210
  A.4.3 The System Partition Notebook .............................. 215
  A.4.4 The Node Notebook ........................................ 217
  A.4.5 The Dependent Node Notebook ............................... 232
  A.4.6 The Node Group Notebook .................................. 237
  A.4.7 The Frame Notebook ....................................... 240
  A.4.8 The Switch Notebook ...................................... 245
A.5 Monitoring Hardware Objects .................................... 251
  A.5.1 The Set Monitoring Notebook ................................. 253
  A.5.2 Monitoring the Control Workstation ....................... 253
  A.5.3 Monitoring the System ...................................... 254
  A.5.4 Monitoring System Partitions .............................. 256
  A.5.5 Monitoring Nodes .......................................... 258
  A.5.6 Monitoring Dependent Nodes ............................... 259
  A.5.7 Monitoring Node Groups .................................... 260
  A.5.8 Monitoring Frames ......................................... 262
  A.5.9 Monitoring Switches ........................................ 263
A.6 Controlling Hardware ............................................. 264
  A.6.1 Controlling System Partitions .............................. 264
  A.6.2 Controlling Nodes .......................................... 267
  A.6.3 Controlling Node Groups ................................... 276
  A.6.4 Controlling Frames ......................................... 278
  A.6.5 Controlling Switches ....................................... 280
A.7 SP Perspectives Examples ........................................ 281
  A.7.1 Using Multiple Panes and Multiple Windows ............... 281
  A.7.2 Using Table View .......................................... 282
  A.7.3 Saving and Loading Preferences ............................ 283
  A.7.4 Filtering by and Acknowledging Monitoring States ....... 284

Appendix B. Managing Events ........................................ 287
B.1 The Event Perspective Interface ................................ 287
  B.1.1 Selecting Objects ........................................ 287
  B.1.2 Panes ...................................................... 288
  B.1.3 Menu Bar .................................................. 288
  B.1.4 Tool Bar .................................................. 291
  B.1.5 Viewing Panes in Icon View ............................... 293
  B.1.6 Viewing Panes in Table View .............................. 293
  B.1.7 Filter Objects ........................................... 299
B.2 Working with System Partitions ................................. 304
  B.2.1 Making a System Partition Current ......................... 304
  B.2.2 Viewing System Partition Properties ...................... 305
## Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>The SP Perspectives Launch Pad</td>
<td>2</td>
</tr>
<tr>
<td>2.</td>
<td>The SP Perspectives Launch Pad with Application Details</td>
<td>5</td>
</tr>
<tr>
<td>3.</td>
<td>The Hardware Perspective Window</td>
<td>7</td>
</tr>
<tr>
<td>4.</td>
<td>The Event Perspective Window</td>
<td>8</td>
</tr>
<tr>
<td>5.</td>
<td>The Sort Dialog Box</td>
<td>14</td>
</tr>
<tr>
<td>6.</td>
<td>The Filter Dialog Box</td>
<td>15</td>
</tr>
<tr>
<td>7.</td>
<td>The Set Object Label Notebook</td>
<td>18</td>
</tr>
<tr>
<td>8.</td>
<td>The Hardware Perspective and Event Perspective Icons</td>
<td>21</td>
</tr>
<tr>
<td>9.</td>
<td>The Hardware Perspective Default Window</td>
<td>23</td>
</tr>
<tr>
<td>10.</td>
<td>The Event Perspective Default Window</td>
<td>24</td>
</tr>
<tr>
<td>11.</td>
<td>The Extended SP Perspectives Launch Pad</td>
<td>26</td>
</tr>
<tr>
<td>12.</td>
<td>The Set Colors Dialog Box</td>
<td>28</td>
</tr>
<tr>
<td>13.</td>
<td>The Set Font Dialog Box</td>
<td>30</td>
</tr>
<tr>
<td>14.</td>
<td>The Add Pane Dialog Box</td>
<td>32</td>
</tr>
<tr>
<td>15.</td>
<td>The Save Preferences Dialog Box</td>
<td>33</td>
</tr>
<tr>
<td>16.</td>
<td>Default Window for the Hardware Perspective</td>
<td>37</td>
</tr>
<tr>
<td>17.</td>
<td>Multiple Panes Single Window</td>
<td>38</td>
</tr>
<tr>
<td>18.</td>
<td>Multiple Windows</td>
<td>39</td>
</tr>
<tr>
<td>19.</td>
<td>Multiple Windows with Multiple Panes</td>
<td>41</td>
</tr>
<tr>
<td>20.</td>
<td>Reduced Screen Real Estate</td>
<td>43</td>
</tr>
<tr>
<td>21.</td>
<td>The View and Modify Properties Notebook</td>
<td>44</td>
</tr>
<tr>
<td>22.</td>
<td>More Slimmed Window</td>
<td>45</td>
</tr>
<tr>
<td>23.</td>
<td>Table View Pane</td>
<td>46</td>
</tr>
<tr>
<td>24.</td>
<td>Set Objects in Table View</td>
<td>47</td>
</tr>
<tr>
<td>25.</td>
<td>Set Table Attributes</td>
<td>48</td>
</tr>
<tr>
<td>26.</td>
<td>Table View</td>
<td>49</td>
</tr>
<tr>
<td>27.</td>
<td>Default Hardware Perspective Window</td>
<td>51</td>
</tr>
<tr>
<td>28.</td>
<td>Hardware Perspective with All Four Possible Panes</td>
<td>52</td>
</tr>
<tr>
<td>29.</td>
<td>Click Nodes Pane, then Monitor Icon</td>
<td>55</td>
</tr>
<tr>
<td>30.</td>
<td>Select Conditions</td>
<td>56</td>
</tr>
<tr>
<td>31.</td>
<td>Monitoring Conditions</td>
<td>58</td>
</tr>
<tr>
<td>32.</td>
<td>Monitored Conditions Page of Node Notebook</td>
<td>59</td>
</tr>
<tr>
<td>33.</td>
<td>Fly-Over Information Pop-Up</td>
<td>60</td>
</tr>
<tr>
<td>34.</td>
<td>Add Pane Dialog Box</td>
<td>61</td>
</tr>
<tr>
<td>35.</td>
<td>Two Nodes Panes Inside One Window</td>
<td>62</td>
</tr>
<tr>
<td>36.</td>
<td>Multiple Panes Inside One Window</td>
<td>63</td>
</tr>
<tr>
<td>37.</td>
<td>Add Pane Dialog Box</td>
<td>64</td>
</tr>
<tr>
<td>38.</td>
<td>Multiple Windows and Multiple Panes</td>
<td>65</td>
</tr>
<tr>
<td>39.</td>
<td>Monitoring in Icon View</td>
<td>67</td>
</tr>
<tr>
<td>40.</td>
<td>Set Table Attributes Notebook</td>
<td>68</td>
</tr>
</tbody>
</table>
41. Table View Nodes Pane .................................................. 69
42. Filter Objects by Their Monitored State ................................. 71
43. Filtered by Triggered and Unknown States ............................. 72
44. Set Table Attributes Notebook ........................................ 73
45. Table View with PSSP Code Version ................................... 74
46. Filter Nodes Dialog Box .................................................. 75
47. Show Objects by Their Label in the Pane ............................... 75
48. Filter to Show Only Back-Level Nodes ................................ 76
49. Select Node 1 To Be Acknowledged ................................... 78
50. Node 1 is Acknowledged .................................................. 79
51. Filtering Out Acknowledged Node ....................................... 80
52. Original Icon Size .......................................................... 81
53. Set Object Label Notebook ............................................... 82
54. No Icon Labels Shown ..................................................... 83
55. Smaller Icon Size .......................................................... 84
56. 132-node System with One Nodes Pane ................................ 85
57. 132-node System with Three Nodes Panes .............................. 86
58. 132-node System with Three Nodes Panes Using Filter .............. 87
59. Save Preferences Dialog Box ............................................. 88
60. SP Perspectives Launch Pad .............................................. 89
61. Add Your Application ..................................................... 90
62. You Have Your Own Icon ................................................ 91
63. Using the Icon on the Tool Bar ........................................ 93
64. Power On or Cluster Power On Nodes Dialog Box .................... 94
65. Power Off, Reset, Shutdown, or Fence Nodes Dialog Box .......... 95
66. Select One Node You Want to Power On/Off .......................... 96
67. View or Modify Properties Node Notebook ............................ 97
68. The Node Group Notebook ............................................... 98
69. New Node Group MyGroup in the Node Groups Pane ............... 99
70. The Run Command Dialog Box ......................................... 100
71. Managing Events Task ................................................... 112
72. Load Default Event Definition Dialog Box ........................... 114
73. Register Tool Bar Icon ................................................... 115
74. Define Your Actions ..................................................... 117
75. The Relationship Between Condition and Event Definition ....... 120
76. Add Conditions Pane ..................................................... 122
77. Open Create Definition Notebook ..................................... 124
78. Fill in the Create Condition Notebook ................................ 127
79. The Created Condition Icon ............................................. 128
80. Open Event Definition Notebook ....................................... 129
81. Fill in the Create Event Definition Notebook ......................... 131
82. The Created Event Definition Icon ..................................... 132
83. The Notified Event Definition Icon ..................................... 133
Tables

1. Commands for SP Perspectives Applications ............................. 22
2. Relationship between Objects, Actions and Conditions (1 of 2) ........ 53
3. Relationship between Objects, Actions and Conditions (2 of 2) ........ 54
4. Related Resource Identifier for Resource Variable Name ............... 105
5. Event Perspective Icons .................................................... 139
6. Equivalent Perspectives Function for spmon GUI (1 of 7) ............ 158
7. Equivalent Perspectives Function for spmon GUI (2 of 7) ............ 159
8. Equivalent Perspectives Function for spmon GUI (3 of 7) ............ 160
9. Equivalent Perspectives Function for spmon GUI (4 of 7) ............ 161
10. Equivalent Perspectives Function for spmon GUI (5 of 7) .......... 162
11. Equivalent Perspectives Function for spmon GUI (6 of 7) .......... 163
12. Equivalent Perspectives Function for spmon GUI (7 of 7) .......... 164
13. Event Perspective Objects Appearance ................................. 293
Preface

This redbook provides an overview of the Scalable POWERparallel Perspectives for AIX (SP Perspectives). SP Perspectives is the graphical user interface for system management on the RS/6000 SP. SP Perspectives is the strategic successor of the spmon GUI. In IBM Parallel System Support Programs for AIX (PSSP) Version 3.1, SP Perspectives is enhanced to be functionally equivalent to the spmon GUI, and the spmon -g option is removed.

This redbook is written for SP system administrators, SP technical professionals and SP customer engineers to help them fully understand the capabilities of SP Perspectives and to quickly learn to use it. It provides hints and tips, as well as detailed scenarios showing you how to use the Perspectives interface to accomplish goals.

This redbook assumes a basic knowledge of the RS/6000 SP and the PSSP software.

The following topics are covered in detail:

- Quickly coming up to speed on the Hardware Perspective and using it effectively.
- Important new features in SP Perspectives, such as multiple instances of panes, multiple windows, table views and filtering by monitor state.
- Addressing the needs of users moving from spmon GUI, emphasizing tasks they were able to do in spmon GUI and explaining how they can now do them in the Hardware Perspective.
- Saving screen real estate using SP Perspectives, with a focus on large system users.
- Quickly coming up to speed on the Event Perspective and using it effectively.
- Taking advantage of the new default event definitions provided by the Event Perspectives, so that, with a couple of clicks, a user can receive notification of any critical problems in the SP system.
- Ways to customize SP Perspectives to your liking and then save it in a preference file, so that every time you invoke SP Perspectives, you get your customized interface. This includes window number and size, pane number, size and title, monitoring of conditions and filtering by monitored state.
- Detailed appendices on the Hardware and Event Perspectives.
• Explanation of the new features of the IBM VSD Perspective, which has been totally redone in PSSP 3.1 to make it more scalable and usable.

**The Team That Wrote This Redbook**

This redbook was produced by a team of the International Technical Support Organization Poughkeepsie Center.

**Yoshimichi Kosuge** is an IBM RS/6000 SP project leader at the International Technical Support Organization, Poughkeepsie Center. He joined IBM Japan in 1982 and has worked in the following areas: LSI design, S/390 CP microcode, VM, MVS, OS/2, and AIX. Since joining the ITSO in 1998, he has been involved in writing redbooks and teaching IBM classes worldwide on all areas of RS/6000 SP.

**Janet Ellsworth** is a software developer for the RS/6000 SP system with design and development responsibilities in the areas of graphical user interface and system management. She has worked on the SP Perspectives user interface for two years, and has worked on a number of software development and engineering projects in IBM over the past 12 years.

Thanks to the following people for their invaluable contributions to this project:

- Marcelo Barrios
  ITSO, Poughkeepsie Center

- Fern Bassow
- Alice Hackett
- Joshua Horton
- Susan Jaworski
- Peter Jennes
- Tony Lau
- Margaret Moran
- Peter Pagerey, PhD
- Keshav Ranganathan
- Marcene Stewart-Hill
- Bill Wajda
- Gina Yuan
- IBM Poughkeepsie
Comments Welcome

Your comments are important to us!

We want our redbooks to be as helpful as possible. Please send us your comments about this or other redbooks in one of the following ways:

• Fax the evaluation form found in “ITSO Redbook Evaluation” on page 351 to the fax number shown on the form.

• Use the electronic evaluation form found on the Redbooks Web sites:
  For Internet users http://www.redbooks.ibm.com
  For IBM Intranet users http://w3.itso.ibm.com

• Send us a note at the following address:
  redbook@us.ibm.com
Chapter 1. Introducing SP Perspectives

SP Perspectives is a graphical user interface (GUI) that enables you to perform system management tasks for your SP system through direct manipulation of system objects represented by icons.

You simply select one or more SP system objects (managed SP system resources such as a frames, nodes, or switches) by clicking on it with a mouse and then select an action to perform on that object from the menu or tool bar. Use this pattern of selecting one or more objects and then selecting an action to perform on these objects to accomplish numerous system management tasks with the SP Perspectives.

SP Perspectives provides function for hardware control and object monitoring. For example, you can use the SP Perspectives to power on and off or reset hardware. Some configuration function is provided by the SP Perspectives (for example, the ability to group nodes into node groups).

SP Perspectives is a suite of five SP Perspective applications. You can use these SP Perspective applications to perform the following system management tasks:

- **Hardware Perspective**  
  Monitor and control hardware.

- **Event Perspective**  
  Create and monitor system events.

- **VSD Perspective**  
  Define and manage IBM Virtual Shared Disks.

- **System Partitioning Aid Perspective**  
  Generate and save system partition configurations.

- **Performance Monitor Perspective**  
  Set up performance and monitoring hierarchies and archiving.

You can access these SP Perspective applications from the SP Perspectives Launch Pad, or from the command line.

The SP Perspectives Launch Pad also provides access to system management tools such as SMIT panels. In addition, you can create your own
applications and make them accessible from the SP Perspectives Launch Pad.

Because the SP Perspectives has fully replaced the spmon GUI, the Hardware Perspective has been enhanced to achieve functional equivalence with the spmon GUI. For more detail, refer to Chapter 5, “For Former spmon GUI Users” on page 141.

1.1 Understanding the SP Perspectives Interface

The SP Perspectives interface consists of the following graphical elements:

- Launch Pad
- Windows
- Dialog boxes
- Notebooks
- Message boxes

1.1.1 Launch Pad

The Launch Pad starts applications associated with managing an SP System. It also provides options for customizing the appearance of the Launch Pad. The default appearance is shown in Figure 1.

![Figure 1. The SP Perspectives Launch Pad](image)

System management applications provided by SP Perspectives are represented as icons on the Launch Pad. Other system management tools,
such as SMIT windows, are also accessible from the Launch Pad. The SP Resource Center provides one simple interface for all soft copy SP documentation and information resources. To install the SP Resource Center, see IBM Parallel System Support Programs for AIX: Administration Guide, GC23-3897. You can also add your own applications to the Launch Pad.

The Launch Pad contains the following two elements:

- Title bar
- Menu bar

1.1.1.1 Title Bar
The title bar presents the name of the window and an identifier for the control workstation:

SP Perspectives Launch Pad - cws_name

1.1.1.2 Menu Bar
The menu bar contains menu items that provide for various actions.

Window Menu
The Window menu consists of the following:

- Exit
  Provides for closing the Launch Pad window. Closing the Launch Pad window does not affect application windows that are open.

Actions Menu
The Actions menu consists of the following:

- Launch
  Starts the selected application (represented by an icon).

Options Menu
The Options menu consists of the following:

- Customize Applications
  Extends the Launch Pad window to include a panel that provides for adding, deleting, or modifying applications on the Launch Pad. Specify a unique application name, a one-line application description, executable file name, and icon file name (a pixmap file in xpm format). Select whether you want to add, delete, or modify the icon representing the application. The Launch Pad
is updated immediately. Select **Leave Customize Mode** to close the Customize Applications panel.

**Show Application Details/Icons**

Presents the Launch Pad in a way that displays icons representing applications, along with the application name, application description, and executable path; see Figure 2 on page 5. Select **Show Application Icons** to return to the default icon view.

**Save Preferences...**

Presents a dialog box that provides for saving files of preferences. You specify the system or user file name to save the preferences to, and select aspects of preferences to save. Aspects of preferences include foreground and background colors, type font, window position and size, and applications.

**Set Colors...**

Presents a dialog box that provides for setting colors. You choose to set the colors for the background and foreground and select the colors from sliders, a palette, or a list. A sample of the colors you select is dynamically displayed in the dialog box.

**Set Font...**

Presents a dialog box that provides for specifying typeface style and size. You select a typeface family and point size and specify bold or italic. A sample of fonts you select is dynamically displayed in the dialog box.

**Help Menu**

The Help menu provides options for information about windows, actions (tasks), and objects.
Figure 2 shows a view containing the names and descriptions of the applications.

### Figure 2. The SP Perspectives Launch Pad with Application Details

#### 1.1.2 Windows

A window for each SP Perspectives application provides a unique view of your SP System.

Windows contain work areas known as panes. Panes contain icons representing system objects. A system object is a managed SP system resource such as a node, frame, or switch.

- To perform actions on the objects themselves, do the following:
  1. Click one or more objects.

    To select multiple objects that are next to each other in a pane, click the icon of the first desired object, hold the left mouse button down, and move the cursor over the icons of other desired objects in the pane.

    To select multiple objects that are not next to each other in a pane, hold down the Ctrl key on your keyboard while you click each desired object in the pane.

  2. Select Actions from the menu bar.
  3. Select the desired action from the pulldown menu. (Alternatively, some Actions options are available from the tool bar.)

- To perform actions on the display of objects in panes:
1. Click pane to give it focus.
2. Select View from the menu bar.
3. Select the desired action from the pulldown menu. (Alternatively, some View options are available from the tool bar.)

Each window consists of the same basic format. The elements of this format are:
- Title bar
- Menu bar
- Tool bar
- Panes
- Sash
- Information area

A Hardware Perspective window, shown in Figure 3 on page 7, allows you to view the system as a set of hardware objects (for example, nodes, frames, switches).
Figure 3. The Hardware Perspective Window

An Event Perspective window, shown in Figure 4 on page 8, allows you to view the system in terms of conditions of interest related to system resources.
1.1.2.1 Title Bar
The title bar displays the name of the application, the name of the control workstation running SP Perspectives, and an identifier for the system.

If the selected object is the System icon, the system is identified as Global. If the selected object is a Syspar icon, the system is identified by the system partition name.

The format for title bar information is:

`application_name - cws_name: Global or partition_name`

1.1.2.2 Menu Bar
The menu bar contains menu items that provide for various actions.
**Window**
These are actions that operate on a window as a whole.

**Exit**  
Closes all windows related to the Perspective. Exiting a window also closes any dialog boxes, message boxes and notebooks that have been opened for that SP Perspectives application.

**Actions**
These are actions that operate on SP System objects. The Actions menu lists the actions available for objects within the current pane. Each SP Perspectives application determines which actions are available. Actions that are unavailable are grayed out.

**View**
These are actions that operate on the display of SP System objects in a selected pane. The following View actions are common to most of the SP Perspectives applications. Each application determines which additional View actions are available.

**Sort...**  
Presents a dialog box that provides for sorting objects by name in either ascending or descending order.

**Filter...**  
Presents a dialog box that provides for specifying which objects are displayed in a pane. You can include or exclude objects by object name or by selecting objects.

**Remove Filter**  
Undoes a Filter action and re-displays all the objects in a pane.

**Select All**  
Selects all objects in the selected pane.

**Deselect All**  
Deselects all objects in the selected pane.

**Add Pane...**  
Adds a pane.
Delete Current Pane
Deletes the selected pane from a window.

Change Current Pane Title...
Changes the title bar text of the selected pane.

Set Object Label...
Sets the text label for objects in the currently selected pane.

Show Objects in Table/Icon View
Displays objects in the selected pane in a table view or icon view.

Set Table Attributes...
Provides for selecting which object attributes are displayed in the selected table.

Change System Partition...
Changes the current system partition.

Set Monitoring...
Allows for setting monitoring of selected conditions in the current pane.

Options
These are actions that operate on the presentation or appearance of individual windows.

The following Options actions are common to all of the SP Perspectives applications. Each application determines which additional Options actions are available.

Show as Vertical/Horizontal Panes
Provides for selecting a vertical or horizontal pane display.

Hide/Show Tool Bar
Hides or shows the tool bar icons.

Hide/Show Information Area
Hides or shows the information area.
Save Preferences...

Presents a dialog box that provides for saving files of preferences. You specify the system or user file name to save the preferences to, and select aspects of preferences to save. Aspects of preferences include foreground and background colors, type font, and window position and size.

Set Colors...

Presents a dialog box that provides for setting colors. You choose to set the colors for the background and foreground and select the colors from sliders, a palette, or a list. A sample of the colors you select is dynamically displayed in the dialog box.

Set Fonts...

Presents a dialog box that provides for specifying typeface style and size. You select a typeface family and point size and specify bold or italic. A sample of fonts you select is dynamically displayed in the dialog box.

Help

The Help button provides options for displaying information about windows, areas, actions (tasks), and objects.

1.1.2.3 Tool Bar

The tool bar displays icons for often-used actions against selected objects and against the display of objects. These actions are a subset of those available from the menu bar.

The following tool bar icons are common to most of the SP Perspectives applications and represent actions against the display of objects:

Sort

Provides for sorting objects in a pane by name either in ascending or descending order.

Filter

Provides for including or excluding the display of objects in a pane by object name or by selecting objects.
1.1.2.4 Panes
Panels are sections of the window work area that contain icons that represent system objects. Typically, but not always, there is one type of system object per pane. System objects in a pane can be manipulated using actions available in the menu bar or tool bar.

1.1.2.5 Sash
A sash (a small square and a separator line) provides for controlling the relative size of the panes above and below it.

1.1.2.6 Information Area
The Information Area, the bottom line of the window, displays information about the object or area at the current cursor location. This display can be toggled on and off from the Options menu.

1.1.3 Dialog Boxes
When you use an SP Perspectives window to perform certain actions, a dialog box is presented. The dialog box solicits or displays additional
Introducing SP Perspectives

information needed to complete the action. The specific information or actions contained in the dialog box depend on the application.

SP Perspectives dialog boxes may contain the following elements (note, however, that not every dialog box contains all of these elements):

- The *title bar* displays the name of the action being performed, the object name or type, and, optionally, the system partition name.
- *Text entry boxes* provide for entering text information.
- *Check buttons* provide for selecting one or more choices from a list of options that are not mutually exclusive.
- *Radio buttons* provide for making a single choice from a list of mutually exclusive options.
- *Option menus* provide for entering information and selecting a single choice from a list of mutually exclusive options.
- *Push buttons* provide for selecting an action:
  - **Ok** Performs the action based on information entered or selected in the dialog box and closes the dialog box.
  - **Apply** Performs any changes made to information entered or selected in the dialog box and leaves the dialog box open.
  - **Cancel** Resets any changes made to information in the dialog box to the original values displayed when the dialog box was opened and closes the dialog box.
  - **Reset** Returns any changes made to information in the dialog box to the last applied values and leaves the dialog box open.
  - **Help** Displays general help about the purpose of and items in the dialog box.

1.1.3.1 The Sort Dialog Box

Use the *Sort* dialog box shown in Figure 5 on page 14 to sort objects in a pane by name in either ascending or descending order.
14

SP Perspectives: A New View of Your SP System

Figure 5. The Sort Dialog Box

To sort objects by name in ascending order:
1. Click **Ascending order**.
2. Click **Ok** to apply the sort and close the dialog box, or click **Apply** to apply the sort and leave the dialog box open.
3. The objects in the selected pane appear in ascending order by name.

To sort objects by name in descending order:
1. Click **Descending order**.
2. Click **Ok** to apply the sort and close the dialog box, or click **Apply** to apply the sort and leave the dialog box open.
3. The objects in the selected pane appear in descending order by name.

1.1.3.2 The Filter Dialog Box

Use the Filter dialog box shown in Figure 6 on page 15 to specify which objects are displayed in a pane. You can show or hide objects by object label or by selected objects.
To filter objects by label:

1. Click **Filter objects by their label in the pane:**

2. Enter the object label in the text entry box. You can use an asterisk (*) to specify a match for any number of characters in the label or a question mark (?) to specify a match for any single character in the label.

3. Click either **Show objects...** or **Hide objects...**

4. Click **Ok** to apply the filter and close the dialog box, or click **Apply** to apply the filter and leave the dialog box open.

5. If you selected **Show objects that match the filtering criteria**, the matched object(s) are displayed in the pane and other previously displayed objects in the pane are excluded; if you selected **Hide objects that match the filtering criteria**, the matched object(s) are not displayed in the pane.

To filter by selected objects:

1. Click **Filter the selected objects in the pane**.

2. Select objects in a pane of the perspective.
   - To select multiple objects that are next to each other in a pane, click the icon of the first desired object, hold the left mouse button down, and move the cursor over the icons of other desired objects in the pane.
   - To select multiple objects that are not next to each other in a pane, hold down the Ctrl key on your keyboard while you click each desired object in the pane.

3. Click either **Show objects that match the filtering criteria** or **Hide objects that match the filtering criteria**.
4. Click **Ok** to apply the filter and close the dialog box, or click **Apply** to apply the filter and leave the dialog box open.

5. If you selected **Show objects that match the filtering criteria**, the selected objects are displayed in the pane and other previously displayed objects in the pane are excluded; if you selected **Hide objects that match the filtering criteria**, the selected objects are not displayed in the pane.

To remove a filter being applied to the objects in a pane, click the pane to give it focus and select **Remove Filter** from the View menu, or click the **Remove Filter** icon in the tool bar.

In most of the Perspectives, the Filter and Remove Filter actions only apply to the current pane. However, in the System Partitioning Aid Perspective, a Filter or Remove Filter action applied to the System partitions pane will also affect the Nodes pane.

The Hardware Perspective and VSD Perspective allow for filtering node panes by monitored states. Thus their filter dialog boxes will have additional options if nodes are being monitored. For more detail, refer to 3.2.4, “Filter Objects” on page 70.

### 1.1.4 Notebooks

An SP Perspectives **notebook** is a type of dialog box that is in a notebook format. Each page in the notebook contains attribute information (defining or operational characteristics) about system objects. Like attributes are grouped on the same page, and tabs provide a visual identification of the category of attributes on the page. The specific attribute information contained on a notebook page depends on what the selected system object is (for example, the hardware or a system event).

Notebooks are provided as a mechanism for viewing or altering object attributes. SP Perspectives notebooks typically contain the following elements (not every notebook contains all of these elements):

- **Title bar** displays the action (view, modify), the object name or type, and optionally, the system partition name.

- **Text entry boxes** provide for entering text information for object attributes that can be modified.

- **Static text entry fields** provide for displaying object attribute information that cannot be modified (view only).

- **Check buttons** provide for selecting one or more choices from a list of options that are not mutually exclusive.
• *Radio buttons* provide for making a single choice from a list of mutually exclusive options.

• *Option menus* provide for entering information and selecting a single choice from a list of mutually exclusive options.

• *Push buttons* provide for selecting an action:

  - **Ok**
    Updates attribute information based on data entered in the notebook page and closes the notebook.

  - **Apply**
    Performs any changes made to information entered in the notebook and leaves the notebook open.

  - **Cancel**
    Resets any changes made to information in the notebook to the original values displayed when the notebook was opened and closes the notebook.

  - **Reset**
    Returns any changes made to information in the notebook to the last applied values and leaves the notebook open.

  - **Help**
    Displays general help about the purpose of items in the notebook.

### 1.1.4.1 The Set Object Label Notebook

Use the Set Object Label notebook shown in Figure 7 on page 18, to specify the icon labels for objects in a selected pane of a window. There is a Set Object Label Notebook for each pane in a window.
To specify the icon labels for objects in a selected pane of a window:

1. If the selected pane contains more than one type of object, there are multiple pages, identified by tabs, in the notebook. Click the tab for the desired object.

2. Select the desired label for the object from the Icon Text list box.

3. Click Ok to specify the icon label and close the notebook, or click Apply to specify the icon label and leave the notebook open.

4. The objects in the pane of the perspective are displayed with the specified icon labels.

1.1.5 Message Boxes

A message box is a type of dialog box used to convey a message to you.

There are four types of messages:

1. Informational
2. Error
3. Fatal
4. Warning

Elements common to SP Perspectives message boxes are:

- The **title bar** displays the name of the perspective.
- A **symbol** represents the message type.
- The **text** of the message.

- **Push buttons** provide for selecting an action, depending on the type of message:
  
  For Informational, Error, or Fatal messages:
  
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ok</strong></td>
<td>Closes the message box.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Displays extended information on the contents of the message and provides a way to view internal diagnostics information.</td>
</tr>
</tbody>
</table>

  For a Warning message:
  
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enter/Ok</strong></td>
<td>Confirms the action.</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Stops the action.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Displays extended information on the contents of the message and provides a way to view internal diagnostics information.</td>
</tr>
</tbody>
</table>

### 1.2 Using Help

Help for the SP Perspectives is available from:

- The Help Menu
- The Information Area
- The Dialog box, Notebook, and Message Box Help Buttons
Chapter 2. Starting and Customizing the SP Perspectives

This chapter describes how you can start and customize the SP Perspectives.

2.1 Starting the SP Perspectives

To start the SP Perspectives running as a background process:

1. Enter following command at the command line to bring up the SP Perspectives Launch Pad. Make sure that you have placed /usr/lpp/ssp/bin directory in your PATH environment variable.

   `# perspectives &`

   The SP Perspectives Launch Pad as shown in Figure 8 is presented.

2. Double-click the icon for the application you want to run. The window for the application will open.

   Alternatively, you can single-click the icon and select Launch in the Actions scroll list.

   ![Hardware Perspective and Event Perspective Icons](image)

   *Figure 8. The Hardware Perspective and Event Perspective Icons*

© Copyright IBM Corp. 1998
To start SP Perspectives applications as background processes without using the SP Perspectives Launch Pad, enter the following commands at the command line:

Table 1. Commands for SP Perspectives Applications

<table>
<thead>
<tr>
<th>Command</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td># sphardware &amp;</td>
<td>Monitor/Control Hardware</td>
</tr>
<tr>
<td># spevent &amp;</td>
<td>Manage Events</td>
</tr>
<tr>
<td># spvsd &amp;</td>
<td>Manage IBM Virtual Shared Disks and Data Striping Devices</td>
</tr>
<tr>
<td># spsyspar &amp;</td>
<td>Define System Partitions</td>
</tr>
<tr>
<td># spperfmon &amp;</td>
<td>Setup/Configure Performance Monitor</td>
</tr>
</tbody>
</table>

Figure 9 on page 23 shows the default window of the Hardware Perspective.
Figure 9. The Hardware Perspective Default Window

Figure 10 on page 24 shows the default window of the Event Perspective.
To load a saved preference while starting a SP Perspectives application from the command line, see “Loading Preferences” on page 35.

You can also start SP Perspectives applications from the Common Desktop Environment (CDE) by double-clicking on the SP Perspectives icon in the CDE Application Manager window.

2.2 Customizing the SP Perspectives

You can customize the appearance of the Launch Pad and windows for each of the SP Perspectives applications and save your preferences across SP Perspectives sessions or on a per session basis. You can customize the following window characteristics:

- Display of applications on the SP Perspective Launch Pad
- Colors
- Font
• Layout
  • Position of windows on the screen
  • Size of the windows
  • Number of windows
  • Number and types of panes, as well as pane titles
  • Pane display characteristics, such as if the pane is in table view and if it was filtered by monitored state
  • Size of panes
  • Monitoring in the pane

The ability to customize the presentation of windows for each of the SP Perspectives applications is an important feature. You can set up multiple profiles (files containing your specifications for color, font, and window layout) that allow you to view your SP system in various ways. You can then invoke these various system views as you desire.

2.3 Displaying Applications on the Launch Pad

You can modify and delete the display of applications on the Launch Pad, as well as add applications.

2.3.1 Modifying the Display of Applications

You can modify icons representing applications and the names of the icons on the Launch Pad, as follows:

1. Select Options from the Launch Pad menu bar.
2. Select Customize Applications.
3. The Launch Pad is extended to include a window for adding, deleting, and modifying the display of applications. Extended Launch Pad is shown in Figure 11 on page 26.
4. Click the icon in the Launch Pad that you wish to modify.
5. To modify the name of the icon, enter the desired name in the Name: text entry box.
6. To modify the icon itself, update the xpm icon file and enter the file name in the Icon file name: text entry box.
7. Click Modify.
8. To exit customize mode, select **Leave Customize Mode** from the Options menu, or click **Leave Customize Mode**.

To save and load this customization, see “Saving Preferences” on page 33 and “Loading Preferences” on page 35.

2.3.2 Deleting the Display of Applications

You can delete icons representing applications from the Launch Pad.

1. Select **Options** from the Launch Pad menu bar.
2. Select **Customize Applications**.
3. The Launch Pad is extended to include a window for adding, deleting, and modifying the display of applications. Extended Launch Pad is shown in Figure 11 on page 26.
4. Click the icon in the Launch Pad that you wish to delete.
5. Click **Delete**.
6. To exit customize mode, select **Leave Customize Mode** from the Options menu, or click **Leave Customize Mode**.

To save and load this customization, see “Saving Preferences” on page 33 and “Loading Preferences” on page 35.

### 2.3.3 Adding Applications

You can add applications to the Launch Pad.

1. Create an executable file for your application.
2. Create an icon to represent your application.
3. Select **Options** from the Launch Pad menu bar.
4. Select **Customize Applications**.
5. The Launch Pad is extended to include a window for adding, deleting, and modifying the display of applications. Extended Launch Pad is shown in Figure 11 on page 26.
6. Enter the name of the application in the **Name:** text entry box. This name will appear as the label for the icon representing the application on the Launch Pad.
7. Optionally enter text describing the application in the **Description:** text entry box.
8. Enter the name of the executable file for the application in the **Executable file name:** text entry box.
9. Enter the name of the xpm file for the icon representing the application in the **Icon file name:** text entry box.
10. Click **Add**.
11. To exit customize mode, select **Leave Customize Mode** from the Options menu, or click **Leave Customize Mode**.

To save and load this customization, see “Saving Preferences” on page 33 and “Loading Preferences” on page 35.

### 2.4 Setting Colors

To set the colors for the Launch Pad or an application’s windows:

1. Select **Options** from the menu bar.
2. Select **Set Colors...**
3. The Set Colors dialog box shown in Figure 12 on page 28 is presented.
2.4.1 Set Colors Dialog Box

Use the Set Colors dialog box to specify background and foreground colors for the Launch Pad or for an application's windows.

If you are using the Set Colors dialog box to specify a single color (for example, when specifying a color for the display of a system partition from the System Partitioning Aid perspective), the background and foreground options are not present.

To set colors:
1. Select either **background** or **foreground** to specify the part of the window you are setting the color for.
2. Select the color you desire by:
• Clicking the text entry box cascade button and selecting a color name from the pull-down menu.

OR
• Selecting a color from the color palette colored push buttons.

OR
• Using the Red/Green/Blue sliders to create a color.

3. Once you are satisfied with the sample of the color displayed:
   • Click Ok to apply your color choice and closes the dialog box.
   • Click Apply to apply your color choice and leaves the dialog box open.

To save and load this customization, see “Saving Preferences” on page 33 and “Loading Preferences” on page 35.

2.5 Setting the Font

To set the font for the Launch Pad or for an application’s windows:

1. Select the Options menu from the menu bar.

2. Select Set Font...

3. The Set Font dialog box shown in Figure 13 on page 30 is presented.
2.5.1 Set Font Dialog Box

Use the Set Font dialog box to specify the typeface style and size for the Launch Pad or for an application’s windows.

To set font:
1. Select a font from the Family pulldown menu or enter a font name in the text entry box.
2. Select a point size from the Point Size pulldown menu or enter a point size in the text entry box.
3. You can select Bold and/or Italic, or neither.

If you select a font that is not available to your display, the closest matching font is used.

4. Once you are satisfied with the sample of the color displayed:
   - Click Ok to apply your color choice and closes the dialog box.
   - Click Apply to apply your color choice and leaves the dialog box open.

To save and load this customization, see “Saving Preferences” on page 33 and “Loading Preferences” on page 35.
2.6 Arranging Window Layout

You can arrange various aspects of the layout of the Launch Pad or an application's window and save your preferences.

2.6.1 Sizing the Launch Pad or a Window

To size the Launch Pad or an application’s windows, move the mouse pointer slowly over a corner of the window until the pointer changes to a double-arrow pointer (this can vary with different window managers), and then drag that corner until the window is the size you want.

Another way to do this is by moving the mouse pointer over an edge of the window until the pointer changes to an arrow pointing in the direction you can resize the window, and then dragging that border until the window is the size you want.

2.6.2 Positioning the Launch Pad or a Window on the Screen

To position the Launch Pad or an application’s window on the screen, place the mouse pointer on the window’s title bar and drag the window to its new location.

2.6.3 Displaying Panes in Window

Within a window, use the View menu or Add or Delete tool bar icons to add and delete panes.

To add a pane:
1. Click the Add Pane tool bar icon or select Add Pane... from the View menu.
2. The Add Pane dialog box shown in Figure 14 on page 32 is presented.
3. In the Add Pane dialog box, select a Pane type: from the list. For Add Pane to: select Current window to add the new pane below the bottom pane in the current window. Select New window to add the new pane to a new window. Enter a unique Pane Title: or use the default. Click Ok to add the new pane and close the Add Pane dialog box. Alternatively, you can click Apply to add the new pane and keep the Add Pane dialog box open.

• If the Perspectives allows multiple instances of panes (currently only the Hardware Perspective and VSD Perspective do this), you can add as many panes and as many windows as you wish. If not, the Add Pane... menu option and Add tool bar icon are disabled when all panes in a perspective are displayed. The control is re-enabled when a pane is deleted.
• The Event Perspective and SP Performance Monitor Perspective allow only one window, and the addition of only one pane per pane type.
• The System Partitioning Aid does not show the Add Pane option at all; both of its panes are displayed by default.

![Add Pane Dialog Box](image)

Figure 14. The Add Pane Dialog Box

To delete a pane:

1. To delete a pane, specify the pane to delete by clicking in the pane area to give it focus.
2. Click the **Delete** tool bar icon or select **Delete Current Pane** from the **View** menu.
   • The Delete Current Pane menu option is disabled if there is only one pane in the perspective. The control is re-enabled when a pane is added.

2.6.4 Setting the Display Characteristics of Panes

Use the display control options under the **View** menu to set the display characteristics of panes. Refer to “View” on page 9.

2.6.5 Setting the Size of Panes

Use the sash to size the pane.

Move the mouse pointer slowly over the sash (a small square and separator line) until the pointer becomes a cross hair, and then drag the sash until the pane above and below is the size you want.
Once you have arranged the window layout to your satisfaction, you can save and load your customization. See 2.7 “Saving Preferences” and 2.8, “Loading Preferences” on page 35.

2.7 Saving Preferences

Once you have customized the Launch Pad or SP Perspectives windows, you can save your preferences for use across SP Perspectives sessions, or on a per session basis.

To save preferences:
1. Select the Options menu from the Launch Pad or application’s windows menu bar.
2. Select Save Preferences...
3. The Save Preferences dialog box shown in Figure 15 is presented.

![Figure 15. The Save Preferences Dialog Box](image)

Starting and Customizing the SP Perspectives  33
2.7.1 Save Preferences Dialog Box

Use the Save Preferences dialog box to save files containing your preferences for the display aspects (applications, color, fonts, window position and size) of the Launch Pad or application’s windows.

By the Profile to save to: radio button, select to save your preferences data to either a **User** or **System** profile.

- Preferences saved to the User level take precedence over the System level preferences.
- A default System level profile is supplied for each SP Perspectives application.
- You must have write access to the `/usr/lpp/ssp/perspectives/profiles` directory to save preferences to the System level.

Specify a file name into which to save preferences by entering a name in the Profile name: text entry box, or by selecting a name from the pulldown menu.

- Specifying the profile name Profile saves the preferences for use across SP Perspectives sessions. (The file named Profile is the one read by default when SP Perspectives is initialized.)
- Specifying a profile name other than Profile saves the preferences for use on a per-session basis.
- The System profile is saved to `/usr/lpp/ssp/perspectives/profiles/LANG/.PERSPECTIVE_CMD`, where `PERSPECTIVE_CMD` is one of the following:
  - `perspectives` (for the SP Perspective Launch Pad)
  - `sphardware` (for the Hardware Perspective)
  - `spevent` (for the Event Perspective)
  - `spvsd` (for the VSD Perspective)
  - `spsyspar` (for the System Partitioning Aid Perspective)
  - `spperfmon` (for the Performance Monitor Perspective)
- The User profile is saved to `~/.PERSPECTIVE_CMD`, where `PERSPECTIVE_CMD` is one of the following:
  - `perspectives` (for the Perspective Launch Pad)
  - `sphardware` (for the Hardware Perspective)
  - `spevent` (for the Event Perspective)
  - `spvsd` (for the VSD Perspective)
• spsyspar (for the System Partitioning Aid Perspective)
• spperfmon (for the Performance Monitor Perspective)

Select one or more options from **Aspects of preferences to save:**
(applications, colors, font, layouts).

Click **Ok** to save your preferences and close the dialog box, or click **Save** to save your preferences and leave the dialog box open.

To use the profile you just saved when you start your next Perspectives session, see 2.8 “Loading Preferences”.

## 2.8 Loading Preferences

Once you have saved your customization preferences (see “Saving Preferences” on page 33), these preferences are available for loading during SP Perspectives initialization.

### 2.8.1 Loading Preferences at SP Perspectives Initialization

The System and User profiles named Profile are loaded by default when the SP Perspectives is initialized. However, you can use commands to invoke the Launch Pad and the individual SP Perspectives applications. Flags for these commands allow you to specify User and System profile names and color and font preferences. Preferences specified as command line options take precedence over the currently loaded profiles or default values.

The flags provided are:

- **-userProfile** `profilename`
  Where `profilename` is the name you specified when you saved your preferences.

- **-systemProfile** `profilename`
  Where `profilename` is the name you specified when you saved your preferences.

- **-noProfile**
  Do not use Profile.

- **-backgroundColor** `colorName`
  Where `colorName` is the background color of Launch Pad or the SP Perspectives application you are starting.
2.9 Customization Sample

When you use the Hardware Perspective, there are two main tasks:
1. Monitoring your SP system.
2. Controlling your SP system.

This section provides several customization examples for these tasks.

2.9.1 Default Window

When started the first time, the Hardware Perspective provides a default window. This window has two panes: the CWS, System and Syspars pane and the Nodes pane. The default window is shown in Figure 16 on page 37.
In default, you can monitor/control hardware objects of the control workstation, system, system partitions, and nodes.

2.9.2 Single Window with Multiple Panes

In addition to the four default hardware objects, you can monitor/control three additional hardware objects: frames, switches and node groups. To monitor/control these three hardware objects, you have two more panes: the Frame and Switch pane and the Node Groups pane. A Hardware Perspective
window with all four possible panes is shown in Figure 17. Refer to “Displaying Panes in Window” on page 31 to add panes in a window.

![Figure 17. Multiple Panes Single Window](image)

Your SP system may have many nodes, and they can be categorized by applications (for example, Lotus Notes servers, application servers clustered by HACMP ES, scientific and engineering computation servers, and so on). In this case, The Node Groups pane allows you to monitor/control several particular nodes simultaneously.
2.9.3 Multiple Windows

Having many panes in a window is a nice feature. However, when you have many system partitions, nodes, frames, switches, and node groups, a window will become very busy-looking. To avoid this, you can have panes in another window. Figure 18 shows four Hardware Perspective windows, each window having one unique pane. To add panes in another window, refer to “Displaying Panes in Window” on page 31.

![Figure 18. Multiple Windows](image)

2.9.4 Multiple Windows with Multiple Panes

Even you have multiple windows, it is still possible to have multiple panes in each window.
Figure 19 on page 41 shows a method to populate two identical panes in one window. In this case you have four windows and each window has two CWS, System and Syspars panes, Nodes panes, Frames and Switches panes, and Node groups panes, respectively. This allows you to concentrate identical types of hardware objects.

For example, you can monitor hostResponds in one Nodes pane and monitor switchResponds in another Nodes pane. If these Nodes panes are in separate windows and the windows are iconified, you will see the overall monitoring state for each Nodes pane (that is, the window icon will be colored for the overall state of the monitoring in the window).

Another advantage of multiple panes/multiple windows is the ability to have different panes up in different partitions - thus you can bring up a Nodes pane in one window, set the window’s partition to be one system partition, and then bring up another Nodes pane in another window and change the window’s partition to be the other system partition. If your system has two or more system partitions, you can have windows open to view each system partition.
2.9.5 Vertical Window

You might have noticed something different in Figure 19: nodes panes and Frames and Switches panes are arranged in columns. This is called a Vertical view. Hardware Perspective allows you to arrange panes in vertical or horizontal view. We recommend the following:

- When there are few frames, a vertical view is recommended for the Nodes pane, while a horizontal view is recommended for the Frames and Switches pane.
- When there are many frames, a horizontal view is recommended for the Nodes pane, while a vertical view is recommended for the Frames and Switches pane.
To control the view, click **Options** on the menu bar and select **Show as Vertical/Horizontal Panes** from scroll list. For more detail, refer to “Options” on page 10.

### 2.9.6 Reducing Screen Real Estate

When you have multiple windows, the control workstation screen may become busy-looking. There are four ways to save space on the screen:

1. Reduce the size of the window itself.
   
   To change the size of window, refer to “Sizing the Launch Pad or a Window” on page 31.

2. Reduce the size of the pane.
   
   To change the size of pane, refer to “Setting the Size of Panes” on page 32.

3. Hide tool bar icons.
   
   To hide/show tool bar icons, refer to “Options” on page 10.

4. Hide the information area.
   
   To hide/show the information area, refer to “Options” on page 10.

After a while, you may not need the tool bar and information area. Hardware Perspective allows you to hide them.

When you use all these techniques, you can migrate from the screen shown in Figure 19 on page 41 to that shown in Figure 20 on page 43.
Figure 20. Reduced Screen Real Estate

There is a way to save space even more on the screen and that is by using a more slimmed window.

When you control a node, for example when powering a node on or off, you need only one Node pane.

Previous to this release, if you wanted to monitor the hostResponds and switchResponds for the node, you used to need two Nodes panes. Now, however, the Hardware Perspective allows you to monitor both hostResponds and switchResponds by one Nodes pane, if you desire. If hostResponds and/or switchResponds triggers, the Hardware Perspective will let you know the status has changed. The icon turns color from green to grey with red x.

At this point, you do not know which condition has triggered. To find out the details, you need to open the View and Modify Properties notebook and look at the Monitored Conditions page, as shown in Figure 21 on page 44.
To open the View and Modify Properties notebook, double-click the node icon. For more detail, refer to Appendix A.4.4.8, “The Monitored Conditions Page for Nodes” on page 231.

When you use this technique, you can migrate the screen shown in Figure 20 on page 43 to that shown in Figure 22 on page 45; this is known as using a more slimmed window.
2.9.7 Table View

Another way to show a great amount of information in a small space is with the table view shown in Figure 23 on page 46.
Figure 23. Table View Pane

To change your view from icon to table:

1. Click View on the menu bar and select Set Objects in Table View from pulldown menu shown in Figure 24 on page 47.
2. The Set Table Attributes notebook shown in Figure 25 on page 48 is presented.
3. Select **Host responds** and **Switch responds**.

4. Click **Ok** to set objects in table view.

The Status column responds as same way as the node icon in Figure 22 on page 45. The Host responds column and the Switch responds column reflect their status.

When you use this technique, you can migrate the screen shown in Figure 20 on page 43 to that shown in Figure 26 on page 49.
2.9.8 Iconify

As previously explained, the Hardware Perspective can have icon views and table views. However, the Hardware Perspective window itself can be an icon.

For example, if you just want to have an indication given when something goes wrong, you can have Hardware Perspective window as an icon on the screen and still monitor your SP system using this icon. If everything is OK, the icon has a green background color. If the status of a hardware object changes, its background color becomes red. If you find a red background color Hardware Perspective icon, you can open it and examine it for more detail.
Chapter 3. Using the Hardware Perspective Effectively

The SP Hardware Perspective provides a variety of ways for a user to easily monitor and control his SP System. The purpose of this chapter is to allow you to start using the Hardware Perspective as quickly as possible.

3.1 Introduction

Figure 27 shows the default Hardware Perspective window.

![Default Hardware Perspective Window]

Figure 27. Default Hardware Perspective Window
When you add panes, you can have four different types of panes in the one window. For more detail about adding panes, refer to 3.2.2, “Monitoring Conditions in Multiple Panes” on page 60. The Hardware Perspective window shown in Figure 28 has four different panes: CWS, System and Syspars; Nodes; Frames and Switches; Node Groups. Each pane shows a different hardware object or set of hardware objects.

You can monitor and control the hardware objects shown in Figure 28, which shows all possible panes that the Hardware Perspective can have.

![Hardware Perspective with All Four Possible Panes](image-url)
Table 3 shows the actions that can be applied and the default conditions that can be monitored for each hardware object. In addition, the Event Perspective will let you create your own conditions.

Table 2. Relationship between Objects, Actions and Conditions (1 of 2)

<table>
<thead>
<tr>
<th>SP Hardware Object</th>
<th>Actions that can be done</th>
<th>Default Conditions that can be monitored</th>
</tr>
</thead>
</table>
| Node               | - Power On or Cluster Power On (w/ Enable Autojoin)  
                        - Power Off, Reset, Shutdown  
                        - Fence or Unfence  
                        - Network Boot  
                        - Open TTY  
                        - Change Key Switch  
                        - Create Node Group  
                        - Run Command  
                        - LCD and LED Display  
                | - errLog  
                        - hasInactiveBMVSDs  
                        - hostResponds  
                        - keyNotNormal  
                        - nodeEnvProblem  
                        - nodeNotReachable  
                        - nodePowerDown  
                        - nodePowerLED  
                        - nodeSerialLinkOpen  
                        - pageSpaceLow  
                        - rvsInRecovery  
                        - switchNotReachable  
                        - switchResponds  
                        - tmpFull  
                        - varFull |
| IP Node            | - Create Node Group  
                        - Open Administrative Session |
| System Partition   | - Power On or Cluster Power On all the Nodes in the System Partition (w/ Enable Autojoin)  
                        - Estart |
| System             | None |
| Control Workstation| None |

You can monitor for the conditions for all nodes in the system partition. These conditions are listed in the first row of this table.

You can monitor for the conditions for all nodes in the overall system. These conditions are listed in the first row of this table.
3.2 Monitoring Hardware

This section describes effective techniques to monitor hardware.

3.2.1 Aggregate Monitoring in a Single Pane

You can monitor multiple conditions in one pane and see the aggregate monitoring state. The pane shows you a visual indication of what you are monitoring.

To monitor this way:

1. Click the **Nodes** pane as shown in Figure 29. Then click the **Monitor** icon:
2. You will see the Set Monitoring for Nodes notebook, shown in Figure 30. You can monitor as many conditions as you want. To monitor `hostResponds` and `switchResponds`, for example, click these two conditions. For multiple selections, use the Ctrl key, and then click **Ok** or **Apply** to start monitoring.
3. Then you can see the aggregate state for each node for the conditions you are monitoring. There are five monitoring states:

1. Triggered - the condition has been met. This corresponds to a red X or red icon for this object.

2. Unknown - The condition is valid, but the value cannot be determined (there could be a problem communicating with an underlying system, for example). This usually corresponds to a grey question mark icon for the object. However, the icon’s appearance depends on the values of all other conditions that are being monitored at the same time.

3. Acknowledged - The condition was triggered or unknown, and was acknowledged as being such. This usually corresponds to a yellow check mark icon for the object. However, the icon’s appearance depends on the values of all other conditions that are being monitored at the same time.

4. Not Triggered - the condition has not been met. This usually corresponds to a green icon for the object. However, how the icon will
look depends on the values of all the other conditions that are being monitored at the same time.

5. Not Available/Not Monitored - The monitored condition is not available for the object at this time. This value may be caused by a communication or hardware problem, but usually it is because the monitored condition is not valid on the object. It may never be available, such as with keyNotNormal on some node types, or it may become available at some point in the future if the state of the system changes, such as with switchNotReachable. Usually, this corresponds to an unmonitored icon for the object. However, how the icon will look depends on the values of all the other conditions that are being monitored at the same time.

Thus the red X for Node 1 in Figure 31 on page 58 means at least one of the conditions has triggered. If you would like to see which one, double-click on Node 1 to bring up the Monitored Conditions page of the Node notebook. This page is shown in Figure 32 on page 59.
Figure 31. Monitoring Conditions
If you move your mouse over the monitoring text for a given pane, you will see “fly over” information pop-up to tell you more information, as shown in Figure 33 on page 60.
3.2.2 Monitoring Conditions in Multiple Panes

Another way to monitor is to create multiple panes and monitor one condition in each pane. These panes can be inside one window or inside multiple windows.

To monitor in multiple Nodes panes (for example, inside one window), do the following:
1. Click the Add Pane icon on the toolbar:

You will then see the Add Pane dialog box, as shown in Figure 34.

![Add Pane Dialog Box](image)

**Figure 34. Add Pane Dialog Box**

2. In the Add Pane dialog box, select **Nodes** for the Pane type field, and **Current window** for Add pane to field. If you want to set the pane’s name, you can specify any name for Pane title field. The pane title must be unique for the application or an error will be generated. A unique title will be assigned by default. Hit Ok or Apply.

3. You will now have two Nodes panes inside one window, as shown in Figure 35 on page 62.
4. You can monitor one or more conditions for each Nodes pane. To monitor conditions, use the same procedure described in 3.2.1, “Aggregate Monitoring in a Single Pane” on page 54. Each Nodes pane starts monitoring, as shown in Figure 36 on page 63. Each pane will have the conditions it is monitoring for listed in the upper right-hand corner of the pane. You can also change the pane title to reflect the contents of the pane or what you are monitoring in the pane.
To have multiple Nodes panes inside multiple windows:

1. Click the Add Pane icon on the toolbar:

   ![Add Pane Icon]

You will then see the Add Pane dialog box, as shown in Figure 37 on page 64.

Figure 36. Multiple Panes Inside One Window
2. In the Add Pane dialog box, select **Nodes** for the Pane type: field, and **New window** for the Add pane to: field. If you want to set the pane’s name, you can specify any name in the Pane title field.

3. You will have a single Nodes pane inside the original window and a new single Nodes pane inside a new window, as shown in Figure 38 on page 65. This figure is shown after starting monitoring. To start monitoring conditions, follow the same procedure described in section 3.2.1, “Aggregate Monitoring in a Single Pane” on page 54.
The window icon for the window will be colored according to the overall monitoring state for that window.

For example, in Figure 38, you have two separate Nodes panes, each monitoring a different condition (hostResponds and switchResponds). The Nodes pane monitoring hostResponds has no red x’s. The window icon in the left side of the icon box is the icon for that window and will be colored green. The Nodes pane monitoring switchResponds has nodes 8, 11, and 15 triggered for switchResponds and thus showing a red x on those nodes. The
window icon in the right side of the icon box is the icon for that window and will be colored red.

In this way, you can iconify each of the windows, and if a condition that you are monitoring for triggers for an object, the window icon for the window you are monitoring that condition in will turn red. The user can then restore the window and immediately see what the problem is. This can save screen real estate so that a user does not have to keep the Perspective windows up all the time.

3.2.3 Table View

The table view provides you a different view of your data. It allows you to see the objects in the pane, along with a set of selected attributes. In this way you can see a large amount of information very quickly. To show you table view’s benefit, we use the following scenario.

Assume that you set up the Nodes pane to monitor hostResponds, switchResponds, and nodePowerLED. This is shown in Figure 39 on page 67.

To change the view from Icon View to Table View:
Using the Hardware Perspective Effectively

Figure 39. Monitoring in Icon View

1. Click the **Table View** icon on the toolbar:

   ![Table View Icon]

   You will see the Set Table Attributes notebook appear. Select **Power**, **Host responds**, and **Switch responds** for this scenario. This is shown in Figure 40 on page 68.
2. Then click **Ok**. You will see the Nodes pane in the table view, as shown in Figure 41 on page 69.
In the table view for the nodes pane, the first column is the current monitored state of the node. You can see in the upper right-hand corner of the pane the monitoring that is occurring. The second column is the name of the node. The rest of the table consists of columns to display the values of the attributes that were selected to be shown in the table.

Also in the table view you can select any row, which essentially selects the object corresponding to that row. So you can select Node 6 in Figure 53 and apply actions to that object just as you would in the icon view.

You can also sort and filter by column in the table view.

![Table View Nodes Pane](image)

**Figure 41. Table View Nodes Pane**
3.2.4 Filter Objects

There are several ways to filter objects. In this section, we explain two major methods.

3.2.4.1 Filter Objects By Their Monitored State

You can set your nodes pane up so that you monitor for conditions that you are interested in, and then filter by monitored state so that the only objects that appear are those with problems - and this is what an operator is usually interested in. These will dynamically update as events occur. This is especially useful for large system users.

We are currently monitoring as shown in Figure 41 on page 69.

You can filter nodes by the objects’ monitored state. To filter this way:

1. Click the Filter icon:

2. Select Filter objects by their monitored state. There are five states available for monitored state. They are:
   - Triggered
   - Not Triggered
   - Unknown
   - Acknowledged
   - Not Available/Not Monitored

Refer to 3.2.1, “Aggregate Monitoring in a Single Pane” on page 54, for more detail.

You can select as many monitored states as you want. We have, by default, Triggered and Unknown selected. Also set by default is “Show objects that match the filtering criteria”, as shown in Figure 42 on page 71. Then click Ok.
Figure 42. Filter Objects by Their Monitored State

In this example, you now see only nodes 8, 11, and 15 as shown in Figure 43 on page 72.
For more detail about the acknowledged state, refer to 3.2.5, "Acknowledge Monitoring State" on page 76.

3.2.4.2 Filter Objects By Their Label
You can filter objects, in this case nodes, by their label.

One useful example of this would be easily showing any back-level nodes with filtering by label. For the table view, one of the attributes you can show is PSSP code version. In this example, we select **Short reliable hostname** and
**PSSP code version** as attributes in the table as shown in Figure 44. You have the table view shown in Figure 45 on page 74.

![Table Attributes Notebook](image)

*Figure 44. Set Table Attributes Notebook*
Figure 45. Table View with PSSP Code Version

1. Click the Filter icon:

You will then see the Filter Nodes dialog box, as shown in Figure 46 on page 75.
If you want to show only nodes with back-level versions of PSSP, select **Filter objects by their label in the pane**, enter *3.1*, and select to **Hide objects that match the filtering criteria**. You want to hide all nodes that are at PSSP 3.1, and thus only show nodes that are not yet at PSSP 3.1; see Figure 47.
2. You will now see only these nodes that are at a back-level version of PSSP in the table view of the nodes pane, as shown in Figure 48.

3.2.5 Acknowledge Monitoring State

If you know that a node is going to be down or is not installed yet, and you do not want it to contribute to the aggregate monitoring state, you can select that node and acknowledge it. This will now show the node with a yellow check mark, and will take it out of the aggregate monitoring state.
If something triggers on the node again, it will automatically turn to a red X again, coming out of the Acknowledged state. This applies to nodes that have a Triggered (red X) or Unknown (question mark) state.

In this section we use the same scenario as in 3.2.4, “Filter Objects” on page 70. That is, nodes 8, 11, and 15 have triggered for switchResponds. This is shown in Figure 43 on page 72.

Assume that you know node 15 will be off the switch for a while. You know you can ignore this problem, so you can acknowledge node 15. To do this:

1. Select node 15 in the Nodes pane as shown in Figure 49 on page 78. Then click the **Acknowledge** icon:
Figure 49. Select Node 1 To Be Acknowledged

Node 15 turns yellow, with a check mark. This is shown in Figure 50 on page 79.
Figure 50. Node 1 is Acknowledged

Since filtered by monitored state is in effect, node 15 will now be filtered out as shown in Figure 51 on page 80.
3.2.6 Reducing Screen Real Estate

For large system users, you can reduce your node icons by setting the object label (the text below the icon) to none, and then reducing to the small icon size. Figure 52 shows the original icon size.
To change the icons to have no object label:

1. Select **Set Object Label** from the View menu. Then you will have the Set Object Label notebook, as shown in Figure 53 on page 82.
2. Select (none), then click Ok. You will have the small icon size shown in Figure 54 on page 83.
You can further reduce the size by switching to the small icon size. Select **Show Objects as Small Icons** from the View menu. Then your nodes will look like this in Figure 54 on page 83. Note the frame label has also changed.
Figure 55. Smaller Icon Size

Figure 56 shows a 132-node system. You can monitor efficiently in several different ways, as illustrated by the following examples.

Figure 56 shows one node pane with no object label and reduced icon size. The aggregate monitoring state is also shown.
In Figure 57 on page 86 we have three separate node panes, each monitoring a different condition.
In Figure 58 we have three separate node panes, with normal icon size and object label, but with the filtering by monitor state turned on.
3.3 Saving Preferences

You can set up your Hardware Perspective to monitor effectively, and then save it to a user or system profile and reuse it over and over. Things that can be saved out are:

- Colors
- Font
- Number of panes and windows
- Window size and positions
- Pane titles
- What conditions were being monitored in each pane
- If the pane was in table view, the attributes (columns) will be saved out
- Filter by monitor state setting
To save preferences:

1. Select the **Save Preference**... pulldown from the Options menu. You will have the Save Preferences dialog box shown in Figure 59. You can save out to a user profile in your $HOME directory, or as a system profile everyone could share, in /usr/lpp/ssp/perspective/profiles/$LANG.

   In this example, we saved preferences as user profile, and named it MyProfile. In this case, profile MyProfile, is saved as $HOME/.sphardwareMyProfile. For more detail, refer to 2.7, “Saving Preferences” on page 33.

   ![Save Preferences Dialog Box](image)

   **Figure 59. Save Preferences Dialog Box**

   To invoke the saved profile, you can type `sphardware -userProfile MyProfile` from the command line, or you can add an icon on the Launch Pad to invoke the Hardware Perspective with your saved profile.

   To add an icon on the Launch Pad:

2. Select the **Customize Applications** pulldown from the Options menu in SP Perspectives Launch Pad, as shown in Figure 60 on page 89.
3. Then you will enter Customize Mode shown in Figure 61 on page 90.

   We are going to add an icon that starts the Hardware Perspective using
   the profile MyProfile we just created.

   To do this:

4. **Type** My Hardware Perspective in the Name: field. **Type** This icon starts
   Hardware Perspective using MyProfile profile! in the Description: field.
   **Type** /usr/lpp/ssp/bin/sphardware -userProfile MyProfile in the
   Executable file name: field, and **type**
   /usr/lpp/ssp/perspectives/pixmaps/sphardware.m.pm in the Icon file name:
   field. This is shown in Figure 61 on page 90.
5. Click **Add**, then click **Leave Customize Mode**. You will exit from Customize Mode and find your original icon. This is shown in Figure 62 on page 91.

![Figure 61. Add Your Application](image)
Now you can start the Hardware Perspective with your favorite profile by just double-clicking your icon.

3.4 Controlling Hardware

This section provides information about how you can control hardware using the Hardware Perspective.

3.4.1 Basic Hardware Actions

We introduce the different ways you can accomplish a hardware operation. For this example we use powering a node on or off. Refer to Table 3 on page 54 for a list of all actions that can be applied to the hardware objects.

You can perform hardware actions either by selecting one node or multiple nodes, and then selecting the appropriate item from the Actions menu or toolbar. You can also do these actions on a per node basis from the Node Status page of the node notebook.

3.4.1.1 Power Nodes On or Off

There are several ways to power on or power off a node. Each way will bring up the same dialog.
Using Icon On The Tool Bar

You can power nodes on/off using the tool bar icon.

To do this:

1. Select one or more nodes to power on or off from the Nodes pane as shown in Figure 63 on page 93. If the nodes are contiguous, drag the mouse pointer over them. If the nodes are not contiguous, select them while holding down the Ctrl key.

2. Then, depending on which operation you wish to perform, click the **Power On** icon:

![Power On Icon](image)

or the **Power Off** icon:

![Power Off Icon](image)

If you click Power On, you will see the Power On or Cluster Power On dialog as shown in Figure 64. The nodes that you previously selected will be displayed in the dialog.

If you click Power Off, you will see the Power Off, Reset, Shutdown or Fence Nodes dialog box as shown in Figure 65, with the selected node numbers displayed in the dialog.
Using the Actions Menu

You can use the Actions menu instead of the icon on the tool bar. All the functions available from the toolbar are also available from the Actions or View menu.

In the case of Power On:

1. Select one or more nodes to power on from the Nodes pane as shown in Figure 63 on page 93.
2. Select the Power On or Cluster Power On... pulldown from the Actions menu.

Figure 63. Using the Icon on the Tool Bar
3. Then you will see the Power On or Cluster Power On Nodes dialog box shown in Figure 64 on page 94. The nodes that you previously selected are displayed in the dialog box.

![Figure 64. Power On or Cluster Power On Nodes Dialog Box](image)

In the case of Power Off:

1. Select one or more nodes to power off from the Nodes pane, as shown in Figure 63 on page 93.

2. Select the **Power Off, Reset, Shutdown** pulldown from the Actions menu.

3. Then you will see the Power Off, Reset, Shutdown dialog box shown in Figure 65 on page 95. The nodes previously selected are displayed in the dialog box.
Using the Node Status Page

Instead of invoking actions from the toolbar or Actions menu, you can use the Node status page of the Node notebook to perform actions on a per node basis.

To do this:

1. Select one node that you want to power on or off. This is shown in Figure 66 on page 96.
Figure 66. Select One Node You Want to Power On/Off

2. Then click the Notebook icon:

Alternatively, you can double-click on the node without selecting it first.
You will see the View or Modify Properties Node notebook shown in Figure 67 on page 97.
3. In this notebook you can power on or off, fence or unfence, or open a tty. In this example, this node is already powered on, so you will see the Power Off... button.

4. Then you will see the Power Off, Reset, Shutdown or Fence Nodes dialog box shown in Figure 65 on page 95. Enter the node numbers that you want to power off in the Nodes to be operated on: field. Select Power Off in the Power Off options: select box, then click Apply.

3.4.2 Create Node Groups

You can select several nodes to perform actions on from the Actions menu or toolbar, or you can select multiple nodes to create node groups, and then perform these power on/off, fence/unfence, network boot and other actions on the node group.
To create node groups:
1. Select nodes that you are interested in from the Nodes pane.
2. Then select the **Create Node Group**... from the Actions menu.
3. You will see the Create Node Group dialog box shown Figure 68 on page 98, with the selected nodes already input. You can modify this further if desired.

![Create Node Group dialog box](image.png)

**Figure 68. The Node Group Notebook**

4. Type the name for the node group you are going to create in the Node Group Name: field. In this example, we used MyGroup. Then click **Create**. Then you can find your new group, MyGroup, in the Node Groups pane shown in Figure 69 on page 99.
Figure 69. New Node Group MyGroup in the Node Groups Pane

For more details, refer to A.6.3.1, “Creating a Node Group” on page 276.

### 3.4.3 Running Commands on More Than One Node

You can run any command on one node, or on multiple nodes, or on a node group by selecting the nodes or node group, and then selecting **Run Command** from the Actions menu. This uses the `dsh` command and will also verify hostResponds by default. Thus, if any nodes are not responding, it will just go on to the next node instead of hanging.

To use the run command function:
Select nodes that you are interested in from the Nodes pane, or a node group from the Node Groups pane.

Then select Run Command... from the Actions menu. You will see the Run Command dialog box shown in Figure 70.

![Run Command Dialog Box](image)

Figure 70. The Run Command Dialog Box

5. Type the command you want to run on the nodes you selected. Then click Apply.

For more details, refer to A.6.2.8, "Running a Command on Nodes or Node Groups" on page 274.
Chapter 4. Using the Event Perspective Effectively

This chapter describes the Event Perspective application of SP Perspectives.

Using the Event Perspective, you can create event definitions that let you know automatically when resource changes that are important to you have occurred in your SP system. Using the Event Perspective, you can be notified when a node goes down or becomes unreachable, or when the system is close to running out of paging space, or when there’s something wrong with the switch. More importantly, you can know these things have occurred without having the Perspective running.

4.1 Event Management Concepts

It is important to understand the concepts underlying Event Management prior to using it, as described in this section.

4.1.1 What is an Event

An event is the result of a change in the state of a resource within a system partition of your SP system. Examples of resources include nodes, disk drives, memory, software applications, and file systems.

4.1.2 What is an Event Definition

When you create an event definition, you identify:

• The system resources to be monitored.
• The condition you want to be informed about (for example, the node is down).
• How you want the system to respond to the event.
• How you want the system to respond when the condition specified by the event is no longer in effect.
• Whether you want to register (activate) the event definition.
• Whether you want the system to check for a pre-existing instance of this event by doing an initial evaluation.

Event definitions are created on a system partition basis. Thus, you can have different event definitions for each system partition.

Each resource in your system is represented by one or more resource variables that can be monitored. The variables associated with each
registered event are observed by the Event Management subsystem periodically or when the variable changes. At each observation, an event expression is applied. The expression compares the value of the resource variable to a constant or to the value of the variable from the previous observation. If the expression is observed to be true, an event is generated.

You can also specify a rearm expression, which is typically the inverse of the event expression.

4.1.2.1 Using the Event Perspective - An Example

Suppose a resource monitor is keeping track of whether a node is up or down. The resource monitor represents the node state by the IBM.PSSP.Membership.Node.state variable and, as the state of the node changes, it sets the variable equal to a value of 1 (when the node is up) or a value of 0 (when the node is down).

You are interested in knowing when the node goes down, so you use the Event Perspective to define an expression, apply it to the variable, and then register the event definition so that the system can begin to observe the variable. In this case, the expression is:

\[ X = 0 \]

where X represents the IBM.PSSP.Membership.Node.state variable. At each observation, the Event Management subsystem applies the expression to the instance of the variable. If the Event Management subsystem observes that the value of the instance of the IBM.PSSP.Membership.Node.state variable is equal to 0, the expression evaluates to TRUE, and the Event Management subsystem generates an event.

You might also define a rearm expression, to inform you when the node comes back up. The rearm expression alternates with the event expression. It generally serves to inform you when the event expression is no longer true.

4.1.2.2 Registering the Event Definition

Creating an event definition does not make it active. To make an event definition active, you must register it. Once an event definition is registered, the system starts monitoring itself for the condition you have specified.

When you create the event definition, you can choose to have the system perform an initial evaluation, upon registration, to determine whether the event specified by the event definition has already occurred. For instance, suppose you create an event definition to inform you when the key mode switch on node 1 changes from normal to either security or service mode. If you have an initial evaluation done for the event definition and node 1’s key
mode switch is already in service mode, an event is triggered right away. If you do not specify initial evaluation, an event will only occur the next time node 1’s key mode switch changes from normal to another mode.

4.1.2.3 What Triggers an Event
If the event definition includes more than one resource, an event occurs when any of the resources meets the condition specified in the event definition.

For example, if you specify NodeNum=1,3,5,7 as the resource identifier for an event definition, an event occurs when Node 1, Node 3, Node 5, Node 7, or any combination of them meets the condition of the event definition.

Each resource defined in the resource identifier must meet the rearm condition (if any) before the icon returns to its original appearance. If the event definition contains no rearm condition, you need to reset the event definition’s icon to its original appearance after it changes to inform you of an event.

4.1.3 What is a Condition
A condition defines the circumstances within the system which cause an event. A condition is made up of the following parts:

- A resource variable
- A resource identifier
- An event expression
- Optionally, a rearm expression

4.1.4 What is a Resource Variable
The Event Management subsystem informs interested parties whenever the state of a resource changes. A resource is an entity in the system that provides a set of services. Examples of resources include hardware entities such as processors, disk drives, and memory, as well as software entities such as database applications, processes, and file systems. Each resource in the system has one or more attributes that define its state.

The resource state change is reflected by a change in the resource attribute. Each resource attribute is represented by a resource variable, which is the representation of the attribute in the Event Management subsystem. Associated with each resource variable is a name, description, value type, data type, resource identifier and, optionally, a location.
The resource variable name is a string that consists of a resource name, followed by a period, followed by the resource attribute.

The list below includes three examples of resource variable names. Their resource attributes are %totused, busy, and power, respectively. Everything to the left of the resource attribute represents the name of the resource (for example, IBM.PSSP.aixos.FS). Note that the name represents a hierarchical organization, from the general to the specific, similar to an AIX file name.

- IBM.PSSP.aixos.FS.%totused
- IBM.PSSP.aixos.Disk.busy
- IBM.PSSP.HW.Frame.power

Although in simple terms an event is the change in the state of a resource, more correctly, an event is the notification that a relational expression, when applied to a resource variable, evaluates to TRUE.

### 4.1.5 What is a Resource Identifier

Most systems include multiple instances of resources. For example, there is more than one logical volume per node, more than one processor per node (if the node is an SMP node), more than one pool of kernel memory buffers, more than one node in the system partition, and so on.

There are also multiple instances of the resource variables representing these resource states. To uniquely identify each instance of a resource and all of its resource variables, each resource in the system has its own resource identifier.

The resource identifier is specified as an element name/element value pair. The pairing consists of a element name, followed by an equal sign, followed by the element value. For example, node 5 is identified using the resource identifier: NodeNum=5, where NodeNum is the element name and 5 is the element value.

The element name is a string that identifies the resource. An element value identifies the particular instance of the resource. It can be:

- A single value
- A range of values
- A comma-separated list of single values
- A comma-separated list of ranges
As the preceding list suggests, an element name can have multiple element values. For example, the element name

NodeNum=1, 3, 5

represents three separate resources; nodes 1, 3, and 5. A range takes the form a-b and is valid only for integer values.

Note that a resource identifier can contain up to four element names. For example, a variable that represents the number of used blocks in the /tmp file system requires a resource identifier with three element names: the node ID, the volume group name, and the logical volume name. On the other hand, a variable that represents the power state of a node requires only a single element, the node ID.

Table 4 shows some examples of resource variable names and related resource identifiers:

<table>
<thead>
<tr>
<th>Resource Variable Name</th>
<th>Resource Identifier</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM.PSSP.aixos.CPU.gluser</td>
<td>NodeNum=5</td>
</tr>
<tr>
<td>IBM.PSSP.aixos.CPU.kern</td>
<td>NodeNum=5;Cpu=cpu0</td>
</tr>
<tr>
<td>IBM.PSSP.aixos.Mem.Kmem.inuse</td>
<td>NodeNum=5;Type=mbuf</td>
</tr>
<tr>
<td>IBM.PSSP.aixos.Disk.busy</td>
<td>NodeNum=5;Name=hdisk1</td>
</tr>
<tr>
<td>IBM.PSSP.aixos.FS.%totused</td>
<td>NodeNum=5;VG=rootvg;LV=lv100</td>
</tr>
<tr>
<td>IBM.PSSP.aixos.SP_HW.Frame.frACLED</td>
<td>FrameNum=1</td>
</tr>
</tbody>
</table>

Note that although most resource identifiers contain a node number, some variables are not associated with a particular node.

4.1.6 What is an Event Expression

As previously mentioned, an event is the notification that a relational expression, when applied to a resource variable, evaluates to TRUE. The expression is specified as part of a condition.

The expression compares the resource variable to a constant or the previous value of the variable. When the expression is observed to be true, an event is generated. An example of an expression is X < 10, where X represents the resource variable IBM.AIX.aixos.PagSp.%totalfree (the percentage of total free paging space). When the expression is true, that is, when the total free paging space is observed to be less than 10%, the Event Management
subsystem generates an event. Note that X does not always represent a percentage; it represents other types of values as well.

4.1.6.1 Specifying an Expression

Use an uppercase letter X to represent the resource variable. Unmodified, X represents the value of the latest observation of an instance of the resource variable.

You can also use other characters to modify the meaning of X, as follows:

- Use P to indicate the value of the previous observation of the instance.
- Use R to indicate the raw value of the variable instance. This is useful only with variables of type Counter.
- Use the serial number of a specific structured field to indicate the value of the field in a structured byte string variable.

The expression you specify can be arithmetic, logical, or a combination of both. The variable name may be repeated in the expression.

Here are some examples of valid expressions:

<table>
<thead>
<tr>
<th>Expression</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X == 0</td>
<td>The value of the resource variable instance is equal to zero.</td>
</tr>
<tr>
<td>X &amp;&lt; 20</td>
<td></td>
</tr>
<tr>
<td>!(X &amp;&lt; 20</td>
<td></td>
</tr>
<tr>
<td>X@R &gt; X@PR</td>
<td>The current raw value of the variable instance is greater than the raw value of the variable instance from its previous observation.</td>
</tr>
<tr>
<td>X &gt;= X@P + 5</td>
<td>The current value of the variable instance is greater than or equal to the value of the variable instance from its previous observation, plus 5.</td>
</tr>
<tr>
<td>X@2 != 100</td>
<td>For a resource variable instance that is defined as a structured byte string, the value of structured field number 2 is not equal to 100.</td>
</tr>
</tbody>
</table>

This expression is referred to as the event expression, when differentiating it from the rearm expression.
4.1.7 What is a Rearm Expression

A *rearm expression* generates an event that alternates with the event expression as follows:

1. The event expression is used until it is true, then
2. The rearm expression is used until it is true, then
3. The event expression is used, and so on.

The rearm expression can be used in a couple of different ways. Generally, the rearm expression is the inverse of the event expression, but this is not necessary. For example, if the event expression tests whether a resource variable value is on, the rearm expression tests whether it is off.

Here is another example. Suppose you want to know how much disk space is used in your system. You decide that normal disk space usage should not exceed 90%. If the amount of disk space used rises above 90%, you want to be notified. Likewise, you also want to be notified once it falls to an acceptable level again (90% or less).

In this case, you would define the event expression to be: the amount of disk space used is greater than 90%. The expression you would write to support this would be $X > 90$. This expression says that an event will occur when disk space usage ($X$) rises above 90%. You would then define the rearm expression to be: the amount of disk space used is less than 91%. The rearm expression you would write to support it would be $X < 91$. This says that a rearm event will occur when the disk space usage ($X$) falls to 90% or less.

The first time disk space usage rises above 90%, you are notified and the Event Management subsystem switches to the rearm expression. You are not notified again until disk space usage drops to 90% or below (at which time, the Event Management subsystem switches back to the event expression).

Use the same rules and syntax for the rearm expression as you used for the event expression.

4.2 Security Considerations for the Event Perspective

Some Event Perspective tasks require special authorization.

4.2.1 To Define New Conditions

To define new conditions, your user name must have root authority.

If your user name does not have root authority:
• You can create event definitions using existing conditions, but you cannot create or modify conditions.
• Any buttons, toolbar icons, or menu bar options for creating or modifying a condition will not be selectable.

4.2.2 To Define Event or Rearm Event Actions

To define actions to take in response to an event or rearm event, your user name must be associated with a Kerberos principal and your Kerberos principal must be authorized to create problem management subscriptions.

If your Kerberos principal is not authorized to create problem management subscriptions:
• You can select notification options, but you cannot define actions in response to an event or rearm event.
• The Actions page of the Event Definition Notebook is not selectable.

To authorize the Kerberos principal to create problem management subscriptions:
1. Associate your user name with a Kerberos principal.
2. Add the Kerberos principal to the /etc/sysctl.pman.acl on the Control Workstation.
3. Copy the new file to all of the nodes. On the Control Workstation, enter:
   ```
   pcp -a /etc/sysctl.pman.acl /etc/sysctl.pman.acl
   ```

For any actions to succeed that you have defined, your Kerberos principal also must be authorized to take the requested actions.

If your Kerberos principal is not authorized to take the actions you define, the actions fail.

To authorize the Kerberos principal to take the actions you plan to define:
• To be able to execute a command, add the Kerberos principal to the $HOME/.klogin file of the user that will be used to run the command.
• To be able to write an entry in the AIX Error Log and BSD Syslog or to generate an SNMP trap, add the Kerberos principal to the root user’s $HOME/.klogin file.

For more information about problem management authorization, see the “Using the Problem Management Subsystem” chapter of IBM Parallel System Support Programs for AIX: Administration Guide, SA22-7348.
4.3 Common Problems

Following are common problems that occur with the Event Perspective and their solutions:

- Problem: The Event Perspective does not launch.
  
  Solution: Check the following:
  
  1. Make sure you are logged into the control workstation.
  2. Make sure you have the `perspectives` or `spevent` command in your PATH. By default, the commands are in the `/usr/lpp/ssp/bin` directory.
  3. Make sure that your user name is associated with a Kerberos principal. See “Security Considerations for the Event Perspective” on page 107.
  4. Make sure the Event Manager daemon is running.
     
     To display the status of the Event Manager daemon, enter:
     
     ```
     # lssrc -l -s haem.syspar_name
     ```
     
     where `syspar_name` is the name of the system partition of interest.
     
     If the Event Manager daemon is not running, exit SP Perspectives (if necessary) and restart the Event Manager daemon by entering:
     
     ```
     # startsrc -s haem.syspar_name
     ```
     
     where `syspar_name` is the name of the system partition of interest.
     

- Problem: The Event perspective stops running.
  
  Solution: Make sure the Event Manager daemon is running.
  
  To display the status of the Event Manager daemon, enter:
  
  ```
  # lssrc -l -s haem.syspar_name
  ```
  
  where `syspar_name` is the name of the system partition of interest.
  
  If the Event Manager daemon is not running, exit SP Perspectives (if necessary) and restart the Event Manager daemon by entering:
  
  ```
  # startsrc -s haem.syspar_name
  ```
  
  where `syspar_name` is the name of the system partition of interest.
  
  For more information on the Event Manager daemon, see IBM Parallel System Support Programs for AIX: Administration Guide, GC23-3897, GC23-3897.
• Problem: Buttons and fields of the Actions page of the Create or View and Modify Properties Event Definition notebook are grayed out.

Solution: The most likely reason for this to occur is that you are not authorized to define actions. To correct this, see “Security Considerations for the Event Perspective” on page 107.

Also, click the button labeled Action fields are grayed out for security reasons.

• Problem: The actions you defined on the Actions page fail.

Solution: You are not authorized to take the actions you defined. To correct this, see “Security Considerations for the Event Perspective” on page 107.

• Problem: The Create Condition button on the Definition page of the Create or View and Modify Properties Event Definition notebook is grayed out.

Solution: You are not authorized to create conditions. To correct this, see “Security Considerations for the Event Perspective” on page 107.

4.4 Understanding the Event Perspective

The Event Perspective is very powerful in that it allows you to set up your event definitions, and be notified or take an action any time that a problem occurs. You do not need to have the Event Perspective running to get an e-mail, a page, or invoke a command or a script. For example, you can be notified or invoke an action when a node has gone down or when a file system is full. You can also be notified or take action when the problem has been corrected.

To monitor resources in the system, SP Perspectives uses the Event Management subsystem. To take action when events occurs, it uses the Problem Management subsystem (pman).

For example, you can set up an event definition to run one script when a node goes down and another script when the node comes back up.

Figure 71 on page 112 shows the relationship between SP Perspectives’ three major tasks and PSSP subsystems.

The Event Perspective allows you to create event definitions to “wrap around” conditions you are interested in. These can be the default conditions provided in the SDR initially, or new conditions created by the user.

When you create an event definition, there are two parts

1. Notification when the condition triggers or goes back to a normal state.
2. Actions to be taken when the event occurs (the condition has triggered) or when the rearm event occurs (the condition has gone back to normal).

An entry will be added to the event notification log when a registered event definition has the condition change. Actions can be defined to happen when this occurs, such as invoking a script to run, e-mailing someone, having an SNMP trap occur and forwarding the event to the Tivoli Enterprise Console. You can set up an event definition to have an system administrator’s beeper go off when an event occurs (the user writes a script to do this).

The advantage of this approach is that you do not have to be visually watching the system. Notification can be done without the Event Perspective running. You use the Event Perspective to set up the event definition, and a subscription to the Problem Management subsystem is made.
4.5 Getting Started Quickly with the Event Perspective

The Event Perspective provides default event definitions that can be loaded in when you start the Perspective up, or loaded in at any desirable time. These event definitions are for the most commonly monitored events. You can easily
register them and thus very quickly begin to receive notification of the most common problems that can occur in your system. This section also discusses about how you can customize these initial event definitions to take actions when these events occur.

### 4.5.1 Default Event Definitions

There are 19 default event definitions provided. They are:

<table>
<thead>
<tr>
<th>Event Definition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>keyNotNormal</strong></td>
<td>The key mode switch on a node was taken out of the Normal position.</td>
</tr>
<tr>
<td><strong>frameControllerNotResponding</strong></td>
<td>The frame controller is not responding.</td>
</tr>
<tr>
<td><strong>LCDhasMessage</strong></td>
<td>The node’s LED or LCD contains a message.</td>
</tr>
<tr>
<td><strong>nodePowerLED</strong></td>
<td>Node power is off (power LED != 1).</td>
</tr>
<tr>
<td><strong>switchResponds</strong></td>
<td>The switch adapter on the node is not responding or the node is isolated.</td>
</tr>
<tr>
<td><strong>tmpFull</strong></td>
<td>The file system for LV=hd3 and VG=rootvg is over 90% full.</td>
</tr>
<tr>
<td><strong>errLog</strong></td>
<td>A permanent error entry has been added to the error log.</td>
</tr>
<tr>
<td><strong>sdrDown</strong></td>
<td>The sdr daemon on the control workstation has died.</td>
</tr>
<tr>
<td><strong>framePowerOff</strong></td>
<td>The power to the frame has been turned off.</td>
</tr>
<tr>
<td><strong>nodeEnvProblem</strong></td>
<td>The environment indicator LED on the node is illuminated. A hardware problem has been detected.</td>
</tr>
<tr>
<td><strong>nodeSerialLinkOpen</strong></td>
<td>The serial link to the node (TTY) is open.</td>
</tr>
<tr>
<td><strong>nodeNotReachable</strong></td>
<td>Group services has found no way to communicate with the node. The node is presumed to be down.</td>
</tr>
<tr>
<td><strong>switchNotReachable</strong></td>
<td>The switch adaptor on the node is not responding to ip or the node is isolated.</td>
</tr>
<tr>
<td><strong>varFull</strong></td>
<td>The file system for LV=hd9var and VG=rootvg is over 90% full.</td>
</tr>
<tr>
<td><strong>nodePowerDown</strong></td>
<td>The power to the node is off.</td>
</tr>
<tr>
<td><strong>hostResponds</strong></td>
<td>The node is not responding.</td>
</tr>
</tbody>
</table>
The paging space utilized on the node exceeds 85 percent.

One of the file systems is over 90% full.

Switch power is off.

These event definitions can be loaded in by doing the following:

1. Click the Event Definitions pane (if it is not already the current pane).

2. Select **Actions->Load Defaults** from the menu bar to bring up the Load Default Event Definition Dialog shown in Figure 72. Listed in the dialog will be all 19 default event definitions.

3. Select one or more event definitions from the list.

![Figure 72. Load Default Event Definition Dialog Box](image-url)
4. To register the selected event definitions, select **Register the selected event definitions**.

5. Select **Ok** or **Apply** to load (and optionally register) the event definitions you selected. They will now appear in your event definitions pane with the appropriate icon.

If you do not have any event definitions in your pane when you start the Event Perspective, you will be prompted at start-up time to see if you would like to load the default event definitions. Remember, these event definitions are on a per-system partition basis.

### 4.5.2 Registering/Unregistering Event Definitions

You can create an event definition, with or without registering it. Registering the event definition makes it active and causes the system to start monitoring for the condition you have specified. If you create an event definition for later use and do not register it, you can register it using the Register tool bar icon shown in Figure 73.

![Figure 73. Register Tool Bar Icon](image)
If the Event Definition is unregistered, its icon will appear grey. If it is registered, its icon will appear with colors.

4.5.3 Getting Notified when Events Occur

While Event Perspective is running, you can be notified when events occur. If you have registered your default event definitions, you will be notified when events occur in two ways:

1. An entry will appear in the Event Notification Log shown in Figure 84 on page 133. This happens for events occurring in any system partition of the system. If the log is not already open, a window will open displaying it.

2. The event definition’s icon in the event definitions pane turns to an envelope icon:

4.5.4 Taking Actions when Events Occur

Even when the Event Perspective is not running, you can get notifications and take actions when events occur. 4.5.3 describes useful ways to be notified, but an extremely powerful feature of the Event Perspective is the ability to attach actions to these event definitions, and have these actions performed whenever the event occurs.

The Event Perspective makes a subscription to the Problem Management subsystem for you. Thus you can be notified through e-mail, or through a page, or by some other means at any time of the day or night that a problem happened. In addition to running a script to do the e-mail or page, you can run a command or script that will take a particular action when the event occurs. A command or script can also be run notifying you or taking an action when the problem stops (for example, the node that went down is now back up).

To add actions to your default event definition (or any event definition), double-click on the event definition to bring up its Event Definition Notebook. Select the Actions tab of the notebook. The page displayed will let you input which actions to take when the event occurs (the condition triggers) and optionally what actions to take when the rearm event occurs (the condition went back to its normal state). The Actions page in the Create Event Definition notebook is shown in Figure 74 on page 117.
Figure 74. Define Your Actions

To take actions when an Event expression is triggered:

1. Turn on the check box of **Take these actions when the event occurs**.

2. You can run any command or script you would like by simply inputting your command in the **Run Command** box. This example runs the `wall` command.

   You can run a command to send e-mail or a page, or to notify the Tivoli Enterprise Console. See 4.7.4, “Useful Commands and Options” on page 138 for other commands that can be run.

3. If you want to generate an SNMP trap, input the SNMP trap ID in the **Trap ID** box. This example generates trap ID 100.

   An SNMP trap can be caught by the Tivoli event adapter or by IBM’s Netview.
4. If you want to write to the AIX error log and BSD Syslog, input your message in the **Log text**: box. This example writes “My Event occurs” to log files.

Note: You can do all of the preceding actions. They are not mutually exclusive.

To take actions when Rearm expression (optional) is triggered:
1. Turn on the check box of **Take these actions when the rearm event occurs**.
2. If you want to run a command, input your command in the **Run Command**: box. This example runs the `/usr/lpp/ssp/bin/notify_event` shell script.
3. If you want to generate an SNMP trap, input the SNMP trap ID in the **Trap ID**: box. This example generates trap ID 200.
4. If you want to write to AIX error log and BSD Syslog, input your message in the **Log text**: box. This example writes “My Rearm event occurs” to log files.

Note: You can do all of the preceding actions. They are not mutually exclusive.

Actions can occur on the node where the event occurred, on nodes in a particular node group, or on a selected node(s). Node 0 indicates take the action on the control workstation. In this example, actions are to be taken on Node 1 and Node 5.

### 4.6 Customizing The Event Perspective

There are two steps to creating your own events:
1. Create a condition.
2. Create an event definition.

To create an event definition (step 2) you need to create a condition. If you are going to use the condition already in the SDR, you do not need to do step 1, create a condition.

Figure 75 on page 120 shows the relationship between Create Condition (step 1) and Create Event Definition (step 2).

This section uses the following scenario to explain these steps: You are going to submit a job that requires a great deal of CPU resource. You are allowed to
use node 1 or node 7 of your SP system. As soon as node 1 or node 7 becomes more than 90% idle, you like to know this status by the View Event Notification Log dialog box, so you can submit your job to one of these two nodes.

In step 1, Event Perspective asks you several questions by the Create Condition dialog box. When you answer the questions and click Create, Event Perspective creates a new condition. In Figure 75 on page 120, this condition is named MYCPUIdle.

Condition MYCPUIdle monitors CPU usage. If the CPU becomes idle more than 90%, MYCPUIdle triggers event. In this step, you do not need to define which CPU and node should be monitored or what kind of action should be taken for this event; they are defined by step 2.

In step 2, the Event Perspective asks you several questions by the Create Event Definition dialog box. When you answer the questions and click Create, the Event Perspective creates a new event definition.

In this step, you need a condition. You may create your own condition by step 1, or you may use a condition already created. In Figure 75 on page 120, there is an event definition created, named MYCPUIdleEvent. Event Definition MYCPUIdleEvent uses the condition MYCPUIdle created in step 1. MYCPUIdleEvent monitors condition MYCPUIdle of CPU 0, both nodes 1 and 7.

If CPU 0 on node 1 or node 7 becomes idle more than 90%, you will get a notification from the Event Perspective.

The next section uses this example to explain how to create and manage event step by step.
There are 19 pre-defined conditions. They are defined in the EM_Condition SDR class. If one of these pre-defined conditions satisfies your requirement, you can use it instead of creating a condition by yourself.

The pre-defined conditions are:

- LCDhasMessage
- errLog
- frameControllerNotResponding
• framePowerOff
• hasInactiveIBMVSDs
• hostResponds
• keyNotNormal
• nodeEnvProblem
• nodeNotReachable
• nodePowerDown
• nodePowerLED
• nodeSerialLinkOpen
• pageSpaceLow
• rvsdInRecovery
• sdrDown
• switchNotReachable
• switchPowerLED
• switchResponds
• tmpFull

4.6.1 Create Condition

If your Event Perspective does not have a Conditions pane, you will need to add it.

To add a Conditions pane:
1. Select the Add Pane icon on the toolbar. The Add Pane dialog box is presented.
2. For the pane type entry, select conditions if it is not already selected. Then click Ok.
3. The Conditions pane is added to the Event Perspective window.

Figure 76 on page 122 shows these steps.
1. Click View on the menu bar, and select Add Pane ...

2. Click Ok

3. You have Conditions pane.

Figure 76. Add Conditions Pane
If you have the Conditions pane in your Event Perspective window, you are ready to create a condition.

To create a condition:
4. Click the **Conditions** pane to give it a focus.
5. Click **Create**.
6. The Create Condition notebook is presented.

Figure 77 on page 124 shows these steps.
5. Click Create icon on the Tool bar

4. Click Conditions pane

6. You have Create Condition notebook

Figure 77. Open Create Definition Notebook
In the Create Condition notebook, you need to fill in at least following items:

7. **Name:**
   This is a name for the condition you are going to create. You should specify an unique condition name in your SP system. In our example, the condition is named MYCPUIdle.

8. **Description:**
   This is an explanation about the condition. This is just a memorandum, but it is required. In this example, the condition is described as “My CPU is idle more than 90%”.

9. **Select a Resource Variable:**
   You should select one of the Resource Variables from the Resource Variable Names list box. To change the contents of this list, select a different Resource Variable Class in the Resource Variable Classes list box.

   There are more than 400 resource variables available. Following is a strategy to find the resource variable you want.

   1. Examine the Resource Variable Classes list box. Select one of the Reduce Variable Class items that you think is most appropriate. If you want to monitor CPU usage, you must choose **IBM.PSSP.aixos.CPU**.

   2. When you click **IBM.PSSP.aixos.CPU** in the Resource Variable Class list box, the contents of the Resource Variable Names list box should change. If you want to monitor how your SP node is idle, you must choose **IBM.PSSP.aixos.cpu.idle**.

   3. If you need an explanation about this resource variable, click **Show Details** and the **Show Resource Variable Details** dialog box is presented.

10. **Expression:**
    You should specify an expression. If you want to monitor the case where CPU is more than 90% idle, the expression should be **X > 90**.

11. Click **Create** to create a condition.

Figure 78 on page 127 shows these steps.

Notes: 1. You can also create a condition from the Event Definition notebook.
2. The condition you create will also be available from the monitoring dialog in the Hardware Perspectives.
Rearm Expression: and Resource ID Element to be Fixed for the Condition: are optional. For more details, refer to Appendix B.4.1, “Create a Condition” on page 320.
Using the Event Perspective Effectively

Figure 78. Fill in the Create Condition Notebook
12. Your condition, MYCPUIdle, is added in Conditions pane. Shown in Figure 79 on page 128.

![Image of Event Perspective pane with added condition]

**Figure 79. The Created Condition Icon**

### 4.6.2 Create Event Definition

To create an event definition:

1. Click the **Event Definitions** pane to give it focus.
2. Click **Create**.
3. The Create Event Definition notebook is presented.

Figure 80 on page 129 shows these steps.
Using the Event Perspective Effectively

1. Click Event Definitions pane
2. Click Create tool bar icon
3. You have Create Event Definition notebook

Figure 80. Open Event Definition Notebook
In the Create Event Definition notebook, you need to fill in at least the following items:

4. **Event definition name:**
   This is the name of the event definition you are going to create. You should specify an unique event definition name in your SP system. In this example, the event definition is named as MYCPUIdleEvent.

5. **Condition Name:**
   This is a condition name you are going to use. The **Condition Name:** selection box lists the conditions available for the current system partition. From the Condition Name selection box, select a condition. Information pertaining to the selected condition is displayed in the **Condition Description:** box. In this example, you select the condition that you created in “Create Condition” on page 121, which is MYCPUIdle.

   You can also create a condition from this window.

6. **Resource ID elements specified:**
   A resource identifier is a set of name/value pairs. When you select a condition, the element names associated with the designated resource variable appear in the Element Names field.

   When you specify an Element Value for an element name, the complete name/value pair appears in the **Resource ID element specified:** field. In this example, CPU 0 (CPU=cpu0) on Node 1 and Node 7 is selected.

   **Attention**

   The user could also select **Wild-card element values** if he wanted to watch for all the nodes in the system partition having their CPU idle more than 90% of the time. The advantage to doing this (over just selecting all the nodes) is that if a node is added to or removed from the system partition at a later date, the Event Management subsystem will be able to handle this.

7. Click **Create** to create an Event Definition.

   Figure 81 on page 131 shows these steps.

   The **Initial evaluation** and **Registration** buttons on the Definition page, and the **Notification** button on the Notifications page are selected by default. Therefore, your event definition is automatically registered and evaluated when it is created.
Registering the event definition makes it active and causes the system to start monitoring for the condition you have specified. Initial evaluation means that upon registration, the system will determine if the event specified by the event definition has already occurred. For example, when we register MYCPUIdleEvent here, we would be immediately notified if either Node 1 of Node 7’s CPU had become more than 90% idle, instead of having to wait for the next observation interval by the Event Management subsystem.

For more details, refer to Appendix B.3.1, “Create an Event Definition” on page 305.

Figure 81. Fill in the Create Event Definition Notebook

8. Your event definition, MYCPUIdleEvent, is added to the Event Definitions pane shown in Figure 82 on page 132.
When the idle rate of CPU 0 on Node 1 becomes more than 90%, you will be notified. The MYCPUIdleEvent icon changes its shape to the envelope icon shown in Figure 83 on page 133.
Using the Event Perspective Effectively

Figure 83. The Notified Event Definition Icon

At the same time, the View Event Notification Log dialog box shown in Figure 84 pops up.

Figure 84. The View Event Notification Log Dialog Box

To learn more details about the event, do the following:

Step 9

Step 10
9. Click the **event** you want to know more about.

10. Click **View Notification**.

You will see the View Event Notification dialog box shown in Figure 85.

![Figure 85. The View Event Notification Dialog Box](image)

For monitoring node 7, select node 7 instead of node 1 in step 6 of “Create Event Definition” on page 128.
4.7 Other Examples

The following sections describe other ways to use the Event Perspective.

4.7.1 /tmp Is Full

If you want to monitor the /tmp file system, you do not need to create your own condition; the tmpFull condition is available by default. This default condition monitors the /tmp file system and if it becomes over 90% full, it triggers an event. If it becomes under 80% full, it triggers a rearm event.

This default condition is a good example to follow when you want to create similar conditions as explained in the following sections.

4.7.2 /tmp Is Over 80% Full

If you need an event to be triggered when the /tmp file system becomes over 80% full (instead of 90%), and you also need a rearm event to be triggered when the /tmp file system becomes under 70% full (instead of 80%), you can create this condition as follows:

1. Click the Event Definitions pane to give it a focus.
2. Click Create to open the Create Event Definition notebook.
3. Select tmpFull in the Condition Name list box.
4. Click Create Condition... to open the Create Condition notebook, as shown in Figure 86 on page 136.
5. Change Condition Name from tmpFull to another name, for example tmpFull80.
6. Change Event expression from X>90 to X>80.
7. Change rearm expression from X<80 to X<70.
8. Optionally, you may change the Condition Description optionally.
9. Click Create to create the condition.
10. In the Create Event Definition notebook, select the condition tmpFull80, you just made.
Any conditions created in the Event Perspective will show up in the Hardware Perspective’s Set Monitoring notebook. See 3.2, “Monitoring Hardware” on page 54 for more details on Monitoring in the Hardware Perspective.

In Figure 87 on page 137 you see the Hardware Perspective monitoring for this new condition tmpFull80.
4.7.3 /var Is Full

If you want to monitor the /var file system instead of the /tmp file system, you can create this condition as follows:

1. Click the **Event Definitions** pane to give it a focus.
2. Click **Create** to open the Create Event Definition notebook.
3. Select **tmpFull** in the Condition Name list box.
4. Click **Create Condition**... to open the Create Condition notebook, as shown in Figure 88 on page 138.

---

Figure 87. Hardware Perspective Monitoring tmpFull80 Condition
5. Change Condition Name from tmpFull to another name, for example varFull.
6. Change the LV resource ID element in the Resource ID Elements to be Fixed for the Condition (optional) box from hd3 to hd9var.
7. Optionally, you may change the Condition Description.
8. Click Create to create the condition.
9. In the Create Event Definition notebook, select the condition (varFull) you just made.

![Create Condition - varFull](image)

Figure 88. varFull Condition

### 4.7.4 Useful Commands and Options

There are useful commands and options for the Run command: box.
**Commands**

`/usr/lpp/ssp/bin/notify_event` This is a simple utility program to send mail to a user when an event occurs.

`/usr/lpp/ssp/bin/log_event` This logs a string consisting of a description of an event response to a user-defined file.

`wall` This broadcasts a message inside a string to the `aixterm` of all users on the system.

`/usr/lpp/ssp/bin/tecad_pssp` This communicates with the Tivoli Enterprise Console.

**Attention**

In the `notify_event`, `log_event`, and `wall` command, we recommend that you send all messages to one node or to the control workstation to centralize the gathering of notifications.

**Options**

In the `wall` command or inside any script, you can use `$PMAN_IVECTOR` to get the resource identifier of the resource that has the event occurring. For instance, if you used this when node 5 had an event trigger for `hostResponds`, `$PMAN_IVECTOR` would return `NodeNum=5`.

`$PMAN_HANDLE` will return the name of the event definition.

### 4.8 How Do You Know Events Occurred

The status of event definitions are represented by various icons, as shown in Table 5.

**Table 5. Event Perspective Icons**

<table>
<thead>
<tr>
<th>Notification Option</th>
<th>Rearm Expression</th>
<th>Unregistered</th>
<th>Registered/No Event</th>
<th>Registered/Event Occurs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y</td>
<td>Y</td>
<td>4 gray blocks</td>
<td>4-color blocks</td>
<td>White envelope</td>
</tr>
<tr>
<td>Y</td>
<td>N</td>
<td>4 gray blocks</td>
<td>4 blue blocks</td>
<td>Blue envelope</td>
</tr>
<tr>
<td>N</td>
<td>Y</td>
<td>4 gray blocks</td>
<td>2 colors and 2 grays</td>
<td>2 colors and 2 grays</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>(No notification)</td>
</tr>
</tbody>
</table>
Remember that you only get visual notification when the event definition is specified with the notification option (for example, in the first two rows of Table 5). When an event occurs without the notification option, the following occurs:

1. Icons are changed to either a white envelope or a blue envelope.
2. An entry is added to the event notification log.
3. When you open the notebook of the event definition, the notification lists all the reasons, with events, for the event definition.
4. The minimized icon of the Event Perspective should be red to alert users that one or more events occurred for the SP system to save real state.

If there are actions specified for the event definition, the actions will take place.
Chapter 5. For Former spmon GUI Users

In PSSP 3.1, SP Perspectives, the strategic follow-on to the spmon GUI, has been enhanced (particularly the Hardware Perspective) to be functionally equivalent to the spmon GUI. This chapter describes how SP Perspectives takes over the functions of the spmon GUI.

5.1 When spmon GUI Was Used

The spmon GUI was used for:
1. Controlling your SP system
2. Monitoring your SP system

The Hardware Perspective, one of the SP Perspectives’ applications, takes over the functions of spmon GUI.

5.1.1 Controlling Your SP System

When you controlled your SP system using spmon GUI, you opened the System Monitor window first. Next, you opened the Global Controls window. Then, you selected the nodes that you wanted to control. After selecting nodes, you clicked one of the control operation buttons (On, Off, Reset, and so on) and then clicked **Do Command**.
In PSSP 3.1, the Hardware Perspective gives you the interface shown in Figure 89 to control your SP system.

![Figure 89. Hardware Perspective Window](image)

In the Hardware Perspectives window, click the nodes that you want to control. You can select more than one node in any of the following ways:

- Hold down the Ctrl key while making your selections.
- Drag select over contiguous nodes.
- Choose the **Select All** icon on the toolbar, or the **Select All** action from the View pulldown menu. Then you can select the control action from the Actions menu bar shown in Figure 90 on page 143.
To access the type of function provided by the Node front panel in spmon GUI, you can do any of the following to get to the Node Status page in the Node notebook as shown in Figure 91 on page 144:

- Double-click the node.
- Select a node and then click the Notebook icon on the toolbar.
- Select View or Modify Properties from the Actions pulldown.

As you can see, the Node Status page provides information about Power, Host responds, Controller responds, and so on. In addition you can power on or off, fence or unfence, open a tty connection to the node, or network boot the node from this page.
For function accessed through the Frame front panel in spmon GUI, you can access the Frame Status page of the Frame notebook as shown in Figure 92 on page 145.
For Former spmon GUI Users

Figure 92. The Frame Status Page

For function that was provided through the Switch front panel in spmon GUI, you can access the Switch Status page of the Switch notebook as shown in Figure 93 on page 146.
5.1.2 Monitoring Your SP System

When you monitored your SP system using the spmon GUI, you opened the System Monitor window first. Then you opened Node Variable windows from the All Node Summary Display window. The following four node variables are among the most important to monitor in many SP systems:

1. 3DigitDisplay
2. hostResponds
3. powerLED
4. switchResponds

When using the spmon GUI to monitor these four node variables, you opened four Node Variable windows one by one, as follows:

- You clicked the 3DigitDisplay field and then Display all-node summary.
For Former spmon GUI Users

- You clicked the **hostResponds** field and then **Display all>node summary**.
- You clicked the **powerLED** field and then **Display all>node summary**.
- You clicked the **switchResponds** field and then **Display all>node summary**.

At this point, all four Node Variable windows would be open and you could proceed to monitor them.

In a real operation environment, you may then have moved these four windows to their proper places. This can take up a certain amount of screen space, and you would have windows in various locations all over your display. SP Perspectives gives you the ability to have these variables displayed in separate windows if you wish, or to have instead a more compact and efficient display.

The Hardware Perspective gives you the interface shown in Figure 94 on page 148. The top pane monitors hostResponds, the middle pane monitors switchResponds, and the lower pane monitors nodePowerLED.
If you prefer, you can display a more “spmon GUI-like” style with these separate windows, as shown in Figure 95 on page 149.
You can also display the windows as a table view, as shown in Figure 96 on page 150.
Figure 96. Hardware Perspective Table View

Note that the 3DigitDisplay is missing in the Hardware Perspective. This is because Hardware Perspective provides you with 3DigitDisplay as a separate window. To show the 3DigitDisplay window, click *Actions* on the menu bar and select *LCD/LED Display* in the scroll menu. This window is shown in Figure 97.

Figure 97. LCD/LED Display (Left) and F1LCD_popup (Right)
Pressing the left mouse button in a frame causes the slot numbers to appear in the node areas. These numbers are displayed only while the mouse button is pressed. When you click the right mouse button on the node areas, it launches another window, F1LCD_popup, to show the message on LCD. This window is also shown in Figure 97 on page 150.

5.1.3 When You Monitor and Control Your SP System

Again, you do not need two windows to monitor and control your SP system. In Perspectives, you can use one window to do both tasks. Click the nodes in the Hardware Perspective window, and click Actions on the menu bar. You can select one of several operations to perform on that node. This is available in both icon view (shown in Figure 98), and in table view (shown in Figure 99 on page 152).

![Figure 98. Controlling the SP System from Frame View](image-url)
Figure 99. Controlling the SP System from a Table View
5.2 Saving Screen Real Estate with Perspectives

Figure 100 on page 153 shows the monitor screen of spmon GUI.

Figure 101 on page 154 shows the monitor screen of the Hardware Perspective.
If you prefer a table view, that is also available. The table view interface is shown in Figure 102 on page 155.
To save window space, you can minimize the Hardware Perspective windows to icons. Even while iconified, the Hardware Perspective will let you know when a condition is triggered: The window’s icon will change from green to red, and you can then restore the window and investigate the problem.

### 5.2.0.1 Going Beyond spmon GUI with Perspectives

The following functions offered by the Hardware Perspective go beyond what spmon GUI previously offered:

- **Table View**

  In addition to showing system objects represented as icons, you can now also display a pane as a table view of data. Thus you can lay out rows of the system objects, with the column headings being the attributes that you want to view. For more detail, refer to 3.2.3, “Table View” on page 66.
• Filter by Monitor State

You can now set up monitoring for the conditions you are interested in, and then filter the objects in the pane by their monitored state (by default, triggered or unknown states). This allows you to view only the nodes that have problems for conditions that you need to watch for. This is especially useful for large system users who usually only want to watch for problem nodes. For more detail, refer to 3.2.4, “Filter Objects” on page 70.

• Acknowledge the Monitor State

If you use the acknowledge function, you can now ignore certain nodes that you know will be triggered or unknown for certain conditions. For more detail, refer to 3.2.5, “Acknowledge Monitoring State” on page 76.

• Saving Preferences

Once you have your window layouts set up the way you want, you can now save the size, position, and number of windows. You can also save the pane characteristics, such as: What conditions were being monitored in the pane; if the pane was in table view; if filtering by monitor state was turned on; pane titles. In addition, you can set up separate profiles for different scenarios you may want to do. For more detail, refer to 3.3, “Saving Preferences” on page 87.

• Efficient User of Screen Real Estate

The ability to save screen real estate with reduced icon size has been added. You can now iconify the window, and the overall monitored state for the window will be colored in accordingly. In this way, you can save screen real estate and still view the state of your system. For more detail, refer to 3.2.2, “Monitoring Conditions in Multiple Panes” on page 60.

• Node Groups

You can now form node groups and save these to the SDR. You can then perform actions on these node groups such as power on/off, fence/unfence, network boot, and so on. For more detail, refer to 3.4.2, “Create Node Groups” on page 97.

• Run Commands

You can now run commands on multiple nodes. You can do this either by selecting one or more nodes and invoking the Run command from the Actions pulldown, or by selecting a node group and then invoking the Run command from the Actions pulldown menu. For more detail, refer to 3.4.3, “Running Commands on More Than One Node” on page 99.

• Hardware Data

• You can now do an ESTART from the Syspar pane.
For Former spmon GUI Users

- The primary and backup nodes being used for the switch configuration are now displayed.
- SDR data has been consolidated into the configuration page of the object notebook.

Usability
- Online help and fly-over help have been added.
- A fast path to actions with toolbar icons has been added.

5.3 Perform Common Administration Tasks with SP Perspectives

If you previously used the System Monitor GUI to perform hardware administrative tasks, you can now use the Hardware Perspective to perform the same functions. From Table 6 on page 158 to Table 12 on page 164 we list the System Monitor GUI function and the corresponding Hardware Perspective function.

Note that this table does not provide detailed instructions on performing these tasks using the Hardware Perspective. For more detailed information, see
Chapter 3, “Using the Hardware Perspective Effectively” on page 51 or Appendix A, “Monitoring and Controlling Hardware” on page 203.

Table 6. Equivalent Perspectives Function for spmon GUI (1 of 7)

<table>
<thead>
<tr>
<th>System Monitor GUI Function</th>
<th>Equivalent Perspectives Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>All node summaries</td>
<td>To monitor the conditions of nodes:</td>
</tr>
<tr>
<td></td>
<td>1. Ensure that the Nodes pane is displayed and is the current pane. You may need to add a Nodes pane first. Then, click in the Nodes pane to make it the current pane.</td>
</tr>
<tr>
<td></td>
<td>2. Select <strong>View =&gt; Set Monitoring</strong> from the menu bar, or click the Monitoring icon on the tool bar.</td>
</tr>
<tr>
<td></td>
<td>3. Select one or more conditions to monitor. The most common conditions to monitor include hostResponds, switchResponds, and nodePowerLED.</td>
</tr>
<tr>
<td></td>
<td>The most commonly used all node summaries are available for monitoring using Perspectives. Note that the 3DigitDisplay previously available using spmon can be seen by selecting <strong>Actions =&gt; LCD/LED Display</strong>. The Nodes pane must be the active pane in the window.</td>
</tr>
<tr>
<td></td>
<td>Note that you can add multiple Nodes panes and monitor a different condition in each pane, or you can monitor multiple conditions inside one pane.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Display Layouts: Node Front Panel</th>
<th>Variables and controls displayed on the Node Font panel now appear on the Node Status page.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1. Ensure that the Nodes pane is displayed and is the current pane. You may need to add a Nodes pane first. Then, click in the Nodes pane to make it the current pane, and select a node for which to view properties.</td>
</tr>
<tr>
<td></td>
<td>2. Select <strong>Actions =&gt; View or Modify Properties</strong> from the menu bar, or just click the Notebook icon.</td>
</tr>
<tr>
<td></td>
<td>3. Select the <strong>Node Status</strong> page. This is the default page.</td>
</tr>
<tr>
<td>System Monitor GUI Function</td>
<td>Equivalent Perspectives Function</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Display Layouts: Node Environment Layout</td>
<td>Variables and controls displayed on the Node Environment Layout now appear on the Node Environment page.</td>
</tr>
</tbody>
</table>

To display this information:

1. Ensure that the Nodes pane is displayed and is the current pane. You may need to add a Nodes pane first. Then, click in the Nodes pane to make it the current pane, and select a node for which to view properties.

2. Select **Actions => View or Modify Properties** from the menu bar, or just click the Notebook icon.

3. Select the **Node Environment** page.
<table>
<thead>
<tr>
<th>System Monitor GUI Function</th>
<th>Equivalent Perspectives Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Layouts: Node Detail Layout</td>
<td>Variables displayed on the Node Detail Layout now appear on the Node Environment page, except for the following:</td>
</tr>
<tr>
<td></td>
<td>• type (node supervisor card type) and codeVersion (node supervisor code version) are shown on the Configuration page.</td>
</tr>
<tr>
<td></td>
<td>• powerLED (Power) and envLED (Environment LED) are shown on the Node Status page.</td>
</tr>
<tr>
<td>To display this information:</td>
<td></td>
</tr>
<tr>
<td>1. Ensure that the Nodes pane is displayed and is the current pane. You may need to add a Nodes pane first. Then, click in the Nodes pane to make it the current pane, and select a node for which to view properties.</td>
<td></td>
</tr>
<tr>
<td>2. Select Actions =&gt; View or Modify Properties from the menu bar, or just click the Notebook icon.</td>
<td></td>
</tr>
<tr>
<td>3. Select the Node Environment page, or the Configuration page, or the Node Status page.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 9. Equivalent Perspectives Function for spmon GUI (4 of 7)

<table>
<thead>
<tr>
<th>System Monitor GUI Function</th>
<th>Equivalent Perspectives Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Layouts: Frame Environment Layout</td>
<td>Variables displayed on the Frame Environment Layout now appear on the Frame Status page in the Frame notebook.</td>
</tr>
<tr>
<td></td>
<td><strong>To display this information:</strong></td>
</tr>
<tr>
<td></td>
<td>1. Ensure that the Frames and Switches pane is displayed and is the current pane. You may need to add a Frames and Switches pane first. Then click in the pane to make it the current pane, and select a frame for which to view properties.</td>
</tr>
<tr>
<td></td>
<td>2. Select <strong>Actions =&gt; View or Modify Properties</strong> from the menu bar, or just click the <strong>Notebook</strong> icon.</td>
</tr>
<tr>
<td></td>
<td>3. Select the <strong>Frame Status</strong> page in the Frame notebook.</td>
</tr>
<tr>
<td>Display Layouts: Frame Detail Layout</td>
<td>Variables displayed on the Frame Detail Layout now appear on the Frame Configuration page in the Frame notebook.</td>
</tr>
<tr>
<td></td>
<td><strong>To display this information:</strong></td>
</tr>
<tr>
<td></td>
<td>1. Ensure that the Frames and Switches pane is displayed and is the current pane. You may need to add a Frames and Switches pane first. Then click in the pane to make it the current pane, and select a frame for which to view properties.</td>
</tr>
<tr>
<td></td>
<td>2. Select <strong>Actions =&gt; View or Modify Properties</strong> from the menu bar, or just click the <strong>Notebook</strong> icon.</td>
</tr>
<tr>
<td></td>
<td>3. Select the <strong>Frame Configuration</strong> page in the Frame notebook.</td>
</tr>
<tr>
<td>System Monitor GUI Function</td>
<td>Equivalent Perspectives Function</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>----------------------------------</td>
</tr>
</tbody>
</table>
| Display Layouts: Switch Environment Layout | Variables displayed on the Switch Environment Layout now appear on the Switch Status page in the Switch notebook.  
To display this information:  
1. Ensure that the Frames and Switches pane is displayed and is the current pane. You may need to add a Frames and Switches pane first. Then click in the pane to make it the current pane, and select a switch for which to view properties.  
2. Select **Actions => View or Modify Properties** from the menu bar, or just click the **Notebook** icon.  
3. Select the **Switch Status** page in the Switch notebook. |
| Display Layouts: Switch Front Panel | Variables and controls displayed on the Switch Front Panel now appear on the Switch Status page in the Switch notebook.  
To display this information:  
1. Ensure that the Frames and Switches pane is displayed and is the current pane. You may need to add a Frames and Switches pane first. Then click in the pane to make it the current pane, and select a switch for which to view properties.  
2. Select **Actions => View or Modify Properties** from the menu bar, or just click the **Notebook** icon.  
3. Select the **Switch Status** page in the Switch notebook. |
Table 11. Equivalent Perspectives Function for spmon GUI (6 of 7)

<table>
<thead>
<tr>
<th>System Monitor GUI Function</th>
<th>Equivalent Perspectives Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Layouts: Switch Detail Layout</td>
<td>Variables displayed on the Switch Detail Layout now appear on the Switch Status page in the Switch notebook (except for type and codeVersion, which are on the Configuration notebook page). To display this information: 1. Ensure that the Frames and Switches pane is displayed and is the current pane. You may need to add a Frames and Switches pane first. Then click in the pane to make it the current pane, and select a switch for which to view properties. 2. Select Actions =&gt; View or Modify Properties from the menu bar, or just click the Notebook icon. 3. Select the Switch Status page in the Switch notebook.</td>
</tr>
<tr>
<td>Display Layouts: Switch Diagnostics Layout</td>
<td>Variables displayed on the Switch Diagnostics Layout now appear on the Switch Status page of the Switch notebook. To display this information: 1. Ensure that the Frames and Switches pane is displayed and is the current pane. You may need to add a Frames and Switches pane first. Then click in the pane to make it the current pane, and select a switch for which to view properties. 2. Select Actions =&gt; View or Modify Properties from the menu bar, or just click on the Notebook icon. 3. Select the Switch Status page in the Switch notebook.</td>
</tr>
</tbody>
</table>
### Table 12. Equivalent Perspectives Function for spmon GUI (7 of 7)

<table>
<thead>
<tr>
<th>System Monitor GUI Function</th>
<th>Equivalent Perspectives Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Controls</td>
<td>Information displayed through the spmon Global Controls function is available by:</td>
</tr>
<tr>
<td></td>
<td>1. Selecting the nodes in the Nodes pane for which you want information.</td>
</tr>
<tr>
<td></td>
<td>2. Selecting Actions from the menu bar.</td>
</tr>
<tr>
<td></td>
<td>The following actions are available:</td>
</tr>
<tr>
<td></td>
<td>• Power Off, Reset, or Shutdown: to perform a power off with setting certain options such as a straight power off or reset, a shutdown or cshutdown, or fence or fence with autojoin.</td>
</tr>
<tr>
<td></td>
<td>• Power On or Cluster Power On: to power on one or more nodes with the options for performing a straight power on or a cstartup.</td>
</tr>
<tr>
<td></td>
<td>• Change Key Switch: change key switch position on nodes that have a key switch.</td>
</tr>
<tr>
<td></td>
<td>• Fence or Unfence: fence or unfence nodes.</td>
</tr>
<tr>
<td></td>
<td>• Open TTY: to open TTY windows to selected nodes.</td>
</tr>
<tr>
<td></td>
<td>• Run Command: run a command on selected nodes.</td>
</tr>
<tr>
<td></td>
<td>• Network Boot: network boot a node.</td>
</tr>
<tr>
<td>Topology</td>
<td>Not currently supported in Perspectives.</td>
</tr>
</tbody>
</table>
Chapter 6. The IBM Virtual Shared Disk Perspective

This chapter introduces you to the IBM VSD Perspective. Many tasks such as monitoring and filtering that can be done in the Hardware Perspective can also be done in the IBM VSD Perspective (see Chapter 3, “Using the Hardware Perspective Effectively” on page 51). For additional examples of tasks that can be performed with the IBM VSD Perspective, see IBM Parallel Systems Support Programs for AIX: Managing Shared Disks, SA22-7279. Be sure to see the IBM VSD Perspective Overview, the Monitoring Virtual Shared Disks section, and Appendix A, “Interface Cross-References”.

6.1 Enhancements and Changes

Many improvements and changes were made to the IBM VSD Perspective since the previous release:

• Separate IBM VSD and IBM HSD panes.
• Relationship filters that limit the amount of information displayed in each pane.
• The ability to display object attributes in a table format.
• Automatic refreshing of panes, notebooks, and the table view when there is a change to either the SDR or the IBM VSD subsystem.
• Support for more virtual shared disk commands from the Actions menu.
• New conditions for monitoring: hasInactiveIBMVSDs and rvsdInRecovery.
• Simplified IBM VSD Node Properties notebooks.
• Refreshing of the Recoverable Virtual Shared Disk subsystem from the Control IBM RVSD Subsystem dialog from the Actions menu. This refresh is a new option in the RVSD subsystem.

The tree type display and the concept of direct and indirect clients in the Nodes pane in previous releases was removed.

Most of the new functionality allowing virtual shared disk management from the IBM Virtual Shared Disk Perspective is not available on any nodes that are running earlier releases. Nodes with PSSP versions earlier than 3.1 cannot use the IBM Virtual Shared Disk Perspective to:

• Monitor conditions related to IBM VSDs.
• Obtain configuration information for IBM VSDs and IBM HSDs in the notebooks or table view. These pages will be blank and so will the table cells.
• Obtain the state of IBM VSDs or the state of the IBM RVSD subsystem.
• Use the filter to show related functions.

In order to carry out the above functions for nodes with PSSP versions earlier than 3.1, the virtual shared disk line commands must be used.

6.2 Panes in the IBM VSD Perspective Window

Four panes are available in the IBM VSD Perspective window:
• CWS and Syspars
• Nodes
• IBM VSDs
• IBM HSDs

By default, you will see the CWS and Syspars pane and the Nodes pane. Figure 103 on page 167 shows the IBM VSD Perspective window with all four panes.
6.3 Using the IBM VSD Perspective

In the following example, we configure a number of virtual shared disks using the IBM Virtual Shared Disk Perspective. Using this Perspective requires your Kerberos principal to be defined in the virtual shared disk sysctl access control lists, /etc/sysctl.vsd.acl and, /etc/sysctl.acl. The system administrator must run the command `sysctl svcrestart` for these changes to take effect. Once you have the correct authorization, you can start the IBM VSD Perspective either from the Launch Pad or by issuing the `spvsd` command. The initial screen should appear similar to Figure 104 on page 168.
For any nodes to become virtual shared disk servers or clients they must have the virtual shared disk LPP installed. The Recoverable Virtual Shared Disk extension is now packaged with the standard Virtual Shared Disk code. Once the code has been installed on nodes, all virtual shared disks can be controlled from the IBM VSD Perspective. Referring to Figure 104 on page 168, we select nodes 1, 5, 6 and 7 and from the menu bar select **Actions->Designate as an IBM VSD Node**. After confirming the action, those nodes will have a blue disk attached to their icon as shown in Figure 105 on page 169.
Our next step is to create virtual shared disks for use by these nodes. If an IBM VSDs pane is not already present, you must add one. To add an IBM VSDs pane, either click on the Add Pane tool bar icon or select View->Add Pane... to bring up the add pane dialog shown in Figure 106 on page 170.
Figure 106. Add Pane Dialog

The options available for selecting a pane type are CWS and Syspars, Nodes, IBM VSDs and IBM HSDs. Select IBM VSDs as shown and click **Ok**. The new pane is created. Make this pane, IBM VSDs:1, the current pane and select **Actions->Create** from the menu bar. A Create IBM VSDs dialog box opens for the creation of virtual shared disks as shown in Figure 107 on page 171.
In our example we select node 5 and hdisk1. The disk is not allocated to any volume group. We define four virtual shared disks of 20 MB and a volume group called extvg. If the disk was in a shared disk subsystem, for example in an SSA loop with node 6, we could use Recoverable Virtual Shared Disks by using node 6 as the backup node. We click Ok. This now creates the volume group and logical volumes for virtual shared disk use on node 5.

The IBM VSDs pane in Figure 108 on page 172 now shows the newly created virtual shared disks.
Figure 108. New Virtual Shared Disks in the IBM VSDs Pane

We can see the addition of these logical volumes. Select node 5, and then select Actions->Run Command... to bring up the Run Command dialog and type in lsvg -l extvg. The Run Command dialog with associated output is shown in Figure 109 on page 173.
We now configure the virtual shared disks on different nodes. In the Nodes pane, select Nodes 5 and 6, and then from the menu bar select **Actions->Configure IBM VSDs...** to bring up the Configure IBM VSDs dialog as shown in Figure 110 on page 173.
We select the button with multiple arrows pointing to the left to select all the virtual shared disks and press **Ok**. All the virtual shared disks are now configured on nodes 5 and 6.

You can also configure virtual shared disks from the IBM VSDs pane. In this example we select vsd1n5 and vsd3n5 and select **Actions->Configure...** and use the dialog to configure these virtual shared disks on node 1. We similarly configure vsd2n5 and vsd4n5 on node 7.

Now make the following selections in the IBM VSD Perspective:

- To save screen real estate you can highlight the CWS and Syspars pane and select **View->Delete Pane**.
- Using the left mouse button select nodes 1, 5, 6 and 7 in the Nodes pane.
- Select **View->Filter->Filter the selected objects in the pane->Ok**.
- Select **View->Show Objects in Table View**.
- From the Set Table Attributes dialog choose:
  - **Active IBM VSDs count**
  - **Suspended IBM VSDs count**
  - **Stopped IBM VSDs count**

The result of these actions is shown in Figure 111 on page 175.
Now to make these virtual shared disks active, select all the IBM VSD Nodes (nodes 1, 5, 6 and 7). Select **Actions->Change IBM VSDs State...**, select the button with multiple arrows pointing to the left, and select **Active State**, as shown in Figure 112 on page 176.
The results of this operation are shown in Figure 113 on page 177. The virtual shared disks are now active.
6.4 Actions Available in the IBM VSD Perspective

In addition to the create and configure actions described in the example in 6.3, “Using the IBM VSD Perspective” on page 167, many other actions are available in the IBM VSD Perspective. This section provides an overview of these actions.

6.4.1 CWS and Syspars Pane Actions

Two actions are available for objects in the CWS and Syspars pane:

- Common Action for both CWS and Syspar objects:
  View Properties...
- Action for Syspar objects:
  Set Current System Partition
These actions are shown in Figure 114 on page 178 and Figure 115 on page 179. They work as they do in the Hardware Perspective.

Figure 114. Actions for CWS Object
6.4.2 Nodes Pane Actions

There are 12 actions available for objects in the Nodes pane:

- Common Actions for all nodes:
  - View and Modify Properties...
  - Open TTY...
  - Run Command...
  - Display IBM VSD Diagnostics...
- Action for nodes not designated as IBM VSD nodes:
  - Designate as an IBM VSD Node...
- Actions for nodes designated as IBM VSD nodes:
  - Remove IBM VSD Node Designation
  - Control IBM RVSD Subsystem...
• Configure IBM VSDs...
• Unconfigure IBM VSDs...
• Configure IBM HSDs...
• Unconfigure IBM HSDs...
• Change IBM VSDs State...

These actions are shown in Figure 116 and Figure 117 on page 181.

Figure 116. Actions for Nodes Not Designated as IBM VSD Nodes
6.4.3 IBM VSDs Pane Actions

There are nine actions available for objects in the IBM VSDs pane:

- View Properties...
- Create...
- Remove
- Define...
- Undefine
- Configure...
- Unconfigure...
- Change Owner and Group...
- Change State...
These actions are shown in Figure 118.

**Figure 118. Actions for IBM VSDs**

### 6.4.4 IBM HSDs Pane Actions

There are seven actions available for objects in the IBM HSDs pane:

- View Properties...
- Create...
- Remove
- Define...
- Undefine

---

182  SP Perspectives: A New View of Your SP System
• Configure...
• Unconfigure...

These actions are shown in Figure 119.

![Figure 119. Actions for IBM HSDs](image)

### 6.5 Notebooks Available in the IBM VSD Perspective

A notebook represents properties of an object. Some of the notebook pages available in the IBM VSD Perspective are identical to the pages in the notebooks of the Hardware Perspective. This section provides an overview of the notebook pages in the IBM VSD Perspective. For detailed information about each page in the notebooks, select Help at the bottom of the notebook dialog.
6.5.1 The CWS Notebook
The CWS notebook has the following pages, which are identical to the Hardware Perspective:
- Identification
- Monitored Conditions

6.5.2 The Syspar Notebook
The Syspar notebook has the following pages, which are identical to the Hardware Perspective:
- Configuration
- Switch Configuration
- Monitored Conditions

6.5.3 Notebook for a Node Not Designated as an IBM VSD Node
A Node notebook has the following pages, which are identical to the Hardware Perspective:
- Node Status
- Configuration
- All Dynamic Resource Variables
- Monitored Conditions

6.5.4 Notebook for a Node Designated as an IBM VSD Node
The following IBM VSD Node notebook pages are identical to the Hardware Perspective:
- Node Status
- Configuration
- All Dynamic Resource Variables
- Monitored Conditions

There are five pages in the IBM VSD Node notebook unique to the IBM VSD Perspective:
1. The IBM VSD Status page, shown in Figure 120 on page 185.
   This page lists the following attributes:
   - Active IBM VSDs count: Lists the number of active IBM VSDs.
• Suspended IBM VSDs count: Lists the number of suspended IBM VSDs.
• Stopped IBM VSDs count: Lists the number of stopped IBM VSDs.
• IBM RVSD subsystem: Indicates the state of the IBM RVSD subsystem.

The values on this page are unknown (or question marks) until at least one IBM VSD is configured on the node. They update automatically at approximately one-minute intervals.

Figure 120. IBM VSD Status Page

2. The IBM VSD Node Attributes page is shown in Figure 121 on page 186. This page can be used to view or modify the following attributes for an IBM VSD Node:
   • IBM VSD adapter
   • Initial cache buffer count
   • Maximum cache buffer count
   • Request block count
• Outstanding LV read/write requests
• Minimum buddy buffer size
• Maximum buddy buffer size
• Number of buddy buffers
• Maximum IP message size

For detailed descriptions of these attributes as well as recommended values, select Help at the bottom of the notebook dialog.

Figure 121. IBM VSD Node Attributes Page

3. The Configured IBM VSDs and HSDs page is shown in Figure 122 on page 187.

The Configured IBM VSDs and HSDs page has two sections:

1. The Configured IBM VSDs section lists the following attributes:
   • IBM VSD Name: Lists the name of each IBM VSD configured on the node.
   • IBM VSD State: Shows the state of each IBM VSD.
   • Primary Server Node Number: Shows the primary server node number.
• IBM VSD Minor Number: Shows the minor number of the logical volume.
• Cache Option: Shows either Cache or No cache.

2. The Configured IBM HSDs section lists the name of each IBM HSD configured on the node.

The values on this page update automatically at approximately one-minute intervals.

Figure 122. Configured IBM VSDs and HSDs Page

4. The IBM VSD Node Statistics page is shown in Figure 123 on page 188.

This page lists information returned from the `statvsd` and `vdsklst` commands. For a detailed description of the information on this page, select Help at the bottom of the notebook dialog.

There are complex interactions among these statistics. For information on how to analyze them and what actions to take, see the chapter on performance in *Parallel System Support Programs for AIX: Managing Shared Disks*. 
5. The IBM HSD Node Statistics Page is shown in Figure 124 on page 189. This page lists information returned from the `ctlhslsd` and `hsdatalst` commands. For a detailed description of the information on this page, select Help at the bottom of the notebook dialog.
6.5.5 The IBM VSD Notebook

An IBM VSD notebook has two pages, and they are unique to the IBM VSD Perspective:

1. The IBM VSD Attributes page, shown in Figure 125 on page 190.

   This page lists the following attributes of an IBM VSD that you can view:
   - The IBM VSD name
   - The primary server node for this IBM VSD
     This is the node that manages the IBM VSD.
   - The secondary server node for this IBM VSD, if any
     Secondary server nodes only apply to IBM VSDs that are managed by the IBM Recoverable Virtual Shared Disk subsystem. The secondary server node manages the IBM VSD if the primary server node has failed or lost its connection to the switch.
   - The IBM VSD minor number
   - The physical disks spanned by this IBM VSD
- The local volume group name that was assigned to this IBM VSD when it was created
- The global volume group name to which this IBM VSD belongs
- The logical volume name
- The current setting of the cache option (Cache or No cache)

Figure 125. IBM VSD Attributes Page

2. The IBM VSD Client Nodes page is shown Figure 126 on page 191. This page displays the following attributes:
   - Node number of the node on which this IBM VSD is configured
   - State of this IBM VSD with respect to this client (may be Active, Stopped, or Suspended)
6.5.6 The IBM HSD Notebook

An IBM HSD notebook has three pages, and they are unique to the IBM VSD Perspective:

1. The IBM HSD Attributes page is shown in Figure 127 on page 192.

   This page lists the following attributes of an IBM HSD that you can view:
   - The IBM HSD name
   - The stripe size for this IBM HSD
   - Whether or not to skip the first stripe to protect the Logical Volume Manager control block (protected or not protected)
2. The IBM HSD Client Nodes page is shown in Figure 128 on page 192. This page displays the following attribute: the number of the node on which this IBM HSD is configured.

3. The IBM VSD List page is shown in Figure 129 on page 193. This page displays the list of IBM VSDs that comprise this IBM HSD.
6.6 Relationship Filters

The IBM VSD Perspective provides a mechanism to filter objects in one pane based on some relationship with objects in other panes. Relationships between nodes, IBM VSDs and IBM HSDs can be determined by first selecting an object and then selecting one of the relationship filters on the View pulldown menu or from the tool bar. You can select the fast path operations that automatically add a pane filtered by the most common relationship, or you can bring up the Filter to Show Related Objects dialog. The following sections describe this dialog based on the object type you selected before bringing up the dialog.

6.6.1 Objects Related to Nodes

You can filter to show related objects for the selected nodes by selecting either the Related IBM VSDs or Related IBM HSDs tab located on the right side of the Filter to Show Related Objects for Selected Nodes dialog.

6.6.1.1 For IBM VSDs Related to the Selected Nodes

In the Show section of the notebook shown in Figure 130 on page 194, select whether to show either of the following:

- Which IBM VSDs are configured on the selected nodes

You can choose any or all of the following:
- In the Active state
- In the Suspend state
- In the Stopped state
- Which IBM VSDs have the selected nodes as a server.

You can choose one or both of the following:
- Primary server
- Backup server

![Figure 130. Related IBM VSDs for the Selected Nodes](image)

6.6.1.2 For IBM HSDs Related to the Selected Nodes

In the Show section of the notebook shown in Figure 131 on page 195, the following option is selected:

which IBM HSDs are configured on the selected nodes
6.6.2 Objects Related to IBM VSDs

You can filter to show related objects for the selected IBM VSDs by selecting either the Related IBM VSD Nodes or Related IBM HSDs tab located on the right side of the Filter to Show Related Objects for Selected IBM VSDs dialog.

6.6.2.1 For IBM VSD Nodes Related to the Selected IBM VSDs

In the Show section of the notebook shown in Figure 132 on page 196, select whether to show either of the following:

- Which nodes are a client of the selected IBM VSDs
- Which nodes are a server for the selected IBM VSDs

You can choose one or both of the following:

- Primary server
- Backup server
6.6.2.2 For IBM HSDs Related to the Selected IBM VSDs

In the Show section of the notebook shown in Figure 133 on page 197, the following option is selected:

Which IBM HSDs are defined by the selected IBM VSDs
6.6.3 Objects Related to IBM HSDs

You can filter to show related objects for the selected IBM HSDs by selecting either the Related IBM VSDs or Related IBM VSD Nodes tab located on the right side of the Filter to Show Related Objects for Selected IBM HSDs dialog.

6.6.3.1 For IBM VSDs Related to the Selected IBM HSDs

In the Show section of the notebook shown in Figure 134 on page 198, the following option is selected:

Which IBM VSDs define the Selected IBM HSDs
6.6.3.2 For IBM VSD Nodes Related to the Selected IBM HSDs

In the Show section of the notebook shown in Figure 135 on page 199, the following option is selected:

Which nodes are a client of the Selected IBM HSDs
6.7 Monitoring

Monitoring in the IBM VSD Perspective is set up the same way as it is in the Hardware Perspective. See Chapter 3, “Using the Hardware Perspective Effectively” on page 51.

In addition to the conditions provided in the Hardware Perspective, the following two conditions are provided for monitoring on the IBM VSD Nodes:

- hasInactiveIBMVSDs - Triggers when one or more of the IBM VSDs configured on the node are in the stopped or suspended state.
- rvsdInRecovery - Triggers when the IBM RVSD subsystem on the node goes into the recovery state.
Figure 136 on page 200 shows the IBM VSD Perspective window with four panes defined:

- The first two panes are defined as they were in Figure 111 on page 175. We make just a single change to this display by activating monitoring through Actions->Set Monitoring or by clicking the Set Monitoring icon on the tool bar. From the Set Monitoring dialog we select hasInactiveIBMVSDs. This updates the state column and also allows us to acknowledge the state of any node where the condition has triggered or is unknown.
• The third pane was added by selecting vsd1n5 and then selecting View->Filter to Show Related Objects, and selecting Which nodes are a client of the selected IBM VSDs. See 6.6, “Relationship Filters” on page 193.

• The fourth pane was added by selecting vsd1n5 and then selecting View->Filter to Show Related Objects, and selecting Which nodes are a server for the selected IBM VSDs. 6.6, “Relationship Filters” on page 193.

• The third and fourth panes were then changed to table view by selecting View->Show Objects in Table View and selecting the following attributes:
  • Host responds
  • Switch responds
  • Short initial hostname

With monitoring active we can iconify the IBM VSD Perspective and the icon will change color as the aggregate state of all the conditions being monitored changes. See Figure 137 for examples of the state changes of the IBM VSD Perspective icon.

![Figure 137. State Changes to the IBM VSD Perspective Icon](image)

The figure on the left represents a gray window icon for the IBM VSD Perspective; this means that monitoring is not active in this window. The second figure from the left represents a green window icon; this means that none of the conditions being monitored in the window have triggered. The third figure from the left represents a red window icon; this means that at least one condition being monitored in the window has triggered. The fourth figure from the left represents a yellow “acknowledged” window icon; this means that at least one condition being monitored has triggered and has been acknowledged.
Appendix A. Monitoring and Controlling Hardware

This appendix describes how you can monitor and control hardware by using the Hardware Perspective. The Hardware Perspective help you to monitor and control:

• The Control Workstation
• The system (global view)
• System partitions
• Nodes
• Node groups
• Frames
• Switches

Hardware can be monitored and controlled from a system or system partition level.

For new SP Perspectives features, refer to A.7, “SP Perspectives Examples” on page 281.

A.1 Security Considerations

Before you use the Hardware Perspective, you must establish certain authorizations. If your user name is not registered in the SP System Monitor Access Control List (ACL), you cannot use SP System Monitor. For example you cannot power on or off frames, switches, or nodes.

Use the following procedures to authorize your user name to use the SP System Monitor. If you are not authorized to make these changes yourself, ask the person who administers security on your system to do these steps for you.

1. To authorize the user to use SP System Monitor, add the user to /spdata/sys1/spmon/hmacls on the control workstation.

2. To activate this permission, you need to refresh the hardmon daemon; to do this, execute the following command:

   # hmadm setacls

You should now be able to use SP System Monitor.
A.2 The Hardware Perspective Interface

The following section describes the Hardware Perspective interface.

A.2.1 Selecting Objects

You can select the following SP hardware objects on which to perform actions from the Hardware Perspective:

- Control workstation, system, system partitions
- Nodes
- Node groups
- Frames and switches

Icons of these hardware objects are displayed in panes. The control workstation, system, and system partition icons are grouped together in a single pane, and the frames and switches icons are grouped together in another single pane.

To select a hardware object on which to perform an action:

1. If necessary, add the pane containing the desired hardware object by clicking the Add Pane toolbar icon. Refer to “Displaying Panes in Window” on page 31.
2. Select the pane for the desired hardware objects.
3. Move the cursor to the desired pane and click the icon of the hardware object to select an individual object. You may select multiple objects.
4. Select the action to be performed against the hardware object from the menu bar or toolbar.
A.2.2 Tool Bar

The tool bar icons are shown in Figure 138:

![Tool Bar Icons](image)

*Figure 138. The Tool Bar Icons*

From left to right, they perform the following functions:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notebook</td>
<td>View hardware attributes.</td>
</tr>
<tr>
<td>Power On</td>
<td>Powers on hardware.</td>
</tr>
<tr>
<td>Power Off</td>
<td>Powers off hardware.</td>
</tr>
<tr>
<td>Sort</td>
<td>Displays objects by name in either ascending or descending order.</td>
</tr>
<tr>
<td>Filter</td>
<td>Specifies which objects are displayed in a pane.</td>
</tr>
<tr>
<td>Remove Filter</td>
<td>Undoes a Filter action and redisplays all objects in a pane.</td>
</tr>
<tr>
<td>Select</td>
<td>Selects all objects in the selected pane.</td>
</tr>
<tr>
<td>Deselect</td>
<td>Deselects all objects in the selected pane.</td>
</tr>
<tr>
<td>Add Pane</td>
<td>Add a pane.</td>
</tr>
<tr>
<td>Delete Pane</td>
<td>Delete the current pane from this window.</td>
</tr>
<tr>
<td>View</td>
<td>Show objects in the table view or the icon view.</td>
</tr>
<tr>
<td>Monitor</td>
<td>Provides a dynamic display of selected hardware object status.</td>
</tr>
</tbody>
</table>

Note

- To select multiple objects that are next to each other in a pane, click the icon of the first desired object, hold the left mouse button down, and move the cursor over the icons of other desired objects in the pane.
- To select multiple objects that are *not* next to each other in a pane, hold the Ctrl key on your keyboard down while you click each desired object in the pane.
Acknowledged

A.3 Setting the Current System Partition

To set the current system partition:

1. Select the desired System Partition object or the System object from the CWS, System and Syspars pane.
2. Click Actions from the menu bar.
3. Click Set Current System Partition.

The name of the current system partition is displayed (following the name of the Hardware Perspective and the control workstation name) in the window title bar. If the System object was set as the current system partition, the term Global follows the name of the Hardware Perspective and the control workstation name in the title bar.

In addition, in the CWS, System and Syspars pane, the icon of the current system partition is displayed with a lightning bolt. The icon looks like Figure 139.

![Figure 139. The Icon of the Current System Partition](image)

When the current system partition is changed, fresh SDR data is retrieved for any panes that contain system partition-dependent objects.

A.4 Viewing Hardware Attributes

Hardware objects have a variety of attributes associated with them. Attributes are defining or operational characteristics (such as the name of the hardware object or the status of power to the hardware object).

Hardware attributes may be viewed in Notebook dialog boxes. These attributes come from a variety of sources, such as the SDR and resource monitors.
Like attributes are grouped on the same page, and tabs provide a visual identification of the category of attributes on the page.

To view hardware attributes:
1. Double-click the icon of the desired hardware object.
2. A notebook dialog box opens, displaying the selected objects’ attributes.

Alternatively:
1. Select the icon of the desired hardware object in a pane.
2. Click the Notebook icon in the tool bar (refer to Figure 138 on page 205).
3. A notebook dialog box opens, displaying the selected objects’ attributes.

Alternatively, you can do the following:
1. Select the icons of the desired hardware objects in a pane.
2. Click Actions in the menu bar.
3. Click View or Modify Properties....
4. The notebook dialog boxes open, displaying the selected objects’ attributes.

For more information on system object attributes and variables, refer to the “System Monitor Variables” and “System Data Repository” appendices in the IBM Parallel System Support Programs for AIX: Administration Guide, GC23-3897.

The following sections explain specific hardware notebooks.

A.4.1 The Control Workstation Notebook
The Control Workstation notebook provides you with pages about the following control workstation attributes:

- Identification
- Monitored conditions

A.4.1.1 The Identification Page
The Identification page shown in Figure 140 on page 208 lists the following control workstation attributes:

Belongs to: The name of the SP system the control workstation is connected to.
**Code version:** The version of PSSP running on the control workstation.

**Active CWS:** If HACWS is used, whether the primary or backup control workstation is active.

**IP addresses:** The Internet Protocol addresses of the control workstation.

**Backup CWS:** If HACWS is used, the name of the backup control workstation.

**Backup CWS IP address:** If HACWS is used, the Internet Protocol address of the backup control workstation.

**Figure 140. The Identification Page of Control Workstation Notebook**

**A.4.1.2 The Monitored Conditions Page**

The Monitored Conditions page shown in Figure 141 on page 210 contains information about attributes of the control workstation that may change state. See “Monitoring Hardware Objects” on page 251 for more information on monitoring.

The page lists the following information:

- **Condition Name** The object attribute or variable being monitored.
- **State** Lists the status of the variable or attribute being monitored. The condition value has four possible states:
**Triggered:** The condition has been met. This corresponds to a red X or a red icon for the object.

**Not triggered:** The condition has not been met. This usually corresponds to a green icon for the object. However, how the icon will look depends on the values of all of the other conditions that are being monitored at the same time.

**Unknown:** The condition is valid, but the value cannot be determined. Usually, this corresponds to a gray question mark icon for the object. However, the icon’s appearance depends on the values of all of the other conditions that are being monitored at the same time.

**Not Available:** The monitored condition is not available for the object at this time. This value may be the result of a communication or hardware problem, or the monitored condition may not be valid on the object. It may never be available, such as with keyNotNormal on some node types, or it may become available in the future if the state of the system changes, such as with switchNotReachable. Usually, this corresponds to an unmonitored icon for the object.

How the icon looks depends on the value of all other conditions being monitored at the same time.

**Resource** An entity in the SP system that provides a set of services.

**Time Observed** The time that the condition’s state last changed to the state shown.
A.4.2 The System Notebook

The System notebook provides you with pages about the following global system attributes:

- Identification
- Configuration
- Accounting Configuration
- Monitored Conditions

A.4.2.1 The Identification Page

The Identification page shown in Figure 142 on page 211 lists the following attributes pertaining to the entire system:

**System name:** The name of the system.

**Code version:** The version of PSSP running on the control workstation.

**Default network install image:** The name of the default network install image.

**Remove install image after installs:** Whether the install images are erased after all nodes have been installed from this server.
**Layout directory:** The directory that contains the system partition configuration layout files.

**Authentication server:** The type of authentication server used (ssp, afs, or krb).

---

![Image](image.png)

*Figure 142. The Identification Page of System Notebook*

### A.4.2.2 The Configuration Page

The Configuration page shown in Figure 143 on page 213 lists the following attributes pertaining to the entire system:

- **NTP installation:** The type of Network Time Protocol installation (none, consensus, timemaster, Internet).

- **NTP server hostname(s):** The names of the Network Time Protocol servers.

- **NTP version:** The version of Network Time Protocol being run (default is 3).

- **Automounter configuration:** Whether an automount daemon is installed.

- **Print management configuration:** The configuration mode of the SP Print Management System (false=do not print; secure=installed in secure mode; open=installed in open mode).
Print system secure mode login name:
The login name to rsh to for secure mode printing.

User administration interface:
Whether the SP User Management System is installed.

Password file:
The file containing password information.

Password file server hostname:
The name of the host where the master password file resides.

Home directory server hostname:
The name of the host where the users’ home directories reside.

Home directory path:
The default path of users’ home directories.

File collection management:
Whether file collections management is installed.

File collection daemon uid:
The user identification number for the file collection daemon supman (default is 102).

File collection daemon port:
The number for the port through which supman can communicate (default is 8431).
A.4.2.3 The Accounting Configuration Page

The Accounting Configuration page shown in Figure 144 on page 214 lists the following attributes pertaining to the entire system:

**SP accounting enabled:** Whether, by default, accounting is enabled on all nodes that have an accounting enabled attribute of default (default is false).

**SP accounting active node threshold:**
- The percentage of nodes for which accounting data must be available in order for merging and reporting of the data for a cycle to take place (default is 80).

**SP exclusive use accounting enabled:**
- Whether accounting start and end job records will be generated for jobs having exclusive use of the node (default is false).

**Accounting master:** The number of the node that is acting as the accounting master.
A.4.2.4 The Monitored Conditions Page

The Monitored Conditions page shown in Figure 145 contains information about system attributes that are being monitored.

For details, refer to “The Monitored Conditions Page” on page 208.
A.4.3 The System Partition Notebook

The System Partition notebook provides you with pages about the following attributes for selected system partitions:

- Configuration
- Switch configuration
- Monitored configurations

A.4.3.1 The Configuration Page

The Configuration page shown in Figure 146 on page 215 lists the following attributes pertaining to a particular system partition:

Name: The name of the system partition.
Address: The Internet Protocol address of the system partition.
Code version: The minimum (earliest) version of PSSP running in the system partition.
Directory: The directory containing the system partition configuration layout.
Install image: The name of the image installed on the system partition.

Figure 146. The Configuration Page of System Partition Notebook

A.4.3.2 The Switch Configuration Page

The Switch Configuration page shown in Figure 147 on page 216 lists the following attributes pertaining to a particular system partition:

Primary name: The name of the switch primary node. The switch primary node initializes the switch fabric and
processes switch operations and errors reported from the switch fabric.

**Oncoming primary name:**

The name of the node that will become the switch primary node on the next Estart.

**Primary backup name:**

The name of the node that is backup to the switch primary node.

**Oncoming primary backup name:**

The name of the node that will become the backup to the switch primary node on the next Estart.

**Switch max ltu:**

Represents the maximum packet length of the data portion of an IP packet sent over the switch. This value is determined by internal switch support, and should not be changed.

**Switch link delay:**

Represents the switch link delay value used by switch support when initializing the switch network. This value is determined by internal switch support, and should not be changed.

![Figure 147. The Switch Configuration Page of System Partition Notebook](image)

**A.4.3.3 The Monitored Conditions Page**

The Monitored Conditions page shown in Figure 148 on page 217 contains information about attributes of the system partitions that are being monitored.

For details, refer to “The Monitored Conditions Page” on page 208.
A.4.4 The Node Notebook

The Node notebook provides you with pages about the following attributes for selected nodes:

- Node Status
- Node Environment
- Configuration
- Hardware Resource Variables
- CSS Resource Variables
- AIX OS Resource Variables
- All Dynamic Resource Variables
- Monitored Conditions

A.4.4.1 The Node Status Page

Attributes on the Node Status page shown in Figure 149 on page 221 may show the following system responses. If you get these responses, corrective actions will be needed.

- If an attribute displays double question marks (??) on a gray background, the attribute is being monitored, but the status is unknown because of communication problems with the hardware.
- If no attributes are displayed, it is likely that the hardmon resource monitor is not operating. Contact your system administrator for assistance.

The Node Status page lists the following node attributes and values:
Power LED: The status of the power light on the front of the node. Also, if the user has authorization and the node has the capability, a power control button will be available to the right of the display. The Power LED attribute displays the following system responses:

**Black (No power to node)**

The power control button to the right of the display is grayed out since the node cannot be powered on from this node state.

**Green (Powered on)**

The power control button to the right of the display is now labeled “Power off” and it will activate a dialog box enabling you to power off, reset, cshutdown, or fence the node.

**Gray (Powered off)**

The power control button to the right of the display is now labeled “Power on” and it will activate a dialog box enabling you to either power on or cstart up the node.

**Host responds:** The status of communication between the node and the control workstation. Green=true; Red=false.

**Controller responds:** Whether the frame supervisor is responding to communication from the node. Green=true; Red=false.

**Switch responds:** Shows status of the node’s switch adapter. This attribute can have the following values:

**Gray (Adapter not configured)**

Switch adapter installed but not configured. The fence control button to the right of the display will also be grayed out as the adapter is not available.

**Green (Active)**

The switch is active on the node. The fence control button to the right of the display will be labeled “Fence” and it will activate a dialog box enabling you to fence the node (the unfence toggle is grayed out).
Red (Not Active)
The switch is not active on the node for one of the following reasons:

• It was fenced without the -autojoin option.
• It faulted and was removed from the switch.
• The node’s switch adapter failed to configure properly.
• The node’s switch adapter was recently reset.

If the node is fenced, the fence control button to the right of the display will be labeled “Unfence” and it will activate a dialog box enabling you to unfence the node (the fence toggle is grayed out).

Yellow (Fenced)
Fenced with the -autojoin option. The fence control button to the right of the display will be labeled “Unfence” and it will activate a dialog box enabling you to unfence the node (the fence toggle is grayed out).

CPU’s online:
The number of processors in the node that are online.

Key switch position:
If the node is equipped with a key switch, there will be a pickbox with three selections to the right of this attribute. Using this pickbox, you will be able to place the node into any one of three operational modes. These modes are:

• Normal (green highlight when selected)
• Service (red highlight when selected)
• Secure (yellow highlight when selected)

The Key switch position attribute will not be displayed if the selected nodes are not equipped with a key switch.

Environment LED:
The status of the environment light on the front of the node. Black= No problems; Yellow=Warning; Gray=Critical error forcing power shutdown.

TTY open:
Shows the status of the TTY connection to the node. This attribute can have the following values:
Black (No)
TTY connection to the node is not active. The Open TTY button to the right of the display will activate a dialog box enabling you to establish a TTY connection to the node.

Yellow (Yes)
The system has an active TTY connection to the node. The Open TTY button to the right of the display is grayed out since the node’s TTY connection is already established (each node is only permitted one TTY connection).

Node failure:
Whether the node supervisor is responding to communication from the frame supervisor. Green=No; Red=Yes.

3-Digit Display: or LCD1: and LCD2:
If a node is equipped with a numeric display, this attribute will show the same output given on the front of that node. Depending on the node type, the display may be either a three-digit LED or a two-line LCD with sixteen characters per line. Some nodes do not have numeric displays and will not display a system response for this attribute.

Network boot:
This is not a monitored attribute. Instead, there is only a Network Boot button at the right side of the display which will activate a network boot dialog box when selected.
A.4.4.2 The Node Environment Page

The information contained in the Node Environment page is customized for different nodes based on the type of supervisor card used in the node. Therefore, some attribute names and the displayed system responses may vary, based on the type of node supervisor card installed in the node you are monitoring.

Attributes on the Node Environment page shown in Figure 150 on page 225 may show the following system responses. If you get these responses, corrective actions will be needed.

- If an attribute displays double question marks (??) on a gray background, the attribute is being monitored, but the status is unknown because of communication problems with the hardware.
- If no attributes are displayed, it is likely that the hardmon resource monitor is not operating. Contact your system administrator for assistance.

Node Environment Page for Type 33 and 65 Node Supervisor Cards

Type 33 and 65 node supervisor cards display the following attributes and system responses on the Node Environment page:

**Temp:** Displays the node's operating temperature status. Red=Failure; Yellow=Warning; Green=OK.
P48OK: Shows the status of the 48-volt power supply. Red=Failure; Green=OK.

voltP12: Shows the status of the +12 Vdc power supply. Red=Failure; Yellow=Warning; Green=OK.

coltN12: Shows the status of the -12 Vdc power supply. Red=Failure; Yellow=Warning; Green=OK.

coltP5: Shows the status of the node’s +5 Vdc power supply. Red=Failure; Yellow=Warning; Green=OK.

Fan 1, 2, or 3: Individually shows the status of the node’s cooling fans. Red=Failure; Yellow=Warning; Green=OK.

**Node Environment Page for Type 83 Node Supervisor Cards**

Type 83 node supervisor cards display the following attributes and system responses on the Node Environment page:

Temp: Displays the node’s operating temperature status. Red=Failure; Yellow=Warning; Green=OK.

P48OK: Shows the status of the 48-volt power supply. Red=Failure; Green=OK.

coltP12: Shows the status of the +12 Vdc power supply. Red=Failure; Yellow=Warning; Green=OK.

coltN12: Shows the status of the -12 Vdc power supply. Red=Failure; Yellow=Warning; Green=OK.

coltP5i: Shows the status of the I/O power supply (+5 Vdc). Red=Failure; Yellow=Warning; Green=OK.

coltP5m: Shows the status of the memory power supply (+5 Vdc). Red=Failure; Yellow=Warning; Green=OK.

coltP4: Shows the status of the node’s +4 Vdc power supply. Red=Failure; Yellow=Warning; Green=OK.

Fan 1, 2, 3, 4 or 5: Individually shows the status of the node’s cooling fans. Red=Failure; Yellow=Warning; Green=OK.

P5DCok: Shows the status of the node’s +5 Vdc power. Red=Failure; Green=OK.

**Node Environment Page for Type 97 Node Supervisor Cards**

Type 97 node supervisor cards display the following attributes and system responses on the Node Environment page:

Temp: Displays the node’s operating temperature status. Red=Failure; Yellow=Warning; Green=OK.
P48OK: Shows the status of the 48-volt power supply. Red=Failure; Green=OK.

voltP12: Shows the status of the +12 Vdc power supply. Red=Failure; Yellow=Warning; Green=OK.

cvetN12: Shows the status of the -12 Vdc power supply. Red=Failure; Yellow=Warning; Green=OK.

cvetP5: Shows the status of the node’s +5 Vdc power supply. Red=Failure; Yellow=Warning; Green=OK.

cvetP4d: Shows the status of the node’s +4 Vdc daughter card power supply. Red=Failure; Yellow=Warning; Green=OK.

cvetP2_5d: Shows the status of the node’s +2.5 Vdc daughter card power supply. Red=Failure; Yellow=Warning; Green=OK.

Fan 1, 2, 3 or 4: Individually shows the status of the node’s cooling fans. Red=Failure; Yellow=Warning; Green=OK.

Memory protect: Represents the MemoryProtect signal which indicates whether the correct memory cards are installed in the node. Red=Incorrect memory cards installed; Green=Correct memory cards installed.

P5DCok: Shows the status of the node’s +5 Vdc power. Red=Failure; Green=OK.

Node Environment Page for Type 161 Node Supervisor Cards
Type 161 node supervisor cards display the following attributes and system responses on the Node Environment page:

Temp: Displays the node’s operating temperature status. Red=Failure; Green=OK.

P48OK: Shows the status of the 48-volt power supply. Red=Failure; Green=OK.

P5DCok: Shows the status of the node’s +5 Vdc power. Red=Failure; Green=OK.

Node Environment Page for Type 177 Node Supervisor Cards
Type 177 node supervisor cards display the following attributes and system responses on the Node Environment page:

Temp: Displays the node’s operating temperature status. Red=Failure; Yellow=Warning; Green=OK.
**Power Status Warning:** Compares the status of the CPU and I/O power supplies. If there is an inconsistency between the two power supplies, a warning is indicated but the node supervisor will not power off the node. Red=Warning condition exists; Green=OK.

**CPU Power Warning:** Indicates that the node’s CPU power supply did not turn on during node power up. Red=CPU not powered on; Green=OK.

**CPU_Power:** Indicates that the node’s CPU power supply is turned on. Red=CPU power is off; Green=CPU power is on.

**CPU P48OK:** Shows the status of the node’s +48-volt CPU power supply. Red=Failure; Green=OK.

---

**Node Environment Page for Type 178 Node Supervisor Cards**

Type 178 node supervisor cards display the following attributes and system responses on the Node Environment page:

**Temp:** Displays the node’s operating temperature status. Red=Failure; Yellow=Warning; Green=OK.

**Power Status Warning:** Compares the status of the CPU and I/O power supplies. If there is an inconsistency between the two power supplies, a warning is indicated but the node supervisor will not power off the node. Red=Warning condition exists; Green=OK.

**CPU Power Warning:** Indicates that the node’s CPU power supply did not turn on during node power-up. Red=CPU not powered on; Green=OK.

**CPU_Power:** Indicates that the node’s CPU power supply is turned on. Red=CPU power is off; Green=CPU power is on.

**CPU P48OK:** Shows the status of the node’s +48-volt CPU power supply. Red=Failure; Green=OK.

**IO Power Warning:** Indicates that the node’s I/O power supply did not turn on during node power-up. Red=IO not powered on; Green=OK.

**IO P48OK:** Shows the status of the node’s +48-volt I/O power supply. Red=Failure; Green=OK.
### IO Power:
Indicates that the node’s I/O power supply is turned on. Red=I/O power is off; Green=I/O power is on.

![Node Environment Page of Node Notebook](image)

**Figure 150. The Node Environment Page of Node Notebook**

#### A.4.4.3 The Configuration Page
The Configuration page shown in Figure 151 on page 227 lists the following attributes pertaining to individual nodes:

- **Node number:** The number ID assigned to a node.
- **Frame number and Node Slot number:** The number ID assigned to the frame and the number ID assigned to the slot (each full size frame has 8 drawers, which have 2 slots each, for a total of 16 slots) in which the node resides.
- **Short hostname:** The shortened name of the node (for example, k16n11).
- **Hostname:** The full name of the node (for example, k16n11.ppd.pok.ibm.com).
- **Internet address:** The Internet Protocol address of the node.
<table>
<thead>
<tr>
<th><strong>System partition:</strong></th>
<th>The name of the system partition to which the node belongs.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PSSP code version:</strong></td>
<td>The version of PSSP running on the node.</td>
</tr>
<tr>
<td><strong>Description:</strong></td>
<td>Description such as processor speed for the selected node.</td>
</tr>
<tr>
<td><strong>Node supervisor type:</strong></td>
<td>Identifies the type of node supervisor card installed in the monitored node. The following node supervisor card types are available:</td>
</tr>
<tr>
<td><strong>Node supervisor code version:</strong></td>
<td>States which software level is driving the node supervisor.</td>
</tr>
<tr>
<td><strong>Processor type:</strong></td>
<td>Whether the node is a uniprocessor (UP) or multiprocessor (MP).</td>
</tr>
<tr>
<td><strong>Processors installed:</strong></td>
<td>The total number of processors in the node.</td>
</tr>
<tr>
<td><strong>Frame number:</strong></td>
<td>The number ID of the frame in which the node resides.</td>
</tr>
<tr>
<td><strong>Slot:</strong></td>
<td>The number ID of the slot in which the node resides.</td>
</tr>
<tr>
<td><strong>Slots used:</strong></td>
<td>The number of slots occupied by the node.</td>
</tr>
<tr>
<td><strong>Switch port number:</strong></td>
<td>The port position on the switch board to which the node is connected.</td>
</tr>
<tr>
<td><strong>Switch chip:</strong></td>
<td>The number ID of the switch chip to which the node is connected.</td>
</tr>
<tr>
<td><strong>Switch chip port:</strong></td>
<td>The switch port the node is connected to.</td>
</tr>
</tbody>
</table>
A.4.4.4 The Hardware Resource Variables Page

The Hardware Resource Variables page shown in Figure 152 on page 228 lists the names of variables (attributes) associated with nodes and the current values of those variables.

You can use the Event Perspective to get a description of Resource Variables. Refer to “View and Modify a Condition” on page 323.

Click Refresh List to update the information for all variables listed, or click an individual variable to update its information only.
A.4.4.5 The CSS Resource Variables Page

The CSS Resource Variables page shown in Figure 153 on page 229 lists the names of variables (attributes) associated with switches and the current values of those variables.

You can use the Event Perspective to get a description of Resource Variables. Refer to “View and Modify a Condition” on page 323.

Click **Refresh List** to update the information for all variables listed, or click an individual variable to update its information only.
A.4.4.6 The AIX OS Resource Variables Page for Nodes

The AIX OS Resource Variables page shown in Figure 154 on page 230 lists the names of variables (attributes) associated with the AIX operating system and the current values of those variables for the monitored node.

You can use the Event Perspective to get a description of Resource Variables. Refer to “View and Modify a Condition” on page 323.

Click Refresh List to update the information for all variables listed, or click an individual variable to update its information only.
A.4.4.7 The All Dynamic Resource Variables Page for Nodes

The All Dynamic Resource Variables page shown in Figure 155 on page 231 lists the names of all variables (attributes) associated with SP system resources (including hardware, switch, and AIX OS resource variables) and the current value of those variables.

Note: Only those variables that have only NodeNum as a resource identifier are included.

You can use the Event Perspective to get a description of Resource Variables. Refer to “View and Modify a Condition” on page 323.

Click Refresh List to update the information for all variables listed, or click an individual variable to update its information only.
A.4.4.8 The Monitored Conditions Page for Nodes

The Monitored Conditions page shown in Figure 156 on page 232 contains information about attributes of the nodes that are being monitored.

For details, refer to “The Monitored Conditions Page” on page 208.
A.4.5 The Dependent Node Notebook

The Dependent Node notebook provides you with pages about the following attributes for selected Dependent nodes:

• Dependent Node Configuration Information
• Dependent Node Dynamic Resource Variables
• Dependent Node Conditions Being Monitored

A.4.5.1 The Configuration Page

The Configuration page shown in Figure 157 on page 235 lists the following attributes pertaining to the selected dependent nodes:

Node number: The node number that corresponds to the valid unused switch port assigned to the dependent node.

Hostname: The fully qualified host name associated with the dependent node's network interface on its system's administrative network. This name must resolve to an IP address, and is required.
Management agent hostname:
The host name that resolves to an IP address that is the source or destination of SNMP packets exchanged with the control workstation via the SP administrative network.

SNMP community name:
The Simple Network Management Protocol (SNMP) community name for the authentication field in SNMP messages exchanged by the SNMP Agent and the SP SNMP Manager. This value can be 1 to 255 ASCII characters.

System partition:
The name of the system partition to which the dependent node is assigned.

Extension node identifier:
The string assigned to the dependent node in its system’s administrative environment. The string uniquely identifies the dependent node to its system and can be 1 to 255 ASCII characters, and is required.

Dependent node IP address:
The Internet Protocol address of the dependent node.

Dependent node netmask:
The network mask for IP addresses on the attached network on which the dependent node resides.

Switch port number:
The number ID of the port position on the switch board to which the dependent node is connected.

Switch number:
The number ID of the switch board to which the dependent node is connected.

Switch chip:
The number ID of the switch chip to which the dependent node is connected.

Switch chip port:
The number ID of the switch chip port to which the dependent node is connected.

Switch partition number:
The number ID of the switch partition for the dependent node.
Switch responds: The monitored state of the dependent node’s connection to the switch. This attribute can have the following values:

Gray (??)
Monitored, but status is unknown (there may be a problem communicating with the hardware object).

Green (Active)
The switch is active on the dependent node.

Red (Not Active)
The switch is not active on the dependent node for one of the following reasons:
• It was fenced without the -autojoin option.
• It faulted and was removed from the switch.
• The dependent node’s switch adapter failed to configure properly.
• The dependent node’s switch adapter was recently reset.

Yellow (Fenced)
Fenced with the -autojoin option.
A.4.5.2  The All Dynamic Resource Variables Page
The All Dynamic Resource Variables page shown in Figure 158 on page 236 displays the current value of the IBM.PSSP.Response.Switch.state resource variable.

You can use the Event Perspective to get a description of Resource Variables. Refer to “View and Modify a Condition” on page 323.

Click Refresh List to update the information for all the variables listed, or click an individual variable to update its information only.
A.4.5.3 The Monitored Conditions Page

The Monitored Conditions page shown in Figure 159 on page 237 contains information about the triggered re-arm state of the switchResponds condition, if it is being monitored for the dependent node.

For details, refer to “The Monitored Conditions Page” on page 208.

---

1 D-Node = Dependent Node
A.4.6 The Node Group Notebook

The Node Group notebook provides you with pages about the following attributes for selected node groups:

- Node Group Configuration
- Monitored Configurations

Note that dependent nodes cannot be members of node groups.

A.4.6.1 The Node Group Configuration Page

The Node Group Configuration page shown in Figure 160 on page 239 contains the following:

Node group name: The name of the node group. A node group name must start with an alphabetic character (A-Z, a-z), but then can contain a sequence of alphanumeric characters (A-Z, a-z, 0-9), a period (.), or an underbar (_). A node group name cannot contain spaces. This is the name the node group is saved
under in the SDR and the name appears as the label for the icon in the Node Groups pane of the Hardware Perspective.

**System partition:**
The name of the system partition the node group is in.

**Member Nodes:**
The node numbers of the nodes in the node group. When a node group is being created, these are the numbers of the nodes that were selected prior to invoking the **Create Node Group**... action (and will also include any nodes that have been added from this dialog box). When an existing node group is being viewed or modified, these are the node numbers of the member nodes of the selected node group object.

**Available Nodes:**
The numbers of all the nodes in the current system partition minus those listed in the **Member Nodes:** list box.

**Member Node Groups:**
The names of the node groups in the node group. When a node group is being created, these are the names of the node groups that were selected prior to invoking the **Create Node Group**... action (and will also include any node groups that have been added from this dialog box). When an existing node group is being viewed or modified, these are the names of the member node groups of the selected node group object.

**Available Node Groups:**
The names of all the node groups in the current system partition minus those listed in the **Member Node Groups:** list box. (When you are working with a node group, it is not listed in this list box.) The left and right arrow buttons are provided to move items to and from the **Member** and **Available** list boxes.
A.4.6.2 The Monitored Conditions Page

The Monitored Conditions page shown in Figure 161 on page 240 contains information about attributes of the node groups that are being monitored.

For details, refer to “The Monitored Conditions Page” on page 208.
A.4.7 The Frame Notebook

The Frame notebook provides you with pages about the following attributes for selected Frames:

- Frame Status
- Configuration
- Dynamic Resource Variables
- Monitored Conditions

A.4.7.1 The Frame Status Page

The information contained in the Frame Status page shown in Figure 162 on page 242 is customized for different frames based on the type of supervisor card used in the frame. Therefore, some attribute names and the displayed system responses may vary, based on the type of frame supervisor card installed in the frame.

Attributes on the Frame Status page may show the following system responses. If you get these responses, corrective actions will be needed.
• If an attribute displays double question marks (??) on a gray background, the attribute is being monitored, but the status is unknown because of communication problems with the hardware.

• If no attributes are displayed, it is likely that the hardmon resource monitor is not operating. Contact your system administrator for assistance.

The Frame Status page lists the following frame attributes and values:

**Power:** The status of the primary power supplying the frame power subsystem. Type 18 and 22 frame supervisor cards (SEPBU equipped frames) display: Red=No primary frame power; Green=Primary frame power OK. Type 17 and 20 frame supervisor cards (PDU equipped frames) display: Black=No primary frame power; Green=Primary frame power OK; Gray=Failure. If the user has authorization and the frame has the capability, a **Power** button will be available to the right of the display. Clicking the button will either turn primary frame power on or off.

**Bus error:** Shows the status of the nodes installed in the frame. All frame supervisor card types display: Black=All nodes responding; Yellow=Node(s) not responding; Gray=No nodes responding.

**Controller responds:** Shows the status of the frame supervisor card. All frame supervisor card types display: Red=No response from frame supervisor card; Green=Frame supervisor card OK.

**Active controller tail:** This attribute is available for type 20 and 22 frame supervisor cards only. It shows the status of the high availability connections.

**rs232 active:** Shows the status of system monitoring communications between the frame(s) and the control workstation. All frame supervisor card types display: Black=Not active; Yellow=Active; Gray=Error. DC power module A, B, C, or D:

**A, B, C, or D:** Shows the status of the individual modules in the power supply subsystem. All frame supervisor card types display: Red=Module failure; Green=Module OK.
A.4.7.2 The Configuration Page

The Configuration page shown in Figure 163 on page 243 lists the following attributes pertaining to the selected frames:

**Number:** The number ID of the frame.

**Slots:** The number of slots in the frame. A full-size frame has 8 drawers, which have 2 slots each, for a total of 16 slots. A short frame has 4 drawers, which have 2 slots each, for a total of 8 slots.

**Type:** Whether the frame has a switch or no switch, or is an all-switch frame.

**tty:** The tty port to be used for the frame.

**Hardware protocol:** This attribute displays either:

- SAMI for Type 2 frame supervisors (RS/6000 Machine Type 7017-S70 or S7A).
- SP for all other frame supervisor types (standard RS/6000 SP frames).
MACN: The name of the monitor and control node that monitors the frame.

Backup MACN: If HACWS is used, the name of the backup monitor and control node.

Frame supervisor type: Displays a number that identifies the type of frame supervisor card installed in the frame. The displayed system responses are:

- 17 for frames equipped with a PDU power subsystem.
- 18 for frames equipped with a SEPBU power subsystem.
- 20 for high availability installations of frames equipped with a PDU power subsystem.
- 22 for high availability installations of frames equipped with a SEPBU power subsystem.

Frame supervisor code version: Identifies the version of the software being used to drive the frame supervisor card.

![Figure 163. The Configuration Page of Frame Notebook](image_url)
A.4.7.3 The Dynamic Resource Variables Page
The Dynamic Resource Variables page shown in Figure 164 on page 244 lists the names of all variables (attributes) associated with SP system resources (including hardware, switch, and AIX OS resource variables) and the current values of those variables.

You can use the Event Perspective to get a description of Resource Variables. Refer to “View and Modify a Condition” on page 323.

Click Refresh List to update the information for all variables listed, or click an individual variable to update its information only.

![Figure 164. The Dynamic Resource Variables Page of Frame Notebook](image)

A.4.7.4 The Monitored Conditions Page
The Monitored Conditions page shown in Figure 165 on page 245 contains information about attributes of the frames that are being monitored.

For details, refer to “The Monitored Conditions Page” on page 208.
A.4.8 The Switch Notebook

The Switch notebook provides you with pages about the following attributes for selected switches:

- Switch Status
- Configuration
- Dynamic Resource Variables
- Monitored Conditions

A.4.8.1 The Switch Status Page

The information contained in the Switch Status page shown in Figure 166 on page 248 is customized for each type of switch. Therefore, some attribute names and the system responses displayed will vary based on the type of switch being monitored.

Attributes on the Switch Status page may show the following system responses. If you get these responses, corrective actions will be needed.
• If an attribute displays double question marks (??) on a gray background, the attribute is being monitored, but the status is unknown because of communication problems with the hardware.

• If no attributes are displayed, it is likely that the hardmon resource monitor is not operating. Contact your system administrator for assistance.

The Switch Status page lists the following switch attributes and values:

**Power LED:**

The status of the power light on the front of the switch. Red= No power to switch; Green= Powered on; Gray= Powered off.

If the user has authorization and the switch has the capability, the **Power** button will be available to the right of the display. Clicking the button will either turn power on or off to the switch.

**Environment LED:**

The status of the environment light on the front of the switch. Black= No problems; Yellow= Warning; Gray= Critical error forcing power shut-down.

**Controller Responds:**

Whether the frame supervisor is responding to communication from the switch. Green= Switch responding (true); Red= No switch response (false).

**Clock Source:**

This attribute will vary with switch type, showing the following displays for synchronization:

16-port High Performance switches

Display the following system responses: Internal (switch using internal clock); Input 1, 2, or 3 (for external clocks).

**SP switches**

Display the following system responses: Internal (switch using internal clock); External (switch using external clock).

Switches that do not have output capability for clock synchronization will not show a display.

**Node Failure:**

Whether the node is responding to communication from the switch. Green= Node responding; Red= Node not responding.

**Power:**

This attribute will vary with switch type, showing the following displays:

*All switch types* have the following power display:
P48 OK: Shows the status of the 48-volt power supply. Red= Power supply failure; Green= Power supply OK.

*High Performance switches* have all of the following power displays:

voltN5: Shows the status of the -5 Vdc power supply. Red= Power supply failure; Yellow= Warning; Green= Power supply OK.

voltP5: Shows the status of the +5 Vdc power supply. Red= Power supply failure; Yellow= Warning; Green= Power supply OK.

voltP12: Shows the status of the +12 Vdc power supply. Red= Power supply failure; Yellow= Warning; Green= Power supply OK.

Fan 1, 2, 3, 4, or 5: This attribute will vary with switch type, showing the following displays: Red= Fan failure; Yellow= Fan warning; Green= Cooling fan OK.

*SP switches* have all of the following power displays:

ps1 Fail: Shows the status of power supply 1. Red= Power supply failure; Green= Power supply OK.

ps2 Fail: Shows the status of power supply 2. Red= Power supply failure; Green= Power supply OK.

warningOC: Over-current threshold warning for power supply 1 or 2. Red= Power supply approaching maximum over-current; Green= Power supplies OK.

Fan 1, 2, 3, 4, or 5: This attribute will vary with switch type, showing the following displays: Red= Fan failure; Green= Fan OK.
A.4.8.2 The Configuration Page for Switches

The Configuration page shown in Figure 167 on page 249 lists the following attributes pertaining to the selected switches:

- **Number:** The unique number assigned to the switch board.
- **Type:** The switch supervisor card type.
- **Level:** The level of microcode from the switch supervisor.
- **Name:** The short model name of the switch (HiPS or SP_Switch).
- **Switch supervisor type:** Identifies the type of switch supervisor card installed in the monitored switch.
- **Switch supervisor code version:** States which software level is driving the switch supervisor.
A.4.8.3 The Dynamic Resource Variables Page for Switches

The Dynamic Resource Variables page shown in Figure 168 on page 250 lists the names of all variables (attributes) associated with SP system resources (including hardware, switch, and AIX OS resource variables) and the current values of those variables.

You can use the Event Perspective to get a description of Resource Variables. Refer to “View and Modify a Condition” on page 323.

Click Refresh List to update the information for all variables listed, or click an individual variable to update its information only.
A.4.8.4 The Monitored Conditions Page for Switches

The Monitored Conditions page shown in Figure 169 on page 251 contains information about attributes of the switches that are being monitored.

For details, refer to “The Monitored Conditions Page” on page 208.
A.5 Monitoring Hardware Objects

You can monitor the state of hardware objects in a pane.

*Monitoring* means that the selected hardware objects are continually watched for changes in state. When a change in state occurs, the display of the hardware objects in the pane is changed.

Monitoring can be done on all *like* objects in a pane, or on *aggregates* of objects. For example, you can set up monitoring for all nodes in the Nodes pane, or you could monitor an aggregate of objects by selecting, for example, a system partition, so that all the nodes in the system partition are monitored. If any of the nodes in the monitored system partition have a change in state, the change is reflected in the display of the system partition.

Another example of monitoring an aggregate is to set up monitoring for a frame: the frame itself is monitored, as well as the nodes the frame contains. If any of the nodes in the monitored frame have a change in state, the change is reflected in the display of the frame.
A default set of conditions that can be monitored is supplied. In addition, you can create conditions to be monitored the Event Perspective (reference page in Appendix B).

The status of monitored hardware objects is reflected in the display of those objects:

**Green**
Good (a monitored condition for the hardware object has not triggered).

**Red X**
Bad (one or more monitored conditions for the hardware object has triggered). Check the Monitored Conditions page in the object's Notebook.

**?**
Monitored, but status is unknown (there may be a problem communicating with the hardware object, for example). Check the Monitored Conditions page in the object's Notebook.

**Unmonitored**
Monitored condition is not available at this time (there may be a communication or hardware problem).

The icon may also display as unmonitored because the selected condition is not valid for the object (for example, keyNotNormal is not valid for all node types). In this instance, you must also check the Monitored Conditions page in the object's notebook.

**Yellow with black checkmark**
Acknowledged; this state is manually applied by selecting object icon and then clicking the **acknowledge** icon on the toolbar. The object's icon is highlighted in yellow until the next change in the object's state.

If you are monitoring multiple conditions, the object displays the overall status of the valid conditions being monitored. You must check the Monitored Conditions page in the object's notebook for specific conditions.

To monitor hardware objects:
1. Select a pane to set up monitoring for all hardware objects in the pane.
2. Click the **Monitor** icon on the tool bar. Refer to Figure 138 on page 205.
3. The Set Monitoring Notebook for the pane opens.
Alternatively:
1. Select a pane to set up monitoring for all hardware objects in the pane.
2. Click View in the menu bar.
3. Click Set Monitoring... on the menu list.
4. The Set Monitoring Notebook for the pane opens.

A.5.1 The Set Monitoring Notebook

Since each hardware object has different functions, each type of object has its own Set Monitoring Dialog Box. The information contained in the object’s dialog box allows you to select conditions whose status you need to monitor.

Even though each hardware object has its own Set Monitoring Dialog Box, operation is pretty much common. To monitor condition:

1. Click on a condition in the list box to select it for monitoring.

   **Note**
   - To select multiple conditions that are listed consecutively, click the first desired condition, hold the left mouse button down, and move the cursor down the list over the desired conditions.
   - To select multiple conditions that are not listed consecutively, hold the Ctrl key on your keyboard down while you click each desired condition.

2. Click Apply to monitor the selected conditions and leave the notebook open, or click Ok to monitor the selected conditions and close the notebook.

To stop monitoring of selected conditions:

1. Click Stop Monitoring.

A.5.2 Monitoring the Control Workstation

When the Set Monitoring for CWS, System and Syspars notebook shown in Figure 170 on page 254 opens, the following default conditions for the control workstation are listed on the Control WS page (additionally, conditions for the control workstation you have created using the Creating a Condition from the Event Perspective are listed):

**Conditions to Monitor:**

| nodeNotReachable | Status of Group Services communication with control workstation. |
pageSpaceLow  Paging space on nodes exceeds 85 percent.
switchNotReachable  Status of communications between switch adapters on nodes.
tmpFull  Status of space on the file system for LV=hd3 and VG=rootvg.

To see detailed information for monitored conditions of objects, open the notebook for the object and view the Monitored Conditions page. Refer to “The Monitored Conditions Page” on page 208.

Figure 170.  Set Monitoring for Control Workstation

A.5.3 Monitoring the System

When the Set Monitoring for CWS, System and Syspars notebook shown in Figure 171 on page 256 opens, the following default conditions for the System are listed on the System page (additionally, conditions for the System you have created using the Creating a Condition from the Event Perspective are listed):
## Conditions of Contained Objects:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>hostResponds</code></td>
<td>Status of communications between processor nodes and the control workstation.</td>
</tr>
<tr>
<td><code>keyNotNormal</code></td>
<td>The position of the key mode switch on nodes.</td>
</tr>
<tr>
<td><code>nodeEnvProblem</code></td>
<td>Status of the environment light on the front of nodes.</td>
</tr>
<tr>
<td><code>nodePowerDown</code></td>
<td>Status of power to nodes.</td>
</tr>
<tr>
<td><code>nodePowerLED</code></td>
<td>Status of power light on front of nodes.</td>
</tr>
<tr>
<td><code>nodeSerialLinkOpen</code></td>
<td>Status of the serial one port.</td>
</tr>
<tr>
<td><code>nodeNotReachable</code></td>
<td>Status of Group Services communication with nodes.</td>
</tr>
<tr>
<td><code>pageSpaceLow</code></td>
<td>Paging space on nodes exceeds 85 percent.</td>
</tr>
<tr>
<td><code>switchNotReachable</code></td>
<td>Status of communications between switch adapters on nodes.</td>
</tr>
<tr>
<td><code>switchResponds</code></td>
<td>Status of switch activity on nodes.</td>
</tr>
<tr>
<td><code>tmpFull</code></td>
<td>Status of space on the file system for LV=hd3 and VG=rootvg.</td>
</tr>
</tbody>
</table>

To see detailed information for monitored conditions of objects, open the notebook for the object and view the **Monitored Conditions** page. Refer to “The Monitored Conditions Page” on page 214.
A.5.4 Monitoring System Partitions

When the Set Monitoring for CWS, System and Syspars notebook shown in Figure 172 on page 257 opens, the following default conditions for system partitions are listed on the Syspar page (additionally, conditions for system partitions you have created using the Creating a Condition from the Event Perspective are listed):

Conditions of Contained Objects:

- **hostResponds**: Status of communications between processor nodes and the control workstation.
- **keyNotNormal**: The position of the key mode switch on nodes.
- **nodeEnvProblem**: Status of the environment light on the front of nodes.
- **nodePowerDown**: Status of power to nodes.
- **nodePowerLED**: Status of power light on front of nodes.
**nodeSerialLinkOpen**  Status of the serial one port.

**nodeNotReachable**  Status of Group Services communication with nodes.

**pageSpaceLow**  Paging space on nodes exceeds 85 percent.

**switchNotReachable**  Status of communications between switch adapters on nodes.

**switchResponds**  Status of switch activity on nodes.

**tmpFul**  Status of space on the file system for LV=hd3 and VG=rootvg.

To see detailed information for monitored conditions of objects, open the notebook for the object and view the Monitored Conditions page. Refer to ‘The Monitored Conditions Page’ on page 216.

![Figure 172. Set Monitoring for System Partitions](image)
A.5.5 Monitoring Nodes

When the Set Monitoring for Nodes notebook shown in Figure 173 on page 259 opens, the following default conditions for nodes are listed on the Node page (additionally, conditions for nodes you have created using the Creating a Condition from the Event Perspective are listed):

Conditions to Monitor:

hostResponds  Status of communications between processor nodes and the control workstation.
keyNotNormal Status of the key mode switch on nodes.
nodeEnvProblem Status of the environment light on the front of nodes.
nodePowerDown Status of power to nodes.
nodePowerLED Status of power light on front of nodes.
nodeSerialLinkOpen Status of the serial one port.
nodeNotReachable Status of Group Services communication with nodes.
pageSpaceLow Paging space on nodes exceeds 85 percent.
switchNotReachable Status of communications between switch adapters on nodes.
switchResponds Status of switch activity on nodes.
tmpFull Status of space on the file system for LV=hd3 and VG=rootvg.

To see detailed information for monitored conditions of objects, open the notebook for the object and view the Node Status and the Monitored Conditions pages. Refer to “The Node Status Page” on page 217, “The Monitored Conditions Page for Nodes” on page 231 and “The Monitored Conditions Page” on page 236.
A.5.6 Monitoring Dependent Nodes

When the Set Monitoring for Nodes notebook shown in Figure 174 on page 260 opens, the following default condition for Dependent Nodes is listed on the Dependent Node page:

**Conditions to Monitor:**

`switchResponds` Status of switch activity on Dependent Node

To see detailed information for monitored conditions of objects, open the notebook for the object and view the Node Status and the Monitored Conditions pages. Refer to “The Node Status Page” on page 217, “The Monitored Conditions Page for Nodes” on page 231 and “The Monitored Conditions Page” on page 236.
Figure 174. Set Monitoring for Dependent Nodes

A.5.7 Monitoring Node Groups

When the Set Monitoring for Node Groups notebook shown in Figure 175 on page 261 opens, the following default conditions for node groups are listed (additionally, conditions for node groups you have created using the Creating a Condition from the Event Perspective are listed):

Conditions of Contained Objects:

- **hostResponds**: Status of communications between processor nodes and the control workstation.
- **keyNotNormal**: The position of the key mode switch on nodes.
- **nodeEnvProblem**: Status of the environment light on the front of nodes.
- **nodePowerDown**: Status of power to nodes.
nodePowerLED Status of power light on front of nodes.
nodeSerialLinkOpen Status of the serial one port.
nodeNotReachable Status of Group Services communication with nodes.
pageSpaceLow Paging space on nodes exceeds 85 percent.
switchNotReachable Status of communications between switch adapters on nodes.
switchResponds Status of switch activity on nodes.
tmpFull Status of space on the file system for LV=hd3 and VG=rootvg.

To see detailed information for monitored conditions of objects, open the notebook for the object and view the Monitored Conditions page. Refer to “The Monitored Conditions Page” on page 239.
A.5.8 Monitoring Frames
When the Set Monitoring for Frames and Switches notebook shown in Figure 176 on page 263 opens, the following default conditions for frames are listed on the Frame page (additionally, conditions for frames you have created using the Creating a Condition from the Event Perspective are listed):

**Conditions to Monitor:**
- frameControllerNotResponding: Status of response of frames to requests and commands from nodes.
- framePowerOff: Status of power to frames.

**Conditions of Contained Objects:**
- hostResponds: Status of communications between processor nodes and the control workstation.
- keyNotNormal: The position of the key mode switch on nodes.
- nodeEnvProblem: Status of the environment light on the front of nodes.
- nodePowerDown: Status of power to nodes.
- nodePowerLED: Status of power light on front of nodes.
- nodeSerialLinkOpen: Status of the serial one port.
- nodeNotReachable: Status of Group Services communication with nodes.
- pageSpaceLow: Paging space on nodes exceeds 85 percent.
- switchNotReachable: Status of communications between switch adapters on nodes.
- switchResponds: Status of switch activity on nodes.
- tmpFull: Status of space on the file system for LV=hd3 and VG=rootvg.

To see detailed information for monitored conditions of objects, open the notebook for the object and view the Monitored Conditions page. Refer to “The Monitored Conditions Page” on page 244:
A.5.9 Monitoring Switches

When the Set Monitoring for Frames and Switches notebook shown in Figure 177 on page 264 opens, the following default conditions for switches are listed on the SwitchBoard page (additionally, conditions for switches you have created using the Creating a Condition from the Event Perspective are listed):

**Conditions to Monitor:**

- **switchPowerLED**  
  Status of power light on front of switches

To see detailed information for monitored conditions of objects, open the notebook for the object and view the Monitored Conditions page. Refer to “The Monitored Conditions Page for Switches” on page 250.
A.6 Controlling Hardware

The following sections show how to control hardware by using SP Perspectives.

A.6.1 Controlling System Partitions

A.6.1.1 Powering On a System Partition

To power on the nodes in a system partition:

1. Click the icon of a system partition in the CWS/System/Syspar pane.
2. Click the **Power On** icon on the tool bar. Refer to Figure 138 on page 205.
3. The Power On/Cluster Power On dialog box shown in Figure 178 on page 265 is presented.
In the Power On/Cluster Power On dialog box, the nodes are listed, by node number, in the Nodes to be operated on: text box.

4. Select from the following **Power On Options**:
   - **Power On**: Turns on power to the nodes.
   - **Cluster Power On**: Turns on power to the nodes only if cstartup dependencies are met.
   - **None**: The default option selected when the dialog box is first presented.

5. Click **Apply**.

The Command output: box displays output for the selected option.

**A.6.1.2 Powering Off a System Partition**

To power off the nodes in a system partition:
1. Click the icon of a system partition in the CWS/System/Syspar pane.
2. Click the **Power Off** icon on the tool bar. Refer to Figure 138 on page 205.
3. The Power Off - Reset/Shutdown/Fence dialog box shown in Figure 179 is presented.

![Figure 179. The Power Off - Reset/Shutdown/Fence Dialog Box](image)

In the Power Off - Reset/Shutdown/Fence dialog box, the nodes are listed, by node number, in the Nodes to be operated on: text box.

4. Select from the following three sets of options:

   - **Power Off options:**
     - **Power Off**
       - Turns off power to the nodes.
     - **Reset**
       - Reboots the nodes.
     - **None**
       - The default option selected when the dialog box is first presented.

   - **Shutdown options:**
     - **Shutdown**
       - Halts the nodes, ignoring cshutdown dependencies, and turns off power to the nodes.
CShutdown  Halts the nodes and turns off power to the nodes only if cshutdown dependencies are met.

None  The default option selected when the dialog box is first presented.

- Fence options:
  - Fence  Isolates the nodes from a switch.
  - Fence with AutoJoin  Isolates the nodes from a switch and enables the nodes to automatically rejoin the switch when the nodes are restarted.
  - None  The default option selected when the dialog box is first presented.

5. Click Apply.

The Command output: box displays output for the selected option.

A.6.1.3 Starting or Restarting a Switch for a System Partition
To start or restart a switch:
1. Click the icon of the current system partition in the CWS/System/Syspar pane.
2. Click Actions in the menu bar.
3. Click Estart in the menu list.

A.6.2 Controlling Nodes

A.6.2.1 Powering On Nodes or Node Groups
To power on nodes or node groups:
1. Select the icons of the desired nodes or node groups in the respective Nodes or Node Groups pane.
2. Click the Power On icon on the tool bar. Refer to Figure 138 on page 205.

The Power On/Cluster Power On dialog box shown in Figure 178 on page 265 is presented.

A.6.2.2 Powering Off Nodes or Node Groups
To power off nodes or node groups:
1. Select the icons of the desired nodes or node groups in the respective Nodes or Node Groups pane.
2. Click the Power Off icon on the tool bar. Refer to Figure 138 on page 205.
The Power Off - Reset/Shutdown/Fence dialog box shown in Figure 179 on page 266 is presented.

A.6.2.3 Fencing and Unfencing
Fencing provides for isolating nodes from the switch and unfencing returns isolated nodes to the switch network. Fencing is used to prevent nodes that are being rebooted or powered off from impacting other nodes in the switch network.

To fence and unfence nodes or node groups:
1. Select the icons of the desired nodes or node groups in the respective Nodes or Node Groups pane.
2. Click Actions in the menu bar.
3. Click Fence/Unfence... in the menu list.

The Fence/Unfence dialog box is presented. Shown in Figure 180.

![Figure 180. The Fence/Unfence Dialog Box](image)

In the Fence/Unfence dialog box, nodes are listed by node number, in the Nodes to be operated on: text box. For dependent nodes, the text box is labeled Dependent nodes to be operated on:.

4. Select from the following Fence options:
**Fence**  
Isolates nodes from the switch.

**Fence with AutoJoin**  
Isolates nodes from the switch and enables nodes to automatically rejoin the switch when nodes are restarted.

**Unfence**  
Returns nodes (that have been previously removed from the switch network) to the switch network.

5. Click **Apply**.

The Output: text box displays command output for the selected option.

### A.6.2.4 Network Booting Nodes or Node Groups

This action initiates a network boot on the specified nodes.

Network booting allows installation, customization, or maintenance of nodes over the SP Ethernet. For information on setting up such installation, customization, and maintenance, refer to the step on network booting in *IBM Parallel System Support Programs for AIX: Installation and Migration Guide*, GC23-2898.

To initiate a network boot of nodes or node groups:

1. Select the icons of the desired nodes or node groups in the respective Nodes or Node Groups pane.
2. Click **Actions** in the menu bar.
3. Click **Network Boot...** in the menu list.

The Network Boot dialog box is presented as shown in Figure 181 on page 270.
The Network Boot Dialog Box
In the Network Boot dialog box, nodes are listed by node number in the Network boot nodes: text box.

1. Click **Apply**.

The Output: box lists network booted nodes by node number.

A.6.2.5 Opening a tty
Opening a tty opens an *aixterm* connection to nodes. The connection is open via the RS-232 and supervisor bus connections, and therefore competes with node controller traffic. You should open a tty connection to display a system console for system debugging, not for general node access. The connection opens /dev/tty0 on nodes.

To open a tty:

1. Select the icons of the desired nodes or node groups in the respective Nodes or Node Groups pane.
2. Click **Actions** in the menu bar.
3. Click **Open TTY...** in the menu list.

System console windows appear as shown in Figure 182 on page 271.
A.6.2.6 Opening an Administrative Session for an Dependent Node

Opening an administrative session for a Dependent Node opens an aixterm connection and telnets to the Dependent Node’s administrative console. The hostname of the Dependent Node is displayed in the title bar of the administrative session window. From this session, you can perform tasks for configuring the attachment of the Dependent Node to the SP system.

For example, you can edit configuration files, run diagnostics, and move the Dependent Node online or offline.

To open an administrative session for a Dependent Node:
1. Select the icon of the desired Dependent Node in the Nodes pane.
2. Click Actions in the menu bar.
3. Click Open Administrative Session... in the menu list.

The administrative session window for the Dependent Node appears as shown in Figure 183 on page 272.
A.6.2.7 Setting the Key Switch
To set the front panel key mode switch position on nodes or node groups:
1. Select the icons of the desired nodes or node groups in the respective Nodes or Node Groups pane.
2. Click Actions in the menu bar.
3. Click Change Key Switch... in the menu list.

The Change Key Switch dialog box is presented as shown in Figure 184 on page 273. If none of the selected nodes or if none of the nodes in a selected node group have a key switch, an informational message stating this will be displayed instead of the Change Key Switch dialog box.
In the Change Key Switch dialog box, the Nodes to be operated on: text window lists the nodes you have selected. If one or more of the selected nodes does not have a keyswitch, the identity of those nodes will be displayed in the Command Output box.

Select from the following Key Switch Position:

**Normal**  
This default setting is used for standard AIX operation. The node will boot to multiuser mode and support user login. *Reset is operational.*

**Secure**  
This setting is used to prevent unauthorized rebooting of a running node or starting a node that has been shutdown. *Reset is not operational.*

**Service**  
This setting is used for running diagnostics on the node. *Reset is operational.*

When a node is in the Service mode, you must open a tty console connecting to the control workstation in order to boot the node.

The Command Output box displays output for the selected option.
A.6.2.8 Running a Command on Nodes or Node Groups

To run a command on nodes or node groups:

1. Select the icons of the desired nodes or node groups in the respective Nodes or Node Groups pane.
2. Click **Actions** in the menu bar.
3. Click **Run Command...** in the menu list.

The Run Command dialog box is presented. Shown in Figure 185.

![Run Command Dialog Box](image)

*Figure 185. The Run Command Dialog Box*

In the Run Command dialog box, nodes are listed by node number in the Run command on nodes: text box.

4. Enter the desired command in the Command: text box.
5. Select **Verify host responds** to check that nodes or node groups are in communication with the control workstation.
6. Click **Apply**.

The Output: text box displays output from the command.

A.6.2.9 Viewing the LCD/LED Display Window

The LCD/LED Display window represents the front panel LEDs of nodes in the current system partition. The LED is a code for an informational message, a warning, or a failure.
The standard RS/6000 codes are documented in the *IBM AIX Version 4.3 Problem Solving Guide and Reference*, SC23-4123.

SP system-specific values are documented in the *IBM Parallel System Support Programs for AIX: Diagnosis and Messages Guide*, GC23-3899.

To view the LCD/LED Display window:
1. Click the Nodes or Node Groups pane to give it focus.
2. Click **Actions** in the menu bar.
3. Click **LCD/LED Display** in the menu list.
4. A LCD/LED Display window is presented as shown in Figure 186.

5. Nodes are displayed in frames. If no code is displayed, this indicates the node is up and running or the node is not powered on or the node is between states displaying LEDs.

6. Pressing the left mouse button in a frame causes the slot numbers to appear in the node areas. These numbers are displayed only while the mouse button is pressed. When you click the right mouse button on the node areas, it launches another window, F1LCD_popup, to show the message on LCD.

![LCD/LED Display Window](image.png)
A.6.3 Controlling Node Groups

Node grouping is a facility for naming and saving sets of nodes.

Nodes can be grouped together so that the group can be acted on as a single entity or object. Node groups can be made up of individual nodes, as well as other node groups.

Dependent Nodes cannot be members of node groups.

Some node groups exist within a system partition (partition-bound) and some node groups cross system partition boundaries (global).

To display partition-bound node groups in the Node Groups pane, the system partition that the node group is in must be set as the current system partition.

To display global node groups in the Node Groups pane, the System must be set as the current system partition. That is, the view of the SP system must be Global. (Note that when the view is Global, only global node groups are displayed in the Node Groups pane; partition-bound node groups are not displayed.)

The Node Group notebook also provides you with the following methods to create, modify, and remove node groups:

- Creating a Node Group
- Modifying a Node Group
- Removing a Node Group

A.6.3.1 Creating a Node Group

To create a Node Group:

1. Click the Nodes pane or Node Groups pane.
2. Click Actions in the menu bar.
3. Click Create Node Group... to open the Create Node Group notebook shown in Figure 187 on page 277.
Monitoring and Controlling Hardware

Figure 187. The Create Node Group Notebook

In the Create Node Group notebook:

4. Enter the name of the node group in the Node group name: text entry box.
5. Select nodes from the Available Nodes: list box, or select node groups from the Available Node Groups: list box.
6. Click on the left arrow button to add the selected nodes or node groups to the Member Nodes: or Member Node Groups: list box.
7. Click Create to create the node group and close the notebook, or click Apply to create the node group and leave the notebook open.

An icon for the newly created node group appears in the Node Groups pane of the Hardware Perspective.

A.6.3.2 Modifying a Node Group

To modify a Node Group:

1. Open the View and Modify Properties Node Group notebook shown in Figure 160 on page 239.
2. To add nodes and node groups to the existing node group:
1. Select nodes from the Available Nodes: list box, or select node groups from the Available Node Groups: list box.

2. Click on the left arrow button to add the selected nodes or node groups to the Member Nodes: or Member Node Groups: list box.

3. To delete nodes or node groups from the existing node group:
   1. Select nodes from the Member Nodes: list box, or select node groups from the Member Node Groups: list box.
   2. Click on the right arrow button to move the selected nodes or node groups to the Available Nodes: or Available Node Groups: list box.

Click Ok to modify the node group and close the notebook, or click Apply to modify the node group and leave the notebook open.

A.6.3.3 Removing a Node Group
To remove a Node Group:
1. Click the icon of the desired node group in the Node Groups pane.
2. Click Actions in the menu bar.
3. Click Remove Node Group to remove a node group.

The node group icon is removed from the Node Groups pane of the Hardware Perspective and the node group is removed from the SDR.

A.6.4 Controlling Frames
A.6.4.1 Powering on Frames
You can power on frames only if the System object is set as the current system partition. That is, the view of the SP system must be Global.

To power on frames:
1. Click the icons of the desired frames in the Frames and Switches pane.
2. Click the Power On icon on the tool bar. Refer to Figure 138 on page 205.
3. A message box shown in Figure 188 on page 279 is presented that asks if you are sure you want to power on the frames. To power on the frames, click Enter.
A.6.4.2 Powering Off Frames

You can power off frames only if the System object is set as the current system partition.

That is, the view of the SP system must be Global.

To power off frames:

1. Click on the icons of the desired frames in the Frames and Switches pane.
2. Click the Power Off icon on the tool bar. Refer to Figure 138 on page 205.
3. A message box Figure 189 on page 279 is presented that asks if you are sure you want to power off the frames. To power off the frames, click Enter.
A.6.5 Controlling Switches

A.6.5.1 Powering On Switches
You can power on switches only if the System object is set as the current system partition.

That is, the view of the SP system must be Global.

To power on switches:
1. Click the icons of the desired switches in the Frames and Switches pane.
2. Click the **Power On** icon on the tool bar. Refer to Figure 138 on page 205.
3. A message box is Figure 190 on page 280 presented that asks if you are sure you want to power on the switches. To power on the switches, click **Enter**.

![Figure 190. The Powering On Switches Message Box](image)

A.6.5.2 Powering Off Switches
You can power off switches only if the System object is set as the current system partition. That is, the view of the SP system must be Global.

To power off switches:
1. Click the icons of the desired switches in the Frames and Switches pane.
2. Click the **Power Off** icon on the tool bar. Refer to Figure 138 on page 205.
3. A message box is Figure 191 on page 281 presented that asks if you are sure you want to power off the switches. To power off the switches, click **Enter**.
A.7 SP Perspectives Examples

The following sections show how to use new SP Perspectives features.

A.7.1 Using Multiple Panes and Multiple Windows

This example shows how to set up two node panes in one window, and a third nodes pane in a second window.

1. Start the Hardware Perspective. This example uses the default configuration of a CWS, System and Syspars pane (labeled CWS, System and Syspars:1) and a Nodes pane (labeled Nodes:1).

2. Click in the Nodes pane.

3. Click the Monitor icon:

4. Select hostResponds and click Ok.

5. Click the Add pane icon:

6. Then
   1. For Pane type:, select Nodes.
   2. For Add pane to: select Current window.
   3. For Pane title: use the default Nodes:2.
   4. Click Apply.
7. A new nodes pane appears in the Hardware Perspective window, with the title Nodes:2. Click in the new Nodes:2 pane and start monitoring for switchResponds.

8. From the Add Pane dialog box:
   1. a. For Pane type:, select Nodes.
   2. b. For Add pane to: select New window.
   3. c. For Pane title: use the default Nodes:3.
   4. d. Click Ok.

9. A new Hardware Perspective window appears displaying the new Nodes:3 pane. Start monitoring in this third nodes pane for nodePowerLED. You now have three nodes panes, each monitoring a separate condition.

10. Each window can represent a different system partition.
    1. Select View ==> Change System Partition....
    2. Select the new system partition for the current window.
    3. You now have multiple windows allowing you to view different system partitions simultaneously.

11. To save this configuration to a preferences file for use during future SP Perspectives sessions, see 2.7, “Saving Preferences” on page 33.

**A.7.2 Using Table View**

This example shows how to set up a table view to monitor several conditions and simultaneously view selected node properties.

1. Start the Hardware Perspective and click in a Nodes pane.
2. Click the Monitor icon:

3. Hold down the Ctrl key and select hostResponds, switchResponds, and nodePowerLED, and click Ok.
4. Click the Table View icon:

5. Select the following Table Attributes by holding down the Ctrl key: Power LED, switchResponds, hostResponds, and Key switch position. Click Ok.
6. The pane display changes from icon view to table view. The text in the upper right hand corner of the pane shows that the pane is monitoring hostResponds, switchResponds, and nodePowerLED. The table shows the value of the node attributes (not the conditions).

7. Sort the nodes by Name in descending order:
   1. Click the **Name** column heading.
   2. Click the **Sort** icon:
   3. Select **Descending order** and click **Ok**.

8. Filter the table by switchResponds:
   1. Click the **Switch responds** column heading.
   2. Click the **Filter** icon:
   3. Select **Filter objects by values displayed in the selected column** and enter **Normal**.
   4. Select **Hide objects that match the filtering criteria** and click **Ok**.
   5. The table displays nodes by switchResponds other than Normal.

9. To save this configuration to a preferences file for use during future SP Perspectives sessions, see 2.7, “Saving Preferences” on page 33.

**A.7.3 Saving and Loading Preferences**

This example shows how to save a Perspectives window layout for future use.

1. Set up an SP Perspectives window layout you want to save.

2. Select **Options ==>>Save Preferences**.

3. Select User to save the profile to your $HOME directory (this is the default. A User profile is only accessible to you.) Alternatively, select System to save a system profile to the /usr/lpp/ssp/perspectives/profiles/LANG/ directory (A System profile is accessible to all users on your system.) (LANG is the current setting for the $LANG language variable.)

4. Profile name: will list the valid existing profiles depending on whether User or System is selected. Click the down arrow and select one, or type in a name.
• These names are appended to a hidden file with the name of the Perspective you are running. If you save a Hardware Perspective user profile with the name TableView, a file called .sphardwareTableView will be saved to your $HOME directory.

• A root user can overwrite the default system profile if System is selected and the user selects Profile from the list. (The default system profile is kept in /usr/lpp/ssp/perspectives/profiles/LANG/.sphardwareProfile).

5. Choose the preferences to save. By default Layouts is selected. You can also save the Colors and Font.

6. The next time you invoke this Perspective, use the -userProfile or -systemProfile command line option to load your preferences profile. For example, if you saved a user profile named TableView, load this profile from the command line by typing: sphardware -userProfile TableView. Or you can add the invocation of this profile to the Perspective Launch Pad. See 2.3, “Displaying Applications on the Launch Pad” on page 25.

A.7.4 Filtering by and Acknowledging Monitoring States

This example shows how to set up monitoring and filtering so that your pane displays only the nodes with a specified monitoring state.

1. Start the Hardware Perspective. This example assumes the default configuration of a CWS, System and Syspars:1 pane and a Nodes:1 pane.

2. Click in the Nodes:1 pane

3. Select View ==>>Do Not Show Nodes in SP Frames (this view saves screen space).

4. Click the Monitor icon:

5. Select nodeSerialLinkOpen and click Ok.

6. Click the Add Pane icon:

Add a Nodes:2 pane to either the current window or a new window.

7. Select the Nodes:2 pane.
8. Click the Table icon:

9. Select the attributes **hostResponds** and **switchResponds**.

10. Click the Monitor icon:

11. Select **nodeSerialLinkOpen** and click **Ok**.

12. Click on a node and select **Actions ==>>Open TTY**. Verify that the monitoring icon for the node has turned to a red X. Repeat this step for several nodes in both panes.

13. Select the **Nodes:1** pane.

14. Click the Filter icon:

   Select Filter objects by their monitoring state. The defaults Triggered (red X) and Unknown will be selected.

15. Click **Ok**. The icons with red X's display the triggered nodes.

16. Repeat steps 12 and 13 for the **Nodes:2** pane.

17. Open a tty on another node (you may need to bring up another nodes pane to do this), and you will see the panes update to add that node, since it has triggered. Similarly, if you close a tty on one of the nodes, you will see the panes update accordingly, and that node will no longer be shown, since it is no longer triggered.

18. You now have panes that show only the data you have chosen to monitor. For example, a large system could be filtered by monitoring state for **hostResponds** in order to see only the problem nodes.

19. You can acknowledge the problem nodes for the condition you are monitoring.

   1. Select the nodes you want to acknowledge
   2. Select the **Acknowledge** icon:

   3. The selected nodes change from a red X to a yellow check mark.
4. If you acknowledge a triggered node in this scenario, it will change to a check mark. Then the pane will update to filter it out, since this pane is only showing nodes that are triggered or unknown.

20. If you save this profile to a preferences file, the acknowledgments do not get saved. The Filter by Monitor State settings will be saved. See 2.7, “Saving Preferences” on page 33.
Appendix B. Managing Events

This chapter describes how you can manage events by using the Event Perspective to define and monitor events.

B.1 The Event Perspective Interface

The Event Perspective lets you create event definitions that let you know automatically when changes that you specify have occurred in your SP system. It can be used to notify you when a node goes down or becomes unreachable, or when the system is close to running out of paging space, or when there is something wrong with the switch.

The Event Perspective window consists of:
- The Syspars, Event Definitions, and Conditions Panes
- The Menu Bar
- The Tool Bar

Figure 4 on page 8 shows the Event Perspective window.

B.1.1 Selecting Objects

To perform a menu bar or tool bar action on an Event Perspective object (system partition, event definition, or condition), you must first select it. If you select more than one object, the action applies to all objects selected.

Some actions, like opening a notebook, apply only to individual objects and are grayed out if multiple objects are selected.

The actions you are not authorized to perform are grayed out in the menu bar and on the tool bar.

Note

- To select multiple objects that are next to each other in a pane, click the icon of the first desired object, hold the left mouse button down, and move the cursor over the icons of other desired objects in the pane.
- To select multiple objects that are not next to each other in a pane, hold down the Ctrl key on your keyboard while you click each desired object in the pane.
B.1.2 Panes

The Event Perspective window has three panes:

- The Syspars pane displays the system partitions. The name of the current system partition appears in the title bar and its icon in the Syspars pane contains a yellow lightning bolt.
- The Event Definitions pane shows the event definitions for the current system partition.
- The Conditions pane shows the conditions defined for the current system partition.

You can view each Event Perspective pane in either icon view or table view. In icon view, objects (system partitions, event definitions, or conditions) are shown as icons.

In table view, objects are displayed as entries in a table. To customize the information displayed for each object in the table, click **View** on the menu bar and select **Set Table Attributes**.

To change a pane from icon view to table view, click **Show objects in Table View or Icon View** icon on the tool bar.

B.1.3 Menu Bar

The Event Perspective menu bar contains pull-down menus for actions you can perform on window pane objects: system partitions, event definitions, and conditions. The menu bar also has options for customizing the display of objects in the window panes. Some of the more frequently used menu bar actions also appear as tool bar icons for one-click access.

The menu bar options shown will vary depending on:

- The pane that is active.
- The object that is selected, if any.
- Whether the pane is in icon view or table view.
- Whether the pane is hidden.
- What actions you are authorized to perform.

The following describes all menu options that could appear under a particular menu.

B.1.3.1 The Window Menu

The Window menu consists of the following:
Exit

Closes the Event Perspective window and any secondary windows belonging to the Event Perspective.

B.1.3.2 The Actions Menu

The Actions menu consists of the following:

View Properties... View the notebook for the selected object. If you are authorized to modify as well as view properties, the View and Modify option is shown instead.

View and Modify Properties... View and modify the notebook for the selected object (system partition, event definition or condition).

Set Current System Partition Make current the selected system partition.

Set Monitoring... Begin monitoring hardware for state changes.

Create... Create a new event definition (if the Event Definition pane is selected). Create a new condition (if the Conditions pane is selected).

Register Register the selected event definition to make it active.

Unregister Unregister the selected event definition to make it inactive.

Delete Delete the selected event definition or condition.

Reset Event Status After an event occurs, use this option to restore the selected event definition to its pre-event state so it can begin monitoring for the next occurrence of the event. Use this option only if the event definition has no rearm expression.

Set Notification Option Change the selected event definition(s) to indicate visually when an event occurs. To select more than one event definition, hold down the Ctrl key while making your selections.

View Event Notification Log View the log containing entries for each event or rearm event in any system partition.
B.1.3.3 The View Menu

The View menu consists of the following:

**Change System Partition...**
Change the current system partition.

**Delete Current Pane**
Hide the selected pane (shown only if more than one pane is displayed).

**Sort...**
Sort objects in a pane in either ascending or descending order.

**Filter...**
Filter objects in a pane to display only those you want to see.

**Remove Filter...**
Remove a filter that is in effect for a pane.

**Select All**
Select all objects in a pane. Use this option to quickly select all pane objects so you can perform an action on them.

**Deselect All**
Deselect all objects in a pane. Use this option to undo a Select All action.

**Show Objects in Table View**
Change the selected pane from icon view to table view (shown only when the selected pane is in icon view).

**Show Objects in Icon View**
Change the selected pane from table view to icon view (shown only when the selected pane is in table view).

**Add Pane**
Display a pane that is currently hidden (shown only if one or more panes are hidden).

**Set Monitoring...**
Select/deselect conditions to monitor. Also start/stop monitoring.

**Set Table Attributes**
Change the information shown in table view for objects in the selected pane (shown only when the selected pane is in table view).

**Set Object Label...**
Specify the type of information used to label icons in a pane. This option appears only if the pane is icon view.

**Delete Current Pane**
Delete the selected pane.

**Change Current Pane Title...**
Change the title of the selected pane.

B.1.3.4 The Options Menu
The Options menu consists of the following:

**Show as Vertical Panes**  Display Event Perspective panes vertically (shown only when the panes are displayed horizontally).

**Show as Horizontal Panes**
Display Event Perspective panes horizontally (shown only when the panes are displayed vertically).

**Hide Info Area**
Hide the information area at the bottom of the Event Perspective window (shown only when the information area is displayed).

**Display Info Area**
Display the information area at the bottom of the Event Perspective window (shown only when the information area is hidden).

**Hide Tool Bar**
Hide the tool bar (shown only when the tool bar is displayed).

**Show Tool Bar**
Show the tool bar (shown only when the tool bar is hidden).

**Save Preferences...**
Save the colors, fonts, and layout currently set for the Event Perspective window so that when you bring up the Event Perspective again, it will be displayed the same way.

**Set Colors...**
Change the colors used in the Event Perspective.

**Set Font...**
Change the fonts used in the Event Perspective.

B.1.4 Tool Bar

Tool bar icons represent short cuts for actions you can select from the Menu bar. You can use tool bar icons to perform actions on system partitions, event definitions, or conditions, or to customize their display in Event Perspective panes.

The tool bar options shown will vary depending on:

- The pane that is active.
- The object that is selected, if any.
- Whether the pane is in icon view or table view.
• Whether the pane is hidden.
• The actions you are authorized to perform.

Figure 192. The Tool Bar Icons

The following list explains each icon, from left to right, in Figure 192:

**Notebook**
When you are in the Syspars pane, this icon means you can view the properties of a system partition.

When you are in the Event Definitions pane, this icon means you can view and modify the properties of an event definition.

When you are in the Conditions pane, this icon means you can view and modify the properties of a condition.

**Create**
When you are in the Event Definitions pane, this icon means you can create an event definition.

When you are in the Conditions pane, this icon means you can create a condition.

**Register**
When you are in the Event Definitions pane, this icon means you can register one or more event definitions.

**Unregister**
When you are in the Event Definitions pane, this icon means you can unregister one or more event definitions.

**Delete**
When you are in the Event Definitions pane, this icon means you can delete one or more event definitions.

When you are in the Conditions pane, this icon means you can delete one or more conditions.

**Notification**
When you are in the Event Definitions pane, this icon means you can set the notification options on one or more event definitions.

**Log**
When you are in the Event Definitions pane, this icon means you can view log details about Events.
Sort
Sort Object in the pane.

Filter
Filter objects in the pane.

Unfilter
Remove filter applied to the pane.

Select
Select all objects in the pane.

Deselect
Deselect all selected objects in the pane.

Add Pane
Add a pane to the Event Perspective window.

Delete Pane
Delete a pane from the Event Perspective window.

View
Show objects from in the table view to in the icon view, or the other way around.

Monitor
When you are in the Syspars pane, this icon means you can set up monitoring.

B.1.5 Viewing Panes in Icon View
Table 13 on page 293 shows how Event Perspective objects appear as icons in icon view.

<table>
<thead>
<tr>
<th>Object</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Partition: current one</td>
<td>Icon with yellow lightning bolt</td>
</tr>
<tr>
<td>System Partition: not current one</td>
<td>Icon without yellow lightning bolt</td>
</tr>
<tr>
<td>Event Definition: registered:</td>
<td>Multiple color icon</td>
</tr>
<tr>
<td>visual notification set; rearm expression</td>
<td></td>
</tr>
<tr>
<td>Event Definition: registered:</td>
<td>Blue color icon</td>
</tr>
<tr>
<td>visual notification set; no rearm expression</td>
<td></td>
</tr>
<tr>
<td>Event Definition: registered and no visual</td>
<td>Half-grey color icon</td>
</tr>
<tr>
<td>notification set</td>
<td></td>
</tr>
<tr>
<td>Event Definition: not registered</td>
<td>All-grey color icon</td>
</tr>
<tr>
<td>Event Notification for an Event Definition:</td>
<td>White envelope</td>
</tr>
<tr>
<td>with rearm expression</td>
<td></td>
</tr>
<tr>
<td>Event Notification for an Event Definition:</td>
<td>Blue envelope</td>
</tr>
<tr>
<td>without rearm expression</td>
<td></td>
</tr>
</tbody>
</table>

B.1.6 Viewing Panes in Table View
To change a pane from table view to icon view, or the other way around, click the **Show objects in Table View or Icon View** tool bar icon or click View. In
table view, pane objects are shown as table entries, allowing you to see information about each object without opening its notebook.

The first time you change a pane from icon view to table view, the Set Table Attributes notebook opens to let you specify the object information you want shown in the table. To change table attributes after that, click View on the menu bar and select Set Table Attributes.

**B.1.6.1 Setting Table Attributes for the Syspars Pane**

You can customize the information displayed about each system partition in table view. The information options match the Syspar attributes displayed in the Syspar page shown in Figure 193 on page 295.

Choose one or more of the following:

- **Name**
  The name of the system partition.

- **Address**
  The Internet Protocol address of the system partition.

- **Code Version**
  The minimum (earliest) version of PSSP running in the system partition.

- **Directory**
  The directory containing the system partition configuration layout.

- **Install Image**
  The name of the image installed on the system partition.

- **Primary Name**
  The name of the switch primary node. The switch primary node initializes the switch fabric and processes switch operations and errors reported from the switch fabric.

- **Oncoming Primary Name**
  The name of the node that will become the switch primary node on the next Estart.

- **Primary Backup Name**
  The name of the node that is backup to the switch primary node.

- **Oncoming Primary Backup Name**
  The name of the node that will become the backup to the switch primary node on the next Estart.

- **Switch Max Itu**
  The maximum packet length of the data portion of an IP packet sent over the switch.
Switch Link Delay

The switch link delay value used by switch support when initializing the switch network.

![Set Table Attributes for Syspars](image)

*Figure 193. The Syspar Page of Set Table Attributes Notebook*

When you are finished, click:

- **Ok** to set the table attributes and close the notebook.
- **Apply** to set the table attributes but keep the notebook open.
- **Cancel** to cancel your selections and close the notebook.
- **Reset** to reset the attributes to what they were when you opened the notebook.

### B.1.6.2 Setting Table Attributes for the Event Definitions Pane

You can customize the information displayed about each event definition in table view. The information options match the event definition properties displayed in the Event Definition page shown in Figure 194 on page 297.

Choose one or more of the following:

**Condition Name**

The name of the condition associated with the event definition. If the condition name is Unnamed, it was created from the command line, with no name specified, as a result of a Problem Management subscription. Unnamed conditions cannot be modified.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Condition Description</strong></td>
<td>A brief description of the condition. Resource ID elements specified. The system resources to be monitored for the condition.</td>
</tr>
<tr>
<td><strong>Initial Evaluation</strong></td>
<td>Whether the system should check for the specified condition immediately when you register the event definition.</td>
</tr>
<tr>
<td><strong>Registration</strong></td>
<td>Whether the event definition is registered.</td>
</tr>
<tr>
<td><strong>Notification</strong></td>
<td>Whether you are notified when an event occurs.</td>
</tr>
<tr>
<td><strong>Event Resources</strong></td>
<td>The resources currently affected by the event.</td>
</tr>
<tr>
<td><strong>Kerberos Principal</strong></td>
<td>The name of the Kerberos principal that created the event definition.</td>
</tr>
<tr>
<td><strong>Actions</strong></td>
<td>Whether actions are enabled. Actions are enabled if <strong>Take these actions when the event occurs</strong> is selected on the Actions page of the Event Definition notebook.</td>
</tr>
<tr>
<td><strong>Command</strong></td>
<td>The command the system is to issue when the event occurs. This command is issued only if actions are enabled in the Event Definition notebook.</td>
</tr>
<tr>
<td><strong>Trap ID</strong></td>
<td>The ID of the SNMP trap to be generated when the event occurs. This attribute is valid only if <strong>Generate SNMP Traps</strong> is selected.</td>
</tr>
<tr>
<td><strong>Log text</strong></td>
<td>The text to be logged to the AIX error log and the BSD syslog when the event occurs. This attribute is valid only if <strong>Log to AIX error log and BSD syslog</strong> is selected. Actions must also be enabled in the Event Definition notebook.</td>
</tr>
<tr>
<td><strong>Rearm actions</strong></td>
<td>Whether actions are enabled. Actions are enabled if <strong>Take these actions when the rearm event occurs</strong> is selected on the Actions page of the Event Definition notebook.</td>
</tr>
<tr>
<td><strong>Rearm command</strong></td>
<td>The command the system is to issue when the rearm event occurs. This command is issued only if actions are enabled in the Event Definition notebook.</td>
</tr>
<tr>
<td><strong>Rearm trap ID</strong></td>
<td>The ID of the SNMP trap to be generated when the rearm event occurs. This attribute is valid only if <strong>Generate SNMP Traps</strong> is selected.</td>
</tr>
</tbody>
</table>
Rearm log text

The text to be logged to the AIX error log and the BSD syslog when the rearm event occurs. This attribute is valid only if Log to AIX error log and BSD syslog is selected. Actions must also be enabled in the Event Definition notebook.

Where to take actions

Where the event actions or rearm event actions are to be performed.

Selected nodes

Where the event actions or rearm event actions are to be performed.

Selected node group

Where the event actions or rearm event actions are to be performed.

Figure 194. The Event Definition Page of Set Table Attributes Notebook

When you are finished, click:

• **Ok** to set the table attributes and close the notebook.
• **Apply** to set the table attributes but keep the notebook open.
• **Cancel** to cancel your selections and close the notebook.
• **Reset** to reset the attributes to what they were when you opened the notebook.

**B.1.6.3 Setting Table Attributes for the Conditions Pane**

You can customize the information displayed about each condition in table view. The information options match the condition properties displayed in the Condition page shown in Figure 195 on page 299.

Choose one or more of the following:

- **Name**  
  The name of the condition.

- **Description**  
  A brief description of the condition.

- **Resource Variable**  
  The resource variable for the condition.

- **Expression**  
  The expression that defines the relationship between the resource variable and other elements (such as constants or the previous value of the variable) that, when true, generates the event.

- **Rearm Expression**  
  The expression that defined the relationship between the resource variable and other elements (such as constants or the previous value of the variable) that, when true, generates the rearm event.

- **Fixed Resource ID Elements**  
  Resource IDs to which the conditions restricted.
When you are finished, click:

- **Ok** to set the table attributes and close the notebook.
- **Apply** to set the table attributes but keep the notebook open.
- **Cancel** to cancel your selections and close the notebook.
- **Reset** to reset the attributes to what they were when you opened the notebook.

**B.1.7 Filter Objects**

Use filtering to limit the objects that are displayed in an Event Perspective pane. This lets you see only the objects that you want to work with.

To filter Event Perspective objects:

1. Click the pane whose objects you want to filter.
2. Click the **Filter**.

If you are filtering system partitions or conditions, the Filter dialog box opens. If you are filtering event definitions, the Filter Event Definitions dialog box opens. For Filter dialog box, refer to “The Filter Dialog Box” on page 14.

To remove Event Perspective object filtering:

1. Click the pane whose objects you want to stop filtering.
2. Click **Remove Filter**.

**B.1.7.1 The Filter Event Definitions Dialog Box**

Use the Filter Event Definitions dialog box shown in Figure 196 on page 301 to limit the type of event definitions that are displayed in the Event Definitions pane so you see only the event definitions you are interested in.

You can filter event definitions by any or all of the following:

- Kerberos Principals
- Event Responses
- Registration

Your selections work together to determine the set of event definitions for the current system partition that are displayed in the Event Definitions pane.

By default, the event definition filtering options are set to:

- **Kerberos Principal** All Kerberos Principals
- **Event Responses** Both
- **Registration** Both

These options cause the following event definitions to be displayed:

- All registered and unregistered event definitions that your own Kerberos principal created that contain a notification, or one or more actions, or both.
- All registered and unregistered event definitions that all other Kerberos principals created that contain one or more actions.
To filter event definitions, do the following steps:

**Step 1: Select Different Kerberos Principal Options**

Your selection in the Kerberos Principals area is used to filter event definitions based on the Kerberos principal that created them. For more information on Kerberos principals, see *IBM Parallel System Support Programs for AIX: Administration Guide, GC23-3897, GC23-3897*.

Select one of the following:

**Current User (Current Kerberos Principal)**

Include only the event definitions that your Kerberos principal created; exclude event definitions created by other Kerberos principals.

**Other Kerberos Principal**

Include only the event definitions that a specific Kerberos principal created; exclude event definitions created by your own Kerberos principal; exclude event definitions created by any other Kerberos principal that is not specified. Enter the name of the Kerberos principal that you wish to specify in the Kerberos Principal: field.

Include the event definitions that all other Kerberos principals created; exclude event
definitions created by your own Kerberos principal. Leave the Kerberos Principal: field blank.

**All Kerberos Principals** Include the event definitions that were created by all Kerberos principals, including your own.

**Step 2: Select Event Responses Options**
Your selection in the Event Responses area is used to filter event definitions based on whether they contain a notification response, one or more action responses, or both. It modifies the set of event definitions you have included by means of the Kerberos Principals option you selected.

---

**Attention**

The My Notifications option applies only to event definitions that your own Kerberos principal created. The combination of Other Kerberos Principal and My Notifications is not valid.

To prevent you from selecting this invalid combination, when you select the Other Kerberos Principal option, the Event perspective grays out the My Notifications and Both buttons in the Event Responses area.

Select one of the following:

**My Notifications**
From the set of event definitions determined by the Kerberos Principals selection, include your own event definitions that contain notifications; exclude your own event definitions that contain actions but no notifications; exclude all event definitions created by other Kerberos principals.

**Actions**
From the set of event definitions determined by the Kerberos Principal selection, include all event definitions that contain actions, whether your own or created by another Kerberos principal; exclude your own event definitions that contain notifications but no actions.

**Both**
From the set of event definitions determined by the Kerberos Principal selection, include your own event definitions that contain either notifications, actions, or both; include event definitions created by other Kerberos principals that contain actions; exclude your own event definitions that do not contain a response; exclude event definitions...
created by other Kerberos principals that do not contain an action.

**Step 3: Select Registration Options**
Your selection in the Registration area is used to filter event definitions based on whether they have been registered. It modifies the set of event definitions you have included by means of the Kerberos Principals and Event Responses options you selected.

Select one of the following:

- **Registered**
  From the set of event definitions determined by the Kerberos Principal and Event Responses selections, include event definitions that have been registered; exclude event definitions that have been unregistered.

- **Unregistered**
  From the set of event definitions determined by the Kerberos Principal and Event Responses selections, include event definitions that have been unregistered; exclude event definitions that have been registered.

- **Both**
  From the set of event definitions determined by the Kerberos Principal and Event Responses selections, include both event definitions that have been registered and those that have been unregistered.

**Step 4: When you are finished, click:**
- **Ok** to set the information for the session and close the dialog box.
- **Apply** to set the information for the session but keep the dialog box open.
- **Cancel** to cancel the information for the session and close the dialog box.
- **Reset** to reset the information for the session to what they were when you opened the dialog box.

**B.1.7.2 Examples**
Here are some examples of how to filter event definitions for the current system partition:

- To display all of the event definitions that you can see, select (or leave as the default):
  - **Kerberos Principal**
    All Kerberos Principals
  - **Event Responses**
    Both
Registration  Both
Keep in mind that you cannot see the event definitions that are owned by other Kerberos principals that contain only the notification option.

• To display all of the event definitions that are registered and for which actions have been defined, select:

  Kerberos Principal  All Kerberos Principals
  Event Responses  Actions
  Registration  Registered

• To display all of your own event definitions that are registered, filter out your unregistered event definitions, and filter out all of the event definitions of other Kerberos Principals, select:

  Kerberos Principal  Current Kerberos Principal
  Event Responses  Both
  Registration  Registered

• To display all of the event definitions created by Kerberos principal admin_2, select:

  Kerberos Principal  Other Kerberos Principal and enter in the Kerberos Principal field: admin_2
  Event Responses  Actions
  Registration  Both

B.2 Working with System Partitions

From the Event Perspective, you can:

• Make a system partition current, to work with its associated event definitions and conditions.

• View a system partition's properties.

B.2.1 Making a System Partition Current

Each system partition has its own event definitions and conditions. Before you create a new event definition or condition or work with an existing one, you must make the right system partition current.

The name of the current system partition appears in the Event Perspective window title bar. The Syspars pane displays all the system partitions and shows the current partition with a yellow lightning bolt.
The event definitions for the current system partition appear in the Event Definitions pane. The conditions for the current system partition appear in the Conditions pane.

To set the current system partition:
1. Select the desired System Partition object from the Syspars pane.
2. Click Actions from the menu bar.
3. Click Set Current System Partition from the scroll list.

In response, the name of the system partition appears in the title bar, a yellow lightning bolt appears in the system partition’s icon, and its associated event definitions appear in the Event Definitions pane. The icon looks like Figure 139 on page 206.

B.2.2 Viewing System Partition Properties
View the properties of a system partition by double-clicking the system partition’s icon to open the View Properties notebook. For more detail, refer to “Viewing Hardware Attributes” on page 206.

B.3 Working with Event Definitions
From the Event Definitions pane, you can:
• Create an Event Definition
• View and Modify an Event Definition
• Register or Unregister an Event Definition
• Delete Event Definitions

B.3.1 Create an Event Definition
The Event Perspective lets you create event definitions for the system partitions in your SP system. The event definitions created by a Kerberos principal are available only to users using that Kerberos principal. Other Kerberos principals cannot register, unregister, modify, or delete them.

To create an event definition:
1. If necessary, make current the system partition for which you want to create the event definition.
2. Click the Event Definitions pane to make it current.
3. Click **Create** on the tool bar icon to open the Create Event Definition notebook.

4. On the Definition page shown in Figure 197 on page 307, specify the properties of the new event definition. For details, refer to “The Definition Page” on page 306.

5. On the Notifications page shown in Figure 198 on page 310, specify whether you want the Event Perspective to notify you visually when an event occurs. For details, refer to “The Notifications Page” on page 309.

6. On the Actions page shown in Figure 199 on page 311, specify actions the system is to take when an event occurs. For details, refer to “The Actions Page” on page 311.

7. When you are finished, click:
   - **Create** to create the event definition and close the notebook.
   - **Apply** to create the event definition but keep the notebook open.
   - **Cancel** to cancel your selections and close the notebook.
   - **Reset** to reset the properties to what they were when you opened the notebook.

The Event Definitions pane should now include an icon labeled with the name you gave it.

Information about the event definitions is stored in the file $HOME/$USER:Events. When you define event definitions for another system or another user, you can copy this file and modify it. However, the file contains information about the Kerberos Principal for each event definition, so it can only be used without change by a user with the same Kerberos Principal. Also, if you try to use the profile on a system with a different configuration, you might receive error messages for event definitions that refer to resources that do not exist in the new configuration.

**B.3.1.1 The Definition Page**

On the Definition page of the Create Event Definition notebook shown in Figure 197 on page 307, do the following steps:
Step 1: Name the Event Definition

Your new event definition will be known in the current system partition by the name you specify in the this page.

To name the event definition:

- In the Event definition name: field, specify a name for the event definition. The name may not include a period.
- Event definition names must be unique within a system partition for the same Kerberos principal. However, you can use the same names for event definitions in different system partitions.
Step 2: Specify the Condition

A condition defines the circumstances within the system that cause an event. When you create an event definition, you must specify the condition, which is made up of the following parts:

- A resource variable
- A resource identifier
- An event expression
- Optionally, a rearm expression

You can either specify a pre-defined condition or create a new one.

To specify a pre-defined condition:

- The Condition Name: selection box lists the pre-defined conditions for the current system partition. Unnamed conditions were created from the Problem Management command line, where a condition name was not specified. You cannot change these using the Event Perspective.
- From the Condition Name selection box, select a condition. Information pertaining to the selected condition is displayed in the Description: text box.
- To view and modify the condition, click View and Modify Condition... to open the View and Modify Properties Condition notebook.

To create a condition:

- Click Create Condition... to open the Create Condition notebook.
- If the Create Condition... button is grayed out, you are not authorized to create new conditions. To correct this, see “Security Considerations for the Event Perspective” on page 107.
- If you just created a new condition for this event definition, it will not automatically appear when you return to this page. You must select the newly-created condition with the selection box of the Condition Name: field before continuing.

Step 3: Specify the Resource Identifier

When you create an event definition, you must identify the specific resource identifier you want to monitor.

A resource identifier is a set of name/value pairs. For example, in the resource identifier NodeNum=5, NodeNum is the element name and 5 is the element value. When you select or create a condition, the resource identifier element names associated with the designated resource variable appear in
the Element Names field. When you specify element values from the Element Values field for an element name, the complete name/value pair appears in the Resource ID element specified: field.

To specify the resource identifier:

1. From the **Element Names** field, select an element name.
2. From the **Element Values** field, select one or more values for the element name. You can select multiple consecutive values by holding the mouse button and dragging the mouse over the desired values. To specify all element values, click **Wild-card Element Values**. The wild card option is also useful when the system’s resource monitor is unable to retrieve the list of element values for a particular resource variable.

Repeat these steps for each element name in the Element Names field.

**Step 4: Register the Event Definition**

Registering an event definition causes the system to begin checking for the specified event. Unregistering an event definition makes it inactive.

To register the event definition:

- If you want the system to do an initial evaluation to see if the event specified by this event definition has already occurred, click **Initial evaluation**. An initial evaluation is performed only when the event definition is registered.
- To register (activate) the event definition, click **Registration**. To unregister (deactivate) the event definition, deselect **Registration**.

**B.3.1.2 The Notifications Page**

The Notifications page of the Create Event Definition notebook shown in Figure 198 on page 310 lets you specify whether you want the Event Perspective to notify you visually when an event occurs. This page also contains a view-only log of events that have occurred.
To be notified visually when an event occurs:

• Click Notification.

With this option, an event causes the following:

• An entry appears in the Event Notification Log. This happens for events occurring in any system partition. If the log is not already open, a window opens to display it.

• The event definition's icon in the Event Definitions pane changes to look like an envelope. This happens only for events whose event definitions for the current system partition.
  • If the event definition has a rearm expression, the envelope is white.
  • If the event definition has no rearm expression, the envelope is blue.
B.3.1.3 The Actions Page

The Actions page of the Create Event Definition notebook shown in Figure 199 on page 311 lets you specify the actions you want taken in response to an event and/or a rearm event.

To specify actions, select one or both of the following action options:

- **Take these actions when the event occurs**
  
  If this button is grayed out, you are not authorized to define actions.

- **Take these actions when the rearm event occurs**
  
  If this button is grayed out, you are not authorized to define actions.

If you are not authorized to define actions, see “Security Considerations for the Event Perspective” on page 107.
**Step 1: Take these actions when the event occurs**
Use this option to specify one or more actions the system is to take automatically in response to the event:

**Run command:** Specifies system commands to issue. These can be any commands you normally issue from the command line.

**Generate SNMP traps:** Specifies SNMP traps to set. Specify the ID of the SNMP trap in the **Trap ID:** field.

**Log to AIX error log and BSD Syslog:** Specifies that an entry is to be added to the AIX error log and the BSD syslog. Specify the text for the log entries in the **Log text:** field.

**Step 2: Take these actions when the rearm event occurs**
Use this option to specify one or more actions the system is to take automatically in response to the rearm event:

**Run command:** Specifies system commands to issue. These can be any commands you normally issue from the command line.

**Generate SNMP traps:** Specifies SNMP traps to set. Specify the ID of the SNMP trap in the **Trap ID:** field.

**Log to AIX error log and BSD Syslog:**
Specifies that an entry is to be added to the AIX error log and the BSD syslog. Specify the text for the log entries in the **Log text:** field.

**Step 3: To Specify the Nodes Where Actions Will Be Taken:**
In the **Where to take the actions specified** field, select one of the following:

**On the node where the event or the rearm event occurs**
Take the actions on the node where the event or the rearm event occurs.

**On a node group**
Take the actions on a specified node group.

**On selected node(s)**
Take the actions on specified node(s). You may choose any nodes in the system partition, including the control workstation, which is considered Node 0.
B.3.1.4 Example: Creating a Key Not Normal Event Definition

This example shows how to create an event definition.

A node's key mode switch can be in normal, security, or service mode. Suppose you wish to be notified when the key mode switch on a node 1 changes from normal to either security or service mode. Create an event definition as follows:

1. Click the Event Definitions pane to make it current.
2. Click the Create tool bar icon to open the Create Event Definition notebook.
3. Fill in the Definition page of the notebook as follows:
   - Event Definition Name: The name you want to give this event definition. This name is used to label the event definition's icon in the Event Definitions pane. For this example, enter keynotnormal.
   - Condition Name: The resource condition you want to be notified about. View the list of conditions by clicking the arrow next to the condition name. Scroll through the list and select keyNotNormal. The Description field now contains a description of the keyNotNormal condition. You can view the condition in greater detail by clicking the View and Modify Condition.
   - The area labeled Specify the resource ID elements not fixed for the condition:, automatically displays the list of element names and values associated with the keyNotNormal condition. NodeNum appears in the list of element names because the keyNotNormal is an event that applies to nodes. The field Element Values shows the values you can assign to the element name. In this case, Element Values is a list of node numbers from which you select the nodes to be monitored for the keyNotNormal event. For this example, click 1.
   - Resource ID elements specified: Summarizes all the element names and their assigned values. For this example, it should specify NodeNum=1.
4. Register the event definition by clicking Registration. This causes the event definition to become active.
5. Click the Notifications tab to specify that you want to be informed when an event occurs. The Notification check box is pre-selected as the default.
response. This response causes you to be notified visually through the Event Definitions pane when the event occurs.

The Actions notebook page lets you specify actions the system is to take automatically when an event occurs. However, for this example, do not specify any actions.

6. Click **Create** to close the notebook. The icon for your new event definition now appears in the Event Definitions pane.

7. To see what happens when your newly-defined event occurs, switch the key mode on node 1 from normal to service. You cannot cause system damage by doing this.

   Enter the following command:
   
   ```bash
   # spmon -k service node1
   ```

   When node 1 switches key modes, the event definition icon changes to and a View Notification Log window opens with information about the new event displayed at the top of the log.

8. Restore the key mode on node 1 to normal by entering the following command:

   ```bash
   # spmon -k normal node1
   ```

   When the key mode switches back, the event definition icon changes back to and the key mode switch is reflected in the View Notification Log window.

9. If you wish to delete your event definition, click its icon in the Event Definitions pane and then click **Delete**.

### B.3.2 View and Modify an Event Definition

The Event Perspective lets you view and modify event definitions for the system partitions in your SP system. You can modify only event definitions that were created by your Kerberos principal.

To view and modify an event definition:

1. If necessary, make current the system partition containing the event definition.

2. In the Event Definitions pane, double-click the event definition’s icon to open the View and Modify Properties Event Definition notebook.

3. Use the Definition page shown in Figure 200 on page 316 to see or change the properties of the event definition.
4. Use the Notifications page shown in Figure 201 on page 317 to see or change whether you are informed visually when an event occurs.

5. Use the Actions page shown in Figure 202 on page 318 to see or change the actions the system takes when an event occurs.

6. When you are finished, click:
   • **Ok** to save the event definition and close the notebook.
   • **Apply** to save the event definition but keep the notebook open.
   • **Cancel** to cancel your selections and close the notebook.
   • **Reset** to reset the properties to what they were when you opened the notebook.

B.3.2.1 The Definition Page
The Definition page of the View and Modify Properties Event Definition notebook shown in Figure 200 on page 316 contains the following information:

**Event definition name:** The name of the event definition. It must be unique within a system partition for a Kerberos principal.

**Name:** The name of the condition.

**Description:** A brief description of the condition.

For more information about the condition, click **View and Modify Condition**.

To create a new condition, click **Create Condition**. If this button is grayed out, you are not authorized to create new conditions. To correct this, see “Security Considerations for the Event Perspective” on page 107.

**Element Names** A list of the element names for the resources that are part of the event definition.

**Element Values** A list of the values for a selected element name.

**Resource ID elements specified:**

A list of the user-selected element names and their element values. This view-only field is updated automatically to reflect current element name and element value selections.
Initial evaluation
If this button is selected, the system does an initial evaluation to check for a pre-existing instance of this event when the event definition is registered. Deselect the button to have no initial evaluation performed.

Registration
If this button is selected, the event definition is registered. Deselect the button to unregister the event definition, making it inactive.

Figure 200. The Definition Page of View and Modify Properties Event Definition

B.3.2.2 The Notifications Page
The Notifications page of the View and Modify Properties Event Definition notebook shown in Figure 201 on page 317 lets you see or change whether the Event Perspective notifies you visually when an event occurs.

1 EDN = Event Definition Notebook
This page also contains a view-only log of events that have occurred.

![Figure 201. The Notifications Page of View and Modify Properties EDN](image)

### B.3.2.3 The Actions Page

The Actions page of the View and Modify Properties Event Definition notebook shown in Figure 202 on page 318 lets you see or change the actions the system takes when an event occurs:

- **Take Actions When the Event Occurs** specifies actions to take in response to the event.

- **Take Actions When the Rearm Event Occurs** specifies actions to take in response to the rearm event.

  If either button is grayed out, you are not authorized to define actions. See “Security Considerations for the Event Perspective” on page 107.

---

2 EDN = Event Definition Notebook
• **Where to Take Actions** specifies the node or nodes where the event actions, or rearm actions, or both, are to be taken.

• **On the node where the event or rearm event occurs** specifies the node where the event or rearm event occurs.

• **On a node group** specifies a node group from the list.

• **On selected node(s)** specifies one or more nodes in the system partition. The control workstation is considered Node 0.

---

![Actions Page of View and Modify Properties EDN](image)

**Figure 202. The Actions Page of View and Modify Properties EDN**

### B.3.3 Register or Unregister an Event Definition

You can register or unregister event definitions that have been created for a system partition:

---

3 EDN = Event Definition Notebook
• Registering an event definition causes the system to begin checking for the specified event.

• Unregistering an event definition causes the system to stop checking for the specified event.

The Event Definitions pane contains both registered and unregistered event definitions for the current system partition. You can register only the event definitions of your current Kerberos principal.

To register an event definition:
1. If necessary, make current the system partition containing the event definition.
2. Select the event definition(s) that you want to register.
3. Click **Register**. Refer to Figure 192 on page 292.
   
   The icons of the selected event definition(s) change to color to show they are registered.

To unregister an event definition:
1. Select the event definition(s) that you want to unregister.
2. Click **Unregister**. Refer to Figure 192 on page 292.
   
   The icons of the selected event definition(s) now turn dark gray to show they are unregistered.

**B.3.4 Delete Event Definitions**

The Event Perspective lets you delete event definitions for a system partition. You can delete only event definitions that were created by your Kerberos principal.

To delete event definitions:
1. Select the event definition(s) that you want to delete.
2. Click **Delete**. Refer to Figure 192 on page 292.

**B.4 Working with Conditions**

From the Event Perspective, you can:

• Create a Condition
• View and Modify a Condition
• Delete Conditions
B.4.1 Create a Condition

A condition defines the circumstances within the system that cause an event. You can create a new condition for:

- A new event definition you are creating
- An event definition you might create later
- For monitoring hardware objects. For more detail, refer to “Monitoring Hardware Objects” on page 251.

To create a condition:

1. If necessary, make current the system partition for which you want to create a condition.
2. Click the Conditions pane to make it active.
3. Open the Create Condition notebook by clicking Create.

The Create Condition notebook shown in Figure 203 on page 321 is presented.
If *Create* is grayed out, you are not authorized to create new conditions. To correct this, see “Security Considerations for the Event Perspective” on page 107.

You can also create a new condition from either the Create Event Definition notebook or the View and Modify Properties Event Definition notebook. Refer to “Create an Event Definition” on page 305, “View and Modify an Event Definition” on page 314.

Use the Create Condition notebook to define the properties of a new condition. A condition is used either in an event definition or for monitoring hardware objects. It consists of:

- A resource variable
- A resource identifier
- An expression
• An optional rearm expression.

To create a condition:

1. In the Name: field, specify the name of the condition or select the name of a pre-defined condition.

   If you choose a pre-defined condition, the rest of the notebook is automatically updated for that condition. Because each condition must have a unique name, you must give your condition a new name.

2. In the Description: field, specify a short description of the condition.

3. From the Resource Variable Classes list, select a resource variable class. The resource variables belonging to the selected class are displayed to the right.

4. From the Resource Variable Names list, select a resource variable name. For more information about a selected resource variable name, click Show Details.... For more detail, refer to “Show Resource Variable Details Dialog Box” on page 326.

5. In the Expression: field, specify the event expression for the condition.

   The event expression defines the relationship between the resource variable and other elements (such as constants or the previous value of the variable) that, when true, generates the event.

   This expression is referred to as the event expression, when differentiating it from the rearm expression.

6. In the Rearm Expression (optional): field, specify a rearm expression for this condition if desired.

   Use the same rules and syntax for the rearm expression as you used for the event expression.

7. In the Resource ID Elements to be Fixed for the Condition (optional): field, restrict the condition to specific resources, if desired. Enter the element name and element value of the resource or resources here, separating the name/value pairs with semicolons.

   If you do not restrict the resource identifiers that can be selected for the condition:

   • All instances of the resource in the system partition will be available for selection when creating an event definition.

   • All resource identifier elements (all of its name/value pairs) will automatically appear under the lists of possible Element Names and Element Values in the Create or View and Modify Properties Event Definition notebook.
Here is an example of how you can use this field:

The resource variable IBM.PSSP.aixos.FS.%totused is represented by two name/value pairs, NodeNum=x and VG=x. If you leave the field blank, all nodes and all volume groups in the system partition are available for selection for this event definition. Both name/value pairs appear in the Field Names field.

To restrict the event definition to a single node, for example, Node 2, enter NodeNum=2 in this field. Now all volume groups on Node 2 will be available for selection for this event definition. Also, NodeNum will not appear in the Field Names field because alternative values cannot be selected.

8. When you are finished, click:
   - Ok to save the new condition and close the notebook.
   - Apply to save the new condition but keep the notebook open.
   - Cancel to close the notebook without saving the new condition.
   - Reset to reset the properties to what they were when you opened the notebook.

B.4.2 View and Modify a Condition

A condition defines the circumstances within the system that cause an event. You can modify a condition for:
   - A new event definition you are creating
   - An event definition you might create later
   - For Monitoring hardware objects. For more detail, refer to “Monitoring Hardware Objects” on page 251.

To view and modify a condition:

1. If necessary, make current the system partition for which you want to create a condition.
2. Click the Conditions pane to make it active.
3. Double-click the condition's icon in the Conditions pane to open its View and Modify Properties Condition notebook.

The View and Modify Properties Condition notebook shown in Figure 204 on page 324 is presented.
Use the View and Modify Properties Condition notebook to view and modify the following properties of an existing condition:

**Name:**
The name of the condition. If the condition name is Unnamed, it was created from the command line, with no name specified, as a result of a Problem Management subscription. Unnamed conditions cannot be modified.

**Description:**
A brief description of the condition.

**Resource Variable Names**
The name of the resource variable that was defined for the condition. It has the format resource name.resource attribute. For example, in the resource variable name IBM.PSSP.aixos.FS.%totused,
IBM.PSSP.aixos.FS is the resource name and %totused is the resource attribute.

For more information about the resource variable name, click **Show Details...** button. For more detail, refer to “Show Resource Variable Details Dialog Box” on page 326.

**Expression:**

The event expression that was defined for the condition. The expression defines the relationship between the resource variable and other elements (such as constants or the previous value of the variable) that, when true, generates the event.

**Rearm Expression (optional):**

The rearm expression that was defined for the condition, if any. It is often the inverse of the event expression, but it does not have to be. If no rearm expression was defined for the condition, this field is blank.

The rearm expression is used to generate an event that alternates with the original event expression as follows:

The event expression is used until it is true, then the rearm expression is used until it is true, then the event expression is used, and so on.

**Resource ID Elements to be Fixed for the Condition (optional):**

The specific resources to which the condition is restricted, if any. If the condition is to apply to all instances of the resource variable in the system partition, this field is blank.

Multiple name/value pairs are separated by semicolons. For example, the resource variable IBM.PSSP.aixos.FS.%totused is represented by two name/value pairs, NodeNum=x and VG=x.

If the field contains NodeNum=2, the event definition is restricted to a single node, Node 2, and all volume groups on Node 2 will be monitored for this event. If the field is blank, all nodes and all volume groups in the system partition will be monitored for this event definition.
B.4.2.1 Show Resource Variable Details Dialog Box

The Show Resource Variable Details dialog box shown in Figure 205 on page 327 opens when you click **Show Details...** from either the Create Condition notebook or View and Modify Properties Condition notebook.

Resource variable details include:

**Resource Variable Name:**

The name of the resource variable.

**Resource Variable Description:**

Information about the resource variable, which might include any or all of the following: the resource variable’s function, data type, syntax, use, limitations, and a list of related resource variables.

**Resource Variable Value Type:**

The type of value the resource variable represents: state, quantity, or counter.

**Resource Variable Data Type:**

The type of data the resource variable contains: long, float, or a structured byte string (SBS).

**SBS (structured byte string format):**

If the resource variable data type is SBS, this field specifies its format.

**Resource ID Format:**

The format of the resource identifier.

**Resource ID Description:**

The description of the resource identifier.
B.4.3 Delete Conditions

The Event Perspective lets you delete conditions for a system partition. You can delete only conditions that were created by your Kerberos principal. You cannot delete default conditions, which are pre-defined by the Event Perspective.

To delete a condition:
1. Select the conditions that you want to delete.
2. Click **Delete**. Refer to Figure 192 on page 292.
B.5 View the Event Notification Log

The Event Notification Log contains entries for each event or rearm event in any system partition in your system. The Event Notification Log may also contain error notifications from the Event Manager.

To view the event notification log:
1. Click the Event Definitions pane to make it active.
2. Click Log.

The View Event Notification Log dialog box is presented.

When an event or rearm event occurs, the Event Perspective opens the log, if it is not already open, to display the new entry.

B.5.1 The View Event Notification Log Dialog Box

Use the View Event Notification Log dialog box shown in Figure 206 to view information about the events that have occurred in your system. Each time an event occurs, a entry describing the event appears in the log. The fields of this dialog box are view-only.

Figure 206. The View Event Notification Log Dialog Box

The View Event Notification Log dialog box contains the following fields:

Notification The type of notification: event, rearm, or error. Event indicates that an event expression caused the event. Rearm indicates that a rearm expression caused this event. Error indicates that the Event Manager detected an error while attempting to observe the specified resource.
<table>
<thead>
<tr>
<th>Event Definition Name</th>
<th>The name of the event definition.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Syspar</td>
<td>The system partition in which the event occurred.</td>
</tr>
<tr>
<td>Resource</td>
<td>The resource identifier for the event definition.</td>
</tr>
<tr>
<td>Time Observed</td>
<td>The time the event was observed.</td>
</tr>
<tr>
<td>Message</td>
<td>For errors, a brief description of the error.</td>
</tr>
</tbody>
</table>

B.5.2 Viewing More Details for Selected Entries

To see more detailed information about an event or error that is listed in the Event Notification Log, click its entry in the log, then click **View Notification**. To select multiple entries, press and hold the mouse button and drag it over consecutive entries.

For each entry you selected, a View Event Notification dialog box appears. This dialog box provides the details for the selected event, rearm event, or error.

B.5.2.1 The View Event Notification Dialog Box

Use the View Event Notification dialog box shown in Figure 207 on page 330 to view more detailed information about an event or error that is listed in the Event Notification Log dialog box.

The fields of this dialog box are view-only.
Figure 207. The View Event Notification Dialog Box

The View Event Notification dialog box contains the following fields:

**Name:**

The name of the condition that was defined for the event definition.

**Description:**

A description of the condition.

**Resource Variable:**
The name of the resource variable that was defined for the condition.

**Expression:/Rearm Expression:**

The expression or rearm expression that was defined for the condition.

**Resource Variable Value:**

The value of the resource variable at the time the event was observed.

**Time Observed:**

The time the event was observed.

**Resource:**

The specific resource for which the event was observed.

For errors, the dialog box also contains an Error Description field that provides details about the error.
Appendix C. Special Notices

This publication is intended to help IBM customers, Business Partners, IBM I/T Specialists, and other RS/6000 SP specialists who are involved with using the SP Perspectives. The information in this publication is not intended as the specification of any programming interfaces that are provided by IBM Parallel Systems Support Programs for AIX Version 3 Release 1. See the PUBLICATIONS section of the IBM Programming Announcement for IBM Parallel Systems Support Programs for AIX Version 3 Release 1 for more information about what publications are considered to be product documentation.

References in this publication to IBM products, programs or services do not imply that IBM intends to make these available in all countries in which IBM operates. Any reference to an IBM product, program, or service is not intended to state or imply that only IBM’s product, program, or service may be used. Any functionally equivalent program that does not infringe any of IBM’s intellectual property rights may be used instead of the IBM product, program or service.

Information in this book was developed in conjunction with use of the equipment specified, and is limited in application to those specific hardware and software products and levels.

IBM may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood, NY 10594 USA.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact IBM Corporation, Dept. 600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The information contained in this document has not been submitted to any formal IBM test and is distributed AS IS. The information about non-IBM ("vendor") products in this manual has been supplied by the vendor and IBM assumes no responsibility for its accuracy or completeness. The use of this information or the implementation of any of these techniques is a customer...
responsibility and depends on the customer’s ability to evaluate and integrate them into the customer’s operational environment. While each item may have been reviewed by IBM for accuracy in a specific situation, there is no guarantee that the same or similar results will be obtained elsewhere. Customers attempting to adapt these techniques to their own environments do so at their own risk.

Any pointers in this publication to external Web sites are provided for convenience only and do not in any manner serve as an endorsement of these Web sites.

References in this publication to IBM products, programs or services do not imply that IBM intends to make these available in all countries in which IBM operates. Any reference to an IBM product, program, or service is not intended to state or imply that only IBM's product, program, or service may be used. Any functionally equivalent program that does not infringe any of IBM's intellectual property rights may be used instead of the IBM product, program or service.

Information in this book was developed in conjunction with use of the equipment specified, and is limited in application to those specific hardware and software products and levels.

IBM may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not give you any license to these patents. You can send license inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood, NY 10594 USA.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact IBM Corporation, Dept. 600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The information contained in this document has not been submitted to any formal IBM test and is distributed AS IS. The information about non-IBM ("vendor") products in this manual has been supplied by the vendor and IBM assumes no responsibility for its accuracy or completeness. The use of this information or the implementation of any of these techniques is a customer responsibility and depends on the customer’s ability to evaluate and integrate
them into the customer’s operational environment. While each item may have been reviewed by IBM for accuracy in a specific situation, there is no guarantee that the same or similar results will be obtained elsewhere. Customers attempting to adapt these techniques to their own environments do so at their own risk.

Any pointers in this publication to external Web sites are provided for convenience only and do not in any manner serve as an endorsement of these Web sites.

Any performance data contained in this document was determined in a controlled environment, and therefore, the results that may be obtained in other operating environments may vary significantly. Users of this document should verify the applicable data for their specific environment.

The following terms are trademarks of the International Business Machines Corporation in the United States and/or other countries:

- AIX IBM
- POWERparallel RS/6000
- Scalable POWERparallel Systems SP

The following terms are trademarks of other companies:

- C-bus is a trademark of Corollary, Inc.
- Java and HotJava are trademarks of Sun Microsystems, Incorporated.
- Microsoft, Windows, Windows NT, and the Windows 95 logo are trademarks or registered trademarks of Microsoft Corporation.
- PC Direct is a trademark of Ziff Communications Company and is used by IBM Corporation under license.
- Pentium, MMX, ProShare, LANDesk, and ActionMedia are trademarks or registered trademarks of Intel Corporation in the U.S. and other countries.
- UNIX is a registered trademark in the United States and other countries licensed exclusively through X/Open Company Limited.

Other company, product, and service names may be trademarks or service marks of others.
Appendix D. Related Publications

The publications listed in this section are considered particularly suitable for a more detailed discussion of the topics covered in this redbook.

D.1 International Technical Support Organization Publications

For information on ordering these ITSO publications see “How to Get ITSO Redbooks” on page 339.

- *RS/6000 SP High Availability Infrastructure*, SG24-4838
- *RS/6000 SP Monitoring: Keeping It Alive*, SG24-4873

D.2 Redbooks on CD-ROMs

Redbooks are also available on CD-ROMs. **Order a subscription** and receive updates 2-4 times a year at significant savings.

<table>
<thead>
<tr>
<th>CD-ROM Title</th>
<th>Subscription Number</th>
<th>Collection Kit Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>System/390 Redbooks Collection</td>
<td>SBOF-7201</td>
<td>SK2T-2177</td>
</tr>
<tr>
<td>Networking and Systems Management Redbooks Collection</td>
<td>SBOF-7370</td>
<td>SK2T-6022</td>
</tr>
<tr>
<td>Transaction Processing and Data Management Redbook</td>
<td>SBOF-7240</td>
<td>SK2T-8038</td>
</tr>
<tr>
<td>Lotus Redbooks Collection</td>
<td>SBOF-6899</td>
<td>SK2T-8039</td>
</tr>
<tr>
<td>Tivoli Redbooks Collection</td>
<td>SBOF-6898</td>
<td>SK2T-8044</td>
</tr>
<tr>
<td>AS/400 Redbooks Collection</td>
<td>SBOF-7270</td>
<td>SK2T-2849</td>
</tr>
<tr>
<td>RS/6000 Redbooks Collection (HTML, BkMgr)</td>
<td>SBOF-7230</td>
<td>SK2T-8040</td>
</tr>
<tr>
<td>RS/6000 Redbooks Collection (PostScript)</td>
<td>SBOF-7205</td>
<td>SK2T-8041</td>
</tr>
<tr>
<td>RS/6000 Redbooks Collection (PDF Format)</td>
<td>SBOF-8700</td>
<td>SK2T-8043</td>
</tr>
<tr>
<td>Application Development Redbooks Collection</td>
<td>SBOF-7290</td>
<td>SK2T-8037</td>
</tr>
</tbody>
</table>

D.3 Other Publications

These publications are also relevant as further information sources:


© Copyright IBM Corp. 1998
• IBM Parallel Systems Support Programs for AIX: Diagnosis and Messages Guide, GC23-3899
• IBM Parallel Systems Support Programs for AIX: Command and Technical Reference, GC23-3900
• IBM Parallel Systems Support Programs for AIX: Managing Shared Disks, SA22-7279
• IBM Performance Toolbox Parallel Extensions for AIX: Guide and Reference, SC23-3997
• IBM AIX Version 4.3 Problem Solving Guide and Reference, SC23-4123
How to Get ITSO Redbooks

This section explains how both customers and IBM employees can find out about ITSO redbooks, CD-ROMs, workshops, and residencies. A form for ordering books and CD-ROMs is also provided.

This information was current at the time of publication, but is continually subject to change. The latest information may be found at http://www.redbooks.ibm.com/.

How IBM Employees Can Get ITSO Redbooks

Employees may request ITSO deliverables (redbooks, BookManager BOOKs, and CD-ROMs) and information about redbooks, workshops, and residencies in the following ways:

- **Redbooks Web Site on the World Wide Web**
  http://w3.itso.ibm.com/

- **PUBORDER** – to order hardcopies in the United States

- **Tools Disks**
  To get LIST3820s of redbooks, type one of the following commands:
  
  TOOLCAT REDPRINT
  TOOLS SENDTO EHOME4 TOOLS2 REDPRINT GET SG24xxxx PACKAGE
  TOOLS SENDTO CANVM2 TOOLS REDPRINT GET SG24xxxx PACKAGE (Canadian users only)

  To get BookManager BOOKs of redbooks, type the following command:
  
  TOOLCAT REDBOOKS

  To get lists of redbooks, type the following command:
  
  TOOLS SENDTO USDIST MKTTTOOLS MKTTTOOLS GET ITSOCAT TXT

  To register for information on workshops, residencies, and redbooks, type the following command:
  
  TOOLS SENDTO WTSCPOK TOOLS ZDISK GET ITSOREGI 1998

- **REDBOOKS Category on INEWS**

- **Online** – send orders to: USIB6FPL at IBMMAIL or DKIBMBSH at IBMMAIL

---

**Redpieces**

For information so current it is still in the process of being written, look at "Redpieces" on the Redbooks Web Site (http://www.redbooks.ibm.com/redpieces.html). Redpieces are redbooks in progress; not all redbooks become redpieces, and sometimes just a few chapters will be published this way. The intent is to get the information out much quicker than the formal publishing process allows.
How Customers Can Get ITSO Redbooks

Customers may request ITSO deliverables (redbooks, BookManager BOOKs, and CD-ROMs) and information about redbooks, workshops, and residencies in the following ways:

- **Online Orders** – send orders to:
  
<table>
<thead>
<tr>
<th>Country</th>
<th>IBMMAIL</th>
<th>Internet</th>
</tr>
</thead>
<tbody>
<tr>
<td>In United States</td>
<td>usib6fpl at ibmmail</td>
<td><a href="mailto:usib6fpl@ibmmail.com">usib6fpl@ibmmail.com</a></td>
</tr>
<tr>
<td>In Canada</td>
<td>caibmbkz at ibmmail</td>
<td><a href="mailto:lmannix@vnet.ibm.com">lmannix@vnet.ibm.com</a></td>
</tr>
<tr>
<td>Outside North America</td>
<td>dkibmbsh at ibmmail</td>
<td><a href="mailto:bookshop@dk.ibm.com">bookshop@dk.ibm.com</a></td>
</tr>
</tbody>
</table>

- **Telephone Orders**
  
<table>
<thead>
<tr>
<th>Country</th>
<th>Telephone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States (toll free)</td>
<td>1-800-879-2755</td>
</tr>
<tr>
<td>Canada (toll free)</td>
<td>1-800-IBM-4YOU</td>
</tr>
<tr>
<td>Outside North America</td>
<td>(long distance charges apply)</td>
</tr>
<tr>
<td>(+45) 4810-1320 - Danish</td>
<td>(+45) 4810-1020 - German</td>
</tr>
<tr>
<td>(+45) 4810-1420 - Dutch</td>
<td>(+45) 4810-1620 - Italian</td>
</tr>
<tr>
<td>(+45) 4810-1540 - English</td>
<td>(+45) 4810-1270 - Norwegian</td>
</tr>
<tr>
<td>(+45) 4810-1670 - Finnish</td>
<td>(+45) 4810-1120 - Spanish</td>
</tr>
<tr>
<td>(+45) 4810-1220 - French</td>
<td>(+45) 4810-1170 - Swedish</td>
</tr>
</tbody>
</table>

- **Mail Orders** – send orders to:
  
  | IBM Publications Publications Customer Support | 144-4th Avenue, S.W. | IBM Direct Services |
  | Raleigh, NC 27626-0570 | Calgary, Alberta T2P 3N5 | Sortemosevej 21 |
  | USA | Canada | DK-3450 Allerød |

- **Fax** – send orders to:
  
  | United States (toll free) | 1-800-445-9269 |
  | Canada | 1-800-267-4455 |
  | Outside North America | (+45) 48 14 2207 (long distance charge) |

- **1-800-IBM-4FAX (United States)** or **(+1) 408 256 5422 (Outside USA)** – ask for:
  
  | Index # 4421 Abstracts of new redbooks |
  | Index # 4422 IBM redbooks |
  | Index # 4420 Redbooks for last six months |

- **On the World Wide Web**
  
  | Redbooks Web Site | http://www.redbooks.ibm.com |

---

**Redpieces**

For information so current it is still in the process of being written, look at "Redpieces" on the Redbooks Web Site (http://www.redbooks.ibm.com/redpieces.html). Redpieces are redbooks in progress; not all redbooks become redpieces, and sometimes just a few chapters will be published this way. The intent is to get the information out much quicker than the formal publishing process allows.
<table>
<thead>
<tr>
<th>Title</th>
<th>Order Number</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

First name | Last name

Company

Address

City | Postal code | Country

Telephone number | Telefax number | VAT number

☐ Invoice to customer number

☐ Credit card number

Credit card expiration date | Card issued to | Signature

*We accept American Express, Diners, Eurocard, Master Card, and Visa. Payment by credit card not available in all countries. Signature mandatory for credit card payment.*
<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ACL</strong></td>
<td>Access Control List</td>
</tr>
<tr>
<td><strong>AIX</strong></td>
<td>Advanced Interactive Executive</td>
</tr>
<tr>
<td><strong>API</strong></td>
<td>Application Programming Interface</td>
</tr>
<tr>
<td><strong>BSD</strong></td>
<td>Berkeley Software Distribution</td>
</tr>
<tr>
<td><strong>BUMP</strong></td>
<td>Bring-Up Microprocessor</td>
</tr>
<tr>
<td><strong>CDE</strong></td>
<td>Common Desktop Environment</td>
</tr>
<tr>
<td><strong>CPU</strong></td>
<td>Central Processing Unit</td>
</tr>
<tr>
<td><strong>CWS</strong></td>
<td>Control Workstation</td>
</tr>
<tr>
<td><strong>DB</strong></td>
<td>Database</td>
</tr>
<tr>
<td><strong>EM</strong></td>
<td>Event Management</td>
</tr>
<tr>
<td><strong>EMAPI</strong></td>
<td>Event Management Application Programming Interface</td>
</tr>
<tr>
<td><strong>EMCDB</strong></td>
<td>Event Management Configuration Database</td>
</tr>
<tr>
<td><strong>EPROM</strong></td>
<td>Erasable Programmable Read-Only Memory</td>
</tr>
<tr>
<td><strong>GB</strong></td>
<td>Gigabytes</td>
</tr>
<tr>
<td><strong>GS</strong></td>
<td>Group Services</td>
</tr>
<tr>
<td><strong>GSAPI</strong></td>
<td>Group Services Application Programming Interface</td>
</tr>
<tr>
<td><strong>GUI</strong></td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td><strong>HACMP</strong></td>
<td>High Availability Cluster Multiprocessing</td>
</tr>
<tr>
<td><strong>HACMP/ES</strong></td>
<td>High Availability Cluster Multiprocessing Enhanced Scalability</td>
</tr>
<tr>
<td><strong>HIPS</strong></td>
<td>High Performance Switch</td>
</tr>
<tr>
<td><strong>HSD</strong></td>
<td>Hashed Shared Disk</td>
</tr>
<tr>
<td><strong>IBM</strong></td>
<td>International Business Machines Corporation</td>
</tr>
<tr>
<td><strong>IP</strong></td>
<td>Internet Protocol</td>
</tr>
<tr>
<td><strong>ITSO</strong></td>
<td>International Technical Support Organization</td>
</tr>
<tr>
<td><strong>JFS</strong></td>
<td>Journaled File System</td>
</tr>
<tr>
<td><strong>KB</strong></td>
<td>Kilobytes</td>
</tr>
<tr>
<td><strong>LAN</strong></td>
<td>Local Area Network</td>
</tr>
<tr>
<td><strong>LCD</strong></td>
<td>Liquid Crystal Display</td>
</tr>
<tr>
<td><strong>LED</strong></td>
<td>Light Emitting Diode</td>
</tr>
<tr>
<td><strong>LV</strong></td>
<td>Logical Volume</td>
</tr>
<tr>
<td><strong>LVCB</strong></td>
<td>Logical Volume Control Block</td>
</tr>
<tr>
<td><strong>LVM</strong></td>
<td>Logical Volume Manager</td>
</tr>
<tr>
<td><strong>MB</strong></td>
<td>Megabytes</td>
</tr>
<tr>
<td><strong>MIB</strong></td>
<td>Management Information Base</td>
</tr>
<tr>
<td><strong>MP</strong></td>
<td>Multiprocessor</td>
</tr>
<tr>
<td><strong>ODM</strong></td>
<td>Object Data Management</td>
</tr>
<tr>
<td><strong>PDU</strong></td>
<td>Power Distribution Unit</td>
</tr>
<tr>
<td><strong>PSSP</strong></td>
<td>Parallel System Support Programs</td>
</tr>
<tr>
<td><strong>PV</strong></td>
<td>Physical Volume</td>
</tr>
<tr>
<td><strong>RAM</strong></td>
<td>Random Access Memory</td>
</tr>
<tr>
<td><strong>RM</strong></td>
<td>Resource Monitor</td>
</tr>
<tr>
<td><strong>RMAPI</strong></td>
<td>Resource Monitor Application Programming Interface</td>
</tr>
<tr>
<td><strong>RVSD</strong></td>
<td>Recoverable Virtual Shared Disk</td>
</tr>
<tr>
<td><strong>SBS</strong></td>
<td>Structure Byte String</td>
</tr>
<tr>
<td>Abbreviation</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>SDR</td>
<td>System Data Repository</td>
</tr>
<tr>
<td>SEPBU</td>
<td>Scalable Electric Power Base Unit</td>
</tr>
<tr>
<td>SMIT</td>
<td>System Management Interface Tool</td>
</tr>
<tr>
<td>SNMP</td>
<td>Simple Network Management Tool</td>
</tr>
<tr>
<td>UP</td>
<td>Uniprocessor</td>
</tr>
<tr>
<td>VG</td>
<td>Volume Group</td>
</tr>
<tr>
<td>VSD</td>
<td>Virtual Shared Disk</td>
</tr>
</tbody>
</table>
Symbols
$HOME 88
$HOME/.klogin 108
$PMAN_HANDLE 139
$PMAN_IVECTOR 139
/etc/sysctl.acl 167
/etc/sysctl.pman.acl 108
/etc/sysctl.vsd.acl 167
/spdata/sys1/spmon/hmacls 203
/tmp 135
/usr/lpp/ssp/bin 109
/usr/lpp/ssp/bin/log_event 139
/usr/lpp/ssp/bin/notify_event 139
/usr/lpp/ssp/bin/tecad_pssp 139
/usr/lpp/ssp/bin/errLog 53, 120
/var 137

Numerics
2 colors and 2 grays 139
4 blue blocks 139
4 gray blocks 139
4-color blocks 139

A
acknowledge 76
acknowledge monitor state 156
ACL 203
add pane
  current window 61
  new window 64
aggregate monitoring state 54, 76

B
blue envelope 139

C
CDE 24
condition 103, 118
erLog 53, 120
  event expression 103
frameControllerNotResponding 54, 120
framePowerOff 54, 121
hasInactiveBMVSDs 53, 121, 165
hostResponds 53, 121
keyNotNormal 53, 121
LCDhasMessage 120
nodeEnvProblem 53, 121
nodeNotReachable 53, 121
nodePowerDown 53, 121
nodePowerLED 53, 121
nodeSerialLinkOpen 53, 121
pageSpaceLinkOpen 53, 121
rearm expression 103
resource identifier 103
resource variable 103
rvsdlRecovery 53, 121, 165
dfDown 121
switchNotReachable 53, 121
switchPowerLED 54, 121
switchResponds 53, 121
tmpFull 53, 121, 135
varFull 53

Conditions pane 320
  Create Condition notebook 320
delete 327
  View and Modify Properties Condition notebook 323
close hardware 264
  frames 278
    power off 279
    power on 278
nodes or node groups 267
  fence and unfence 268
network boot 269
open a tty 270
open an administrative session 271
power off 267
power on 267
run a command 274
set the front panel key mode switch position 272
view the LCD/LED Display window 275
switches 280
  power off 280
  power on 280
system partition 264
  power off the nodes 265
  power on the nodes 264
start or restart a switch 267

Control Workstation notebook 207
Identification page 207
Notebook 292
Notification 292
Register 292
Select 293
Sort 293
Unfilter 293
Unregister 292
View 293
expression 105
P 106
R 106
X 106

F
F1LCD_popup 151
filter by monitor state 156
filter objects 70
monitored state 70
Frame notebook 240
Configuration page 242
Dynamic Resource Variables page 244
Frame Status page 240
Monitored Conditions page 244

G
get notified 116
GUI 1

H
hardware data 156
Hardware Perspective 203
Actions
Cluster Power On... 93
Create Node Group... 98
Power Off, Reset, Shutdown 94
Power On 93
Run Command... 100
current system partition 206
customization 36
default 36
hide information area 42
hide tool bar icons 42
iconify 49
multiple windows 39
multiple windows with multiple panes 39
single window with multiple panes 37
table view 45
vertical view 41
hardware attributes 206
Options
Save Preference... 88
tool bar icon 205
Acknowledge 206
Add Pane 205
Delete Pane 205
Deselect 205
Filter 205
Monitor 205
Notebook 205
Power Off 205
Power On 205
Remove Filter 205
Select 205
Sort 205
View 205
View
Show Objects as Small Icons 83
help 19
hmadm setacls 203

I
IBM HSD 165
IBM VSD 165
IBM VSD Perspective 165
action 177
CWS and Syspars pane 177
IBM HSDs pane 182
IBM VSDs pane 181
Nodes pane 179
dialog box
Set Table Attributes 174
monitoring 199
notebook 183
CWS 184
IBM HSD 191
IBM VSD 189
IBM VSD Node 184
Node 184
Syspar 184
pane
CWS and Syspars 166
IBM HSDs 166
IBM VSDs 166
Nodes 166
relationship filter 193
R
rearm expression 107
relationship filter
IBM HSDs
  Related IBM VSD Nodes 197
  Related IBM VSDs 197
IBM VSDs
  Related IBM HSDs 195
  Related IBM VSD Nodes 195
node
  Related IBM HSDs 193
  Related IBM VSDs 193
resource identifier 104
  Cpu 105
  FrameNum 105
  LV 105
  Name 105
  NodeNum 104, 105
  Type 105
  VG 105
resource variable 103
  IBM.AIX.aixos.PagSp.%totalfree 105
  IBM.PSSP.aixos.CPU.gluser 105
  IBM.PSSP.aixos.CPU.kern 105
  IBM.PSSP.aixos.Disk.busy 104, 105
  IBM.PSSP.aixos.FS.%totused 104, 105
  IBM.PSSP.aixos.Mem.Kmem.inuse 105
  IBM.PSSP.aixos.SP_HW.Frame.frACLED 105
  IBM.PSSP.HW.Frame.power 104
  IBM.PSSP.Membership.Node.state 102
root authority 107
run command 156

S
sash 12
save preferences 33
dialog box 34
saving preferences 156
screen real estate 156
Set Monitoring for CWS/System/Syspars notebook 253
  Control WS page 253
 Syspar page 256
  System page 254
Set Monitoring for Frames/Switches notebook 262
  Frame page 262
  SwitchBoard page 263
Set Monitoring for Node Groups notebook 260
Set Monitoring for Nodes notebook 258
  Dependent Node page 258
  Node page 258
SNMP trap 111
SP hardware
  actions 53, 54
  default conditions 53, 54
  object 53, 54
SP Perspectives 1
  applications 1
  Event Perspective 1
  examples 281
  Hardware Perspective 1
  Launch Pad 1
  Performance Monitor Perspective 1
  SMIT panels 1
  System Partitioning Aid Perspective 1
  VSD Perspective 1
SP System Monitor 203
speekent 22, 109
sp hardware 22
spmon 141
  3DigitDisplay window 150
  All Node Summary Display window 146
  Frame front panel 144
  Global Controls window 141
  Node Variable windows 146
  Switch front panel 145
  System Monitor window 141, 146
spperfmon 22
spsyspar 22
spvsd 22, 167
startsrc 109
status 252
  ? 252
  green 252
  red X 252
  unmonitored 252
  yellow with black checkmark 252
Switch notebook 245
  Configuration page 248
  Dynamic Resource Variables page 249
  Monitored Conditions page 250
  Switch Status page 245
sysctl svcrestart 167
System notebook 210
  Accounting Configuration page 213
  Configuration page 211
  Identification page 210

349
Table view 66, 155
take actions 116
Tivoli Enterprise Console 111

Usability 157

Wall 139
white envelope 139
window
   arrange 31
      characteristics 32
      pane 31
      position 31
      size 31
   menu bar 8
   help 11
   title bar 8
   tool bar 11
      add 12
      delete 12
      deselect 12
      filter 11
      monitor 12
      remove filter 12
      select 12
      show objects in table/icon view 12
      sort 11
ITSO Redbook Evaluation

SP Perspectives: A New View of Your SP System
SG24-5180-00

Your feedback is very important to help us maintain the quality of ITSO redbooks. Please complete this questionnaire and return it using one of the following methods:

- Use the online evaluation form found at http://www.redbooks.ibm.com
- Fax this form to: USA International Access Code + 1 914 432 8264
- Send your comments in an Internet note to redbook@us.ibm.com

Which of the following best describes you?
_ Customer _ Business Partner _ Solution Developer _ IBM employee
_ None of the above

Please rate your overall satisfaction with this book using the scale: (1 = very good, 2 = good, 3 = average, 4 = poor, 5 = very poor)

Overall Satisfaction __________

Please answer the following questions:

Was this redbook published in time for your needs? Yes___ No___

If no, please explain:

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

What other redbooks would you like to see published?

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

Comments/Suggestions: (THANK YOU FOR YOUR FEEDBACK!)

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________